
HARDWARE 
 
 
1.    Where would you find the letters QUERTY? 
(1)    Mouse      (2)   Screen  
(3)    Numeric Keypad  (4)    Keyboard 
(5)    None of these 
2.    How did the computer mouse get its name?  
(1)    It's cable looks like a tail 
(2)    Because it squeaks when moved 
(3)    It has ears 
(4)   Teeth outside mouth 
(5)    None of these 
3.    What are you most likely to use when playing 
(1)    Touch screen a computer game? 
(2)    Light pen       (3)   notepad  
(4)    Joystick   (5)   None of these 
4.    A digitising tablet can be used for?  
(1)   Tracing diagrams  
(2)    Printing letters 
(3)    Reading barcodes  
(4)    Playing 
(5)    None of these 
5.    Which of the following is a pointing device     
(1)    Hard disk .    
(2)    CD-ROM drive 
(3)    Touch screen used for computer input. 
(4)    RAM   
(5)    None of these 
6.    What does a light pen contain? 
(1)    Refillableink  (2)    Light sensitive elements 
(3)    Pencil lead  (4)    Blue Ink 
(5)    None of these 
7.    What would be the best way to move around a 3D 
environment? 
(1)    Use a tracker ball (2)    Use a keyboard.  
(3)    Use a space mouse (4)    Use Joystick 
(5)    None of these 
8.    What input device can be used for marking  
(1)    Optical mark reader  
(2)    Bar code reader 
(3)    Mouse a multiple choice test? 
(4)    All of the above  
(5)    None of these 
9.    What input device could tell you the price of 
(1)    Mouse a bar of chocolate? 
(2)    All of the above 
(3)    Optical mark reader 
(4)     Bar code reader   
(5)    None of these 
10. Where   would   you   find   a magnetic strip?  

(1)    Speakers   (2)    Credit card 
(3)    Smart card  (4)    All of the above 
(5)    None of these 
11.  Hard copy is a term used to describe...?  

(1)    Printed output  
(2)    Writing on a hard board 
(3)    Storing information on the hard disk 
(4)    All of the above  
(5)    None of these 
12. What do the abbreviations VAB stand for? 

(1)    Voice activated broadcasting 
(2)   Visual audio board   
(3)   Voice answer back 
(4)    All of the above  
(5)    None of these 
13. What are the individual dots which make up a picture on 

the monitor screen called? 
(1)    Coloured spots  
(2)    All of the above 
(3)    Pixies    
(4)    Pixels  
(5)    None of these 
 

14.  A daisy wheel is a type of...? 
(1)    None of these 
(2)    Storage device 
(3)    Pointing device 
(4)    All of the above 
(5)    Printer 
15.  Factory production lines can be automated using...?  

(1)    Machine tools 
(2)    VDUs  
(3)    Plotters 
(4)    All of the above 
(5)    None of these 
16.  An   impact  printer  creates characters by using...?  

(1)    An inked ribbon and print head 
(2)    Electrically charged ink 
(3)    An ink pen 
(4)    All of the above 
(5)    None of these 
17.  What would you NOT use with a flatbed plotter?  
(1)    A pen   (2)   Eraser  
(3)    Paper  (4)    All of the above 
(5)    None of these 
18. What would be the best way to move around a 3D 

environment? 
(1)    Electrostatic plotters (2)    None of these      
(3)   Thermal printers  (4)   All of the above  
(5)    Robots 

19. What do you need for an ink jet printer?  

(1)   A drum    (2)   A cartridge 
(3)   A ribbon  (4)   All of the above 
(5)    None of these 
20. A laser printer does NOT use?  
(1)   A photoconductive drum 
(2)   A print head 
(3)   A laser beam 
(4)   All of the above 
(5)    None of these 
21. The amount of data that a disk may containis known as 
the disk's...? 
(1)    Volume          (2)   Size  
(3)   All of the above  
(4)    Storage capacity  (5)    None of these 
22. You can protect a floppy disk. 
(1)    Read  (2)    Read and Write  
(3)   Write  (4)   All of the above 
(5)    None of these 
23.  Information on a hard disk is usually backed-up using 
a..?  
(1)    CD-ROM  (2)    Magnetic tape 
(3)    Floppy disk  (4)   All of the above 
(5)    None of these 
24.  Magnetic storage devices can represent binary 0 by the 
absence of...?  
(1)   A magnetic field  
(2)   Magnetic tape 
(3)   Static electricity 
(4)   All of the above 
(5)    None of these 
25.  Magnetic tape is a..? 
(1)    Random access medium 
(2)   A parallel access medium  
(3)   Serial access medium 
(4)   All of the above 
(5)    None of these 
26.  Hard disks can have a storage capacity in the region 
of...?  
(1)    1Gb   (2)   1.44Mb (3)    720K 
(4)    All of the above (5)    None of these 
27.  Formatting a disk results in all the data being...? 
(1)    Saved to the disk 
(2)    Copied from the disk  
(3)    Deleted from the disk 
(4)    All of the above 
(5)    None of these 
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28. Which storage device has the largest capacity in Mb's? 
(1)    A floppy disk  
(2)    A CD-ROM 
(3)    Magnetic tape storage 
(4)    All of the above 
(5)    None of these 
29.   Which storage device cannot be erased? 
(1)    A CD-ROM 
(2)    None of these 
(3)    Magnetic tape storage 
(4)    All of the above- 
(5)    A floppy disk 
30. Where should floppy disks be stored? 
(1)    By a sunny window  
(2)    In a drawer 
(3)    All of the above 
(4)    By magnet objects 
(5)    None of these 
31. Who is accredited with developing the architecture of the 
modern computer? 
(1)    Sir Clive Sinclair 
(2)    Bill Gates 
(3)    All of the above 
(4)    None of these 
(5)   John Von Neumann 
32. Which bus carries information between    processors    
and peripherals?  
(1)    Autobus   (2)    Data bus 
(3)   Address bus  (4)    All of the above 
(5)    None of these 
33. Which bus controls the sequencing of read/write 
operations? 
(1)    Control bus  (2)    Address bus 
(3)    Data bus  (4)    All of the above 
(5)    None of these 
34.  The contents of these chips are lost when the computer 
is switched off?  
(1)    RAM chips 
(2)    ROM chips 
(3)    DRAM chips 
(4)    All of the above 
(5)    None of these 
35.  What are responsible for storing permanent data and 
instructions? 
(1)    RAM chips 
(2)    All of the above 
(3)    DRAM chips  
(4)    ROM chips  
(5)    None of these 
36.  Which parts of the computer perform arithmetic 
calculations?  
(1) Registers  (2) ALU 
(3)    Logic bus 
(4)    All of the above 
(5)    None of these 
37.  What are small high speed memory units used for 
storing temporary results? 
(1)    All of the above 
(2)    Registers 
(3)    Control unit  
(4)   CPUs  
(5)    None of these 
38.  What maintains the status of the last operation carried 
out by the ALU? 
(1)    Instruction pointer .     
(2)    Status register  
(3)    Accumulator 
(4)    All of the above 
(5)    None of these 
39.  How many bits of information can each memory cell in a 
computer chip hold?  
(1)    8 bits (2)    1 bit 
(3)    Obits (4)    All of the above 
(5)    None of these 

40. What type of computer chips are said to be volatile?  
(1)    ROM chips   (2)    RAM chips 
(3)    DRAM  (4)   All of the above 
(5)    None of these - 
41. An example of an embedded system is ...? 
(1)    A CD-ROM  (2)   A machine tool  
(3)   A calculator  (4)   All of the above 
(5)   None of these 
42. Which computers use single chip processors? 
(1)   All of the above 
(2)   Parallel computers 
(3)   Cray computers  
(4)    Personal computers  
(5)   /tone of these 
43. Travel agents use this computer system when reserving 
flights. 
(1)   Supercomputer 
(2)   Mainframe computer  
(3)   Personal computer  
(4)   All of the above 
(5)   None of these 
44. Which computers are used in the weather forecasting 
industry?  
(1)   Super computers 
(2)    Notebook computers 
(3)   Jon Von Neumann computers 
(4)   All of the above 
(5)    None of these 
45. Which computers are connected to many terminals and 
can multitask? 
(1)    Minicomputers 
(2)    LEO 1 computers 
(3)   All of the above 
(4)   None of these 
(5)   Personal      computers running MS-DOS 
46. Vacuum tube based electronic computers are...? 
(1)   Second generation 
(2)   Hoover generation  
(3)    First generation 
(4)    All of the above 
(5)    None of these 
47. Which generation of computer was developed from 
microchips?  
(1)    Third generation 
(2)    Second generation 
(3)    Fourth generation 
(4)    All of the above 
(5)    None of these 
48. Which generation of computer uses more than one 
microprocessor? 
(1)    Second generation 
(2)   Third generation 
(3)    None of these 
(4)   All of the above  
(5)    Fifth generation 
49. Which generation of computer developed using 
integrated circuits? 
(1)   Second generation 
(2)    Fifth generation  
(3)   Thirtl generation 
(4)   All of the above 
(5)    None of these 
50. Which of these is actually a very basic computer?  
(1)   a toaster      (2)   a stove  
(3)    a light bulb (4)   a calculator  
(5)    None of these 
51.  Imagine that a user has a WORD document open at a 
workstation and that workstation is unexpectedly 
disconnected from the school network and from the Internet. 
Where should the user BEST save her work?  
(1) USB key  (2) P drive 
(3)    None of these 
(4)    S drive       (5)   H drive 
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52. Computer memory that temporarily stores information is 
called the ____.  
(1) RAM  (2) CPU  
(3) ROM  (4) IBM  
(5) None of these 
53. The brain of the computer is called the _____.  
(1)    IBM  (2)   ROM 
(3)    RAM  (4)   CPU  
(5)    None of these 
54.  The operating system is also called the ______ between 
the user and the computer. 
(1)    interrelate 
(2)    interface 
(3)    interference 
(4)   intermediate 
(5)    None of these 
55. When installing a peripheral you also usually need to 
install a _____ . 
(1)    port (2)    server 
(3)    driver (4)    password 
(5)    None of these 
56.   Computers use which of the following number systems 
to store information?  
(1)   base 4         (2)   base 2  
(3)   base8          (4)   base 10  
(5)    None of these 
57.  A single binary digit is known as 
(1)    MB  (2)   byte  
(3)    KB  (4)  bit  
(5)   None of these 
58.  Internet     Safety     relates to__________.  
(1)   only   those   who   buy products online 
(2)   only those who sign up for chat rooms 
(3)   only those who do their banking online 
(4)   everyone who uses a computer that can conned to the 
Internet 
(5)    None of these 
59. A file name extension for Word 2007 files is ___.  
(1)    .gif   (2)   .txt  
(3)    .docx           (4)   .exe  
(5)    None of these 
60. A KB represents____bytes 
(1)   8 
(2)    1,000,000,000 
(3)    1,000,000  
(4)    1,000  (5)    None of these 
61.  How many Bytes in a Megabyte (MB)?  
(1)    1,000,000 
(2)    1,024,000 
(3)    1,048,576 
(4)    1,000,024 (5)    None of these 
62. Which QBasic statement is W'-'rnost evil? 
(1)    PRINT 
(2)    LOCATE  
(3)    GOTO 
(4)    RANDOMIZE 
(5)    None of these 
63. What does ALU stand for?  
(1)   Arithmetic Logic Unit 
(2)   Asymmetrical Localizing Unit 
(3)    Because his legs are in the way 
(4)   Awfully     Long-winded Unionist 
(5)    None of these 
64.  How many pins on a standard DDR RAM Dimm?  
(1)    64   (2)   256  
(3)    168             (4)    184       ' 
(5)    None of these 
65. Which Platform(s) can a Pentium III Processor beused in? 
(1)    Socket 370 / Socket mPGA 370 / Slot 1 
(2)    Socket 462 / Slot A /Socket 8  
(3)    Socket 5 / Socket 7 /Socket 3  
(4)    Slotl/Slot A/Socket A 
(5)   None of these  

67.  If a computer is constantly rebooting itself, what is most 
commonly the problem? 
(1)    Insufficient Power-Supply Unit 
(2)    Bad Sectors on Hard Drive 
(3)    Processor Overheating 
(4)    Defective/Bad Memory 
(5)    None of these 
68.   What does the company name 'AMD' stand for?  
(1)    Always Making Dough 
(2)    Advanced Micro Devices 
(3)    Alternating Micron Deficiencies 
(4)    A Mad Device 
(5)    None of these 
69.  How many pins does Ethernet use in the RJ-45 
Connection? 
(1)    3   (2)   2 
(3)    6     (4)   4 
(5)    None of these 
70.  What does SSE stand for in Intel's SSE Technology? 
(1)   Sophisticated Software Enhancer  
(2)    Streaming Simmd Extensions 
(3)    Some Stupid Enhancer 
(4)    Simplistic Software Extensions 
(5)    None of these     
73.  Which does NOT belong to a Intel Pentium 4 Platform? 
(1)    DDRSDRAM  
(2)    EDO/Fast-Page Ram 
(3)    SDRAM 
(4)    Rambuss 
(5)    None of these 
75.  What Video Card is Best Suited for 3D Games? 
(1)    ATI 3D Charger 
(2)    nVidia GeForce 256 DDR  
(3)    ATI Radeon 9700 Pro 
(4)    3DFX VooDoo 5 
(5)    None of these 
76.  What platform does the AMD K6 3+ Processor Belong to?  
(1)    Sockets     (2)   Socket7  
(3)    Slot A  (4)   Slotl  
(5)    None of these 
77.  What platform can the VIA/Cyri III Processor Be used in 
jut c the following? 
(1)    Slot 1  (2) Socket A  
(3) Slot A  (4) Socket 7  
(5) None of these 
78.  What   motherboard   manufacturer is the most popular 
out of the following?  
(1)    Abit  (2)   AOpen  
(3)    IWill  (4)    Asus  
(5)    None of these 
79.  What is the BEST ram solution for   the    Intel    Pentium    
4 Processor?  
(1)    SDRAM 
(2)    DDR SDRAM 
(3)    EDO/Fast Page Ram 
(4)    Rambuss 
(5)    None of these 
80.  How did the SHIFT key get it's name? 
(1)    From the Latin word for large, Shiftius, which v as the 
first language ever used on acomouter. 
(2)    Because it shifts the ASC11 table by a value of 32.  
(3)  It was a carry-over from typewriters which had both 
upper and lower case letters on each print head and used a 
mechanical shifting of the print head to differentiate. 
(4)    <font color=red>(Bad pun alert!)</font color=red> 
Because the Capitol is full of shifty characters. 
(5)    None of these  
81.  If an 8-bit integer has a maximum of 256 possible 
values, what is the highest possible value of a 16 bit integer? 
(1)    512  (2)   257  
(3)    65536  (4)    65535  
(5)    None of these  
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32.  What does BASIC stand for?   
(1)    Basically, it's just your basic computer language, so   
they named it BASIC.  
(2)   Beginner's All-purpose Symbolic Instruction Code 
(3)    Binary Analysis System Interpretation Commandset 
(4)    Byte Arranging Software for Improved Coding 
(5)    None of these 
83. What does ASCII stand for?    ' 
(1)    Array of Simple Character Iteration Indices 
(2)    Another Stupid Character Identification Idea 
(3)    Alternate Source Code Image Improvement 
(4)    None of these  
(5)    American Standard Code for Information Interchange 
84. The access method used for magnetic tape is_____ 
(1)    Direct 
(2)    Random 
(3)    All of the above 
(4)Sequential  
(5)    None of these 
85.  By .Processing   we   understand ____  
(1)    String manipulation only 
(2)    None of the above 
(3)    Processing string of only words 
(4)    Processing string of numbers and special symbols 
(5)    None of these 
86. The difference between memory and storage is that the 
memory is ___ and storage is ____ 
(1)    Slow, fast 
(2)    Temporary, permanent 
(3)    Permanent, temporary 
(4)    All of the above 
(5)    None of these 
87. Which of the Following holds the ROM, CPU, RAM and 
expansion cards " 
(1)    Hard disk  (2)    Floppy disk 
(3)    All of the above  
(4)    Mother board  
(5)    None of these  
(88) The language that the computer can understand and 
execute is called ____ 
(1)    System program (2)    Application software  
(3)    Machine language (4)    All of the above 
(5)    None of these 
89. Which of the following devices can be used to directly 
input printed text 
(1)    MICR  (2)   OMR 
(3)    OCR 
(4)    All of the above 
(5)    None of these 
90. A floppy disk contains  
(1)    Circular tracks only 
(2)    Both circular tracks and sectors 
(3)    Sectors only 
(4)    All of the above 
(5)    None of these 
91.  CD-ROM is a 
(1)    Semiconductor memory 
(2)    None of these 
(3)    Magnetic memory 
(4)    All of the above 
(5)    Memory register 
92. Actual execution of instructions in a computer takes 
place in ,  
(1)    Control Unit 
(2)    ALU 
(3)    Storage unit 
(4)    All of the above 
(5)    None of these 
93.  Which of the following is used as a primary storage 
device 
(1)    Magnetic tape (2)    PROM 
(3)    Floppy disk 
(4)    None of these 
(5)    All of the above 

94.  Information retrieval is faster from  
(1)    Floppy disk   (2)    Hard disk 
(3)    Magnetic tape 
(4)    All of the above 
(5)    None of these 
95.  Operating system is 
(1)    A collection of software routines 
(2)   A collection of input-output devices 
(3)    A collection of hardware components 
(4)    All of the above 
(5)    None of these 
96.  Operating system 
(1)    Provides a layered, user-friendly interface . 
(2)    Link a program with the subroutines it references 
(3)    Enables a programmer to draw a flowchart 
(4)    All of the above 
(5)    None of these 
97.  Execution of two or more programs by a single CPU is 
known as: 
(1)    Multiprocessing 
(2)   Time sharing 
(3)    Multiprogramming 
(4)    None of these 
(5)   All of these 
98.  Modem stands for 
(1)   A   type   of   secondary memory 
(2)   Mainframe     operating device memory  
(3)   Modulator demodulator 
(4)   All of the above 
(5)    None of these 
99. Typical data transfer rate in LAN are of the order of  
(1)    Kilo bits per sec 
(2)    Bits per sec 
(3)   Mega bits per sec 
(4)   All of the above 
(5)   None of these 
100. Ethernet uses 
(1)   Ring topology 
(2)    Bus topology 
(3)    Mesh topology 
(4)   All of the above 
(5)    None of these 
101. Wide area networks (WANs) always require 
(1)   None of these 
(2)    High speed processors 
(3)   Same type 
(4)   All of the above  
(5)   High bandwidth communication source link 
102. Typical bandwidth of optical fibers is 
(1)   Order of GHz 
(2)    Order of KHz 
(3)   Order of Hz  
(4)   None of these  
(5)   All of the above 
103. A large number of computers in a wide geographical 
area can be efficiently connected by 
(1)   Twisted pair lines 
(2)   Coaxial cables 
(3)   All of the above 
(4)   None of these  
(5)   Communications satellites  
104. Which of the following topologies is not of broadcast type? 
(1)   Star  
(2)   None of these 
(3)   Ring 
(4)   All of the above 
(5)    Bus 
105. Bug means 
(1)    A difficult syntax error in a program 
(2)    Documenting programs using an efficient Docu-
mentation too  
(3)    A logical error in a program 
(4)    All of the above 
(5)    None of these 
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106.The part of machine level instruction, which tells the 
central processor what was to be Done is 
(1)   Operation code 
(2)    Address 
(3)   All of the above  
(4)    Operand 
(5)    None of these 
107. Indicate which , of the following is not true about 4GL. 
(1)    Many database management system packages support 
4GLs 
(2)    4GL does not support a high -level of screen interaction 
(3)    A 4GL is a software tool which is written, possibly, in 
some third generation language 
(4)   All of the above 
(5)    None of these 
108. Indicate which of the following, best describes the term 
"software" 
(1)   Systems programs only 
(2)   Application programs only 
(3)   All of the above 
(4)    Both (1) and (2) 
(5)    None of these 
109. A translator is best described as 
(1)    A hardware component 
(2)    A system software  
(3)   An Application software 
(4)   All of the above 
(5)   None of these  
110. Indicate which of the following is not true about an 
interpreter 
(1)   Interpreter analyses each source statement every 
time it is to be executed 
(2)    Interpreter is a kind of translator 
(3)    Interpreter generates an object program from the 
source program 
(4)   All of the above 
(5)    None of these  
111. The errors that can be pointed out by the compiler are 
(1)   All of the above 
(2)    Semantic errors 
(3)    Logical errors  
(4)   Syntax errors  
(5)    None of these 

112.  C is 

(1)    An assembly language 
(2)    A machine language 
(3)    A third generation high level language 
(4)    All of the above 
(5)    None of these 
113. A   graph   preapared   by   a computer 
(1)    is its output 
(2)    None of these 
(3)    is a hard copy 
(4)    all of the above  

(5)    is the piece of information to use 
114. Which of the following does not represent on I/O device 
(1)   speaker which beeps  
(2)    ALU  
(3)   plotter 
(4)   joystick 
(5)    None of these 
115. The    communication     line between the CPU, memory 
and peripherals is called a  
(1)   all of these    (2)   line  
(3)    media  (4)   Bus  
(5)    None of these 
116. Memories which can be read only are called.............. 
memories 
(1)    ROM  (2)   RAM  
(3)    PROM          (4)   EPROM  
(5)   None of these 
 
 

117. Example  of  non-numerical data is  
(1)   All of the above 
(2)    Examination score 
(3)    Bank balance 
(4)    Employee address  
(5)    None of these 
118. One thousand byte;   opresenta 
(1)    Megabyte 
(2)   Gigabyte 
(3)    None of these 
(4)    All of the above  
(5)    Kilobyte 
119. The language that the computer .  can understand and 
execute is called 
(1)   Application software  
(2)    Machine language 
(3)    System program 
(4)    All of the above 
(5)    None of these 
120. A step by step procedure used to solve a problem is 
called 
(1)    Operating system 
(2)    None of these 
(3)    Application Program 
(4)    All of the above 
(5)   Algorithm 
121. Which of the following holds the ROM, CPU, RAM and 
expansion cards 
(1 )    Mother board 
(2)    Cache memory 
(3)    Hard disk 
(4)   All of the above 
(5)    None of these 
122. The errors that can be pointed out by the compiler are 
(1)    Logical errors 
(2)   Semantic errors  
(3)  Syntax errors 
(4)    All of the above  5)    None of these 
123. A computer cannot "boot" if it does not have the  
(1)    Compiler      (2)   Loader 
(3)    None of these 
(4)    Assembler  
(5)   Operating system 
124. WAN hardware includes 
(1)    EOF 
(2)    Bridger and modems  
(3)   Multiplexors and routers 
(4)    All of above 
(5)    None of these 
125.Third generation computers 
(1)    Were the first to use built-in error detecting device 
(2)    Used transistors instead of vaccum tubes 
(3)    Were the first to use neural network 
(4)    None of these 
(5)    All of the above 
126. A Winchester disk is a 
(1)    None of these 
(2)    Removable disk 
(3)    Flexible disk 
(4)    All of the above  
(5)    Disk stack 
127. A computer can be defined as an electronic device that 
can be(choose the most precise definition): 
(1)  carry out arithmetical operation 
(2) accept and process data using a set of stored instructions 
(3)  carry out logical function 
(4)  present information on.a VDU 
(5)  None of these 
128. The Central Processing Unit: 
(1)    is operated from the control panel. 
(2)    is controlled by the input data entering the system  
(3)    controls all input, output and processing. 
(4)    controls the auxiliary storage unit 
(5)    None of these 

U
p

al
 R

an
ga

For More Book Download Here - http://GKTrickHindi.com

http://gktrickhindi.com/


129.Computer follows a simple principle called GIGO which 
means:  
(1)    garbage in garbage out 
(2)    garbage input good output 
(3)    great instructions great output 
(4)    good input good output. 
(5)    None of these 
130. The term 'baud' is a measure of the:  
(1)    memory capacity 
(2)   speed at which data travels over the communication line 
(3)    instruction execution time 
(4)    all of the above 
(5)    None of these 
131. A bootstrap is: 
(1)    a memory device 
(2)    a device to support the computer 
(3)    an error correction technique 
(4)    a small initialisation program to start up a computer 
(5)    None of these 
132.Which of the following is not hardware: 
(1)    Magnetic tape 
(2)    Printer  
(3)    Assembler 
(4)    VDU terminal 
(5)    None of these 
133. Pick out the wrong definition : 
(1)    EDP- acronym for Electronic Data Processing 
(2)    COBOL-a language used for business data processing 
(3)    Control unit - heart of a computer. 
(4)    None of these  
(5)    Access time-time needed to access the output 
134. Terminal is a: 
(1)    point at which data enters or leaves the computer 
(2)   device to give power supply to computer 
(3)   the last instruction in a program 
(4)    any input /output device. 
(5)    None of these 
135. Multiple choice examination answer sheets can be 
evaluated automically by 
(1)   Optical Character Reader  
(2)    Optical Mark Reader 
(3)    Magnetic tape reader 
(4)   Magnetic ink character reader. 
(5)    None of these 
136. An operating system 
(1)   is not required on large computers 
(2)   is always supplied with the copmuter 
(3)   consists of programs that help in the operation of 
computer. 
(4)   is always supplied with the BASIC 
(5)   None of these 
137. Which of the following would cause quickest acess 
(1)   direct  access  from   a magnetic tape 
(2)   direct   access   from   a cassette tape 
(3)   direct access from a floppy disk  
(4) direct access from a hard disk  
(5) None of these 
138. The process of retaining data for future use is called  
(1)    reading       (2)   storing  
(3)   writing  (4)   coding  
(5)    None of these 
139. A file is corrected immediately after the input of a trans-
action.This is an example of 
(1)   on-line updating 
(2)    batching 
(3)   sorting 
(4)   off-line updating  
(5)    None of these 
140. Magnetic tapes are good storage media for 
(1)   backup and low volume data 
(2)   None of these 
(3)   storing original but low volume data 
(4)   storing original but high volume data 
(5)   backup and high volume data 

141.Which of the following is a computercode  
(1)    EPROM       (2)   JAVA  
(3)   All of the above 
(4)    EBCDIC 
(5)    None of these 
142. Data is generally coded in 8-bit units, such a unit is also 
called  
(1)    k   (2)   byte  
(3)   field              (4)   Word  
(5)    None of these 
143. Half adder is logic CKT that adds. .........Digit at a time 
(1)    three  (2)   one  
(3)   Two             (4)   zero  
(5)    None of these 
147. In 1st Complement a number which is Subtracted from 
other number is known as.......... 
(1)    Carry 
(2)   subtrahend 
(3)    All of this  
(4)    minuend  
(5)    None of these 
148. In a 2nd Complement a number which is subtracted 
from other number is known as........... 
(1)    Carry  (2)   Minuend 
(3)    Subtrahend  (4)   All of this  
(5)    None of these 
149. In 2nd Complement a number which is subtracted from 
other number is known as............. 
(1)    Minuend  (2)   Subtrahend 
(3)    Carry  (4)   All of this  
(5)    None of these 
156...........Are used for converting one type of number 
system in to other form. 
(1)    half adder 
(2)    logic gate 
(3)    Encoder      (4)   FA  
(5)    None of these 
157.......... Are used for converting one type of number 
system in to the other form  
(1)    logic gate  (2)    Decoder 
(3)   half adder     (4)   Full adder  
(5)    None of these 
158. Multiplexer means................. 
(1)    One in to many 
(2)    All of these 
(3)    many in to many  
(4)    many in to one  
(5)    None of these 
159. Multiplexers is also known as.  
(1)    adder  (2)   demux 
(3)    mux (4)    subtracter 
(5)    None of these 
160. ASCII code isa......... bit code. 
(1)    1   (2)   2  
(3)    9       (4)    8 
(5)    7 
162.The    decimal    number    is converted in to excess 3 
codes by adding, to each decimal digit. 
(1)    4   (2)   8  
(3)    3                   (4)   2 
(5)    7  
163.  110+110=............ 
(1)    3   (2)   0 
(3)    1   (4)   2 
(5)    None of these  
164.  12+12=........... 
(1) 1   (2) 0  
(3) 2   (4) 3  
(5) None of these 
165.The digital system usually operated on.........system. 
(1)   decimal       (2)   binary 
(3)   octal 
(4)   hexadecimal 
(5)    None of these 
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166. The binary system use powers of..........for positional 
values. 
(1)    16   (2)   10  
(3)    8                 (4)   2 
167. After counting 0, 1, 10, 11, 'the next binary number is 
(1)    100  (2)   12  
(3)    101         (4)   110  
(5)    None of these 
170. In logic algebra, variables can assume only two 
values:either..........or 1. 
(1) 2  (2) 4  (3) 3  
(4) 0  (5) None of these 
171. A logic gate is an electronic circuit which 
(1)    None of these 
(2)    allows electron flow only in one direction 
(3)    works on binary algebra 
(4)    alternates between 0&1 values 
(5)    makes logic decisions 
172. In positive logic, logic gate 1 corresponds to 
(1)    positive voltage 
(2)    zero voltage level 
(3)    higher voltage level 
(4)    lower voltage level 
(5)    None of these 
173. In negative logic, the logic state 1 corresponds to 
(1)    lower voltage level 
(2)    negative logic 
(3)    zero voltage 
(4)    more negative voltage 
(5)    None of these 
175. An X-OR gate produces an output only when it's two 
inputs are  
(1)    high  (2)   low 
(3)    None of these 
(4)    same         (5)   different 
176. An AND gate 
(1)    is equivalent to a series switching circuit 
(2)    implements logic addition 
(3)    is an any-or-all gate 
(4)    is equivalent to a parallel switching circuit 
(5)    None of these 
178. The only function of a NOT gate is to 
(1)    stop a signal 
(2)    recomplement a signal 
(3)    act as a universal set 
(4)    invert an input signal  
(5)    None of these 
179. A NOR gate is ON only when all it's inputs are 
(1)    OFF  (2)   positive  
(3)    higb              (4)   ON  
(5)    None of these 
181.Karnaugh map (K-map) technique provides a systematic 
method for simplifying ——— 
(1)    multiplexers 
(2)    logic gates 
(3)   All of these 
(4)    None of these 
(5)   Boolean expressions 
184. A octal is group of —— 1's  
(1)   2  (2)   6  (3)    8  
(4)   4  (5)   None of these 
187. A Register   is a group of — —  
(1)    Flip-flops 
(2)    OR & AND gate 
(3)    OR gates 
(4)   All of these 
(5)   None of these 
192.The   First   Microprocessor was ______  
(1)   8080  
(2)   Intel 4004 
(3)    8085 
(4)    4008 
(5)   None of these 
 

193. 8085 was introduced in ___  
(1)    1971  (2)    1972  
(3)    1976             (4)    1978  
(5)    None of these 
194. In 1978 Intel introduced the 16 bit Microprocessor 8086   
now called as_____  
(1)    APX80         (2)    M6800 
(3)    ZylogzSOOO 
(4)    Intel 8086 
(5)    None of these 
195.Which is a 8 bit Microprocessor ______  
(1)    Intel 4040  
(2)    Motorala MC-6801 
(3)    Pentium-I 
(4)    8088 
(5)    None of these 
196. Pentium-l, Pentium-ll, Pentium III and Pentium-IV are 
recently introduced microprocessor by______ 
(1)    Motorala      (2)   None 
(3)    Stephen Mors 
(4)    Intel  
(5)    None of these 
197. The address bus flow in ____ 
(1)    unidirection k     (2)    bidirection 
(3).  Mulidirection  (4)    Circular 
(5)    None of these 
198. Status register is also called as _______  
(1)    Accumulator 
(2)    None of these 
(3)    Counter        
(4)   Stack 
(5)   flags 
 (1)    8 bit data 
203. The First electronic computer was completed in ___ . 
(1)    1941  (2)   1938  (3)    1946     
(4)    1950  (5)    None of these 
204. The First Generation of computer appeared during the 
period __ . 
(1)    1937 to 1949 
(2)    1964 to 1974 
(3)    1934 to 1944  
(4)    1945 to 1954  
(5)    None of these 
205.The Second Generation of computers used ___ 
(1)    Transistors   
(2)    IC-Chip 
(3)    Vaccum tubes 
(4)    Microprocessor chip 
(5)    None of these  
206. The fourth Generation began in________  
(1)    1974  
(2)    1965  
(3)    1935               
(4)    1975 
(5)     None of these  
207. ____is used .to create Large program on internet  
(1)    C++  
(2)   HTML  
(3)    Java script 
(4)    C language 
(5)    None of these 
208.The Device which converts instructions into the binary 
form that  is  understood  by  the computer and supply to the 
computer is known as___.  
(1)    Memory        
(2)   Output  
(3)    Automatic   
(4)   Input  
(5)    None of these 
209. Laptop PCs are also known as ___Computers  
(1)    Mainframe     (2)   Super 
(3)    Notebook 
(4)    personal 
(5)    None of these  
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210. The symbol is used to indicate a point at which decision 
has to be made __ . 
(1)    decision 
(2)    Connector 
(3)    processing   
(4)   Terminal  
(5)    None of these  
211 . Windows 98 is ____________ 
(1)    Graphics System 
(2)    None of these 
(3)    Drawing system 
(4)    Processing system 
(5)   Operating System 
212. A common topology to any network is _ __ topology 
(1)    Star  (2)   Bus  
(3)   Tree             (4)   Ring  
(5)    None of these 
213. A flip flop has ____ stable status 
(1)   Two       (2)   five 
(3)   four  (4)   Three 
(5)   None of these  
214. Flip flop is also called as _____ 
(1)   Stable  (2)   Tri stable  
(3)    bistable 
(4)   not stable 
(5)   None of these  
215. The number system that we use in our day to day life is 
called the Number System __ .  
(1)    Octal  (2)   Decimal 
(3)   hexadecimal 
(4)    Binary 
(5)   None of these  
216.The    Binary    system    has base ___ .  
(1)   2   (2)   8 
(3)    10   (4)   16 
(5)   None of these  
217. The Octal Number system has base ______ 
(1)   2   (2)   10 
(3)    10   (4)   8 
(5)    None of these  
218. The Decimal Number system has base ___ . 
(1)    8   (2)   10  
(3)    16                 (4)   2  
(5)    None of these  
219.The   Hexadecimal   Number system has base_.  
(1)    2                  (2)   10 
(3)    None of these 
(4)    8   (5)    16  
225. Hexadecimal number system has ..... symbols.  
(1)    16   (2)   12 
(3)    15   (4)   10 
(5)    None of these  
226.Octal number system has ..... symbols. 
(1)    15   (2)   16 
(3)    10   (4)   8 
(5)   None of these 
227. Binary number system has ..... symbols. 
(1)    15   (2)   2  
(3)    16   (4)    10  
(5)   None qtthese 
228. Decimal n/mber system has ..... symljfls.  
(1)    15   (2)   16 
(3)    10   (4)   2  
(5)    None of these 
237. The binary equivalent of (64)10 ,     is : 
(1)    11000000    (2)    1100000  
(3)    1100010 I  (4)    1000000  
(5)    None of these  
238. The two kinds of main memory are: 
(1)    ROM and RAM 
(2)    Random and sequential 
(3)    Primary and secondary 
(4)   All of above 
(5)    None of these  

239.Which of the following will happen when data is entered 
into a memory location?  
(1)    It will add to the content of the location 
(2)    It will erase the previous content 
(3)    It will change the address of the memory location 
(4)    It will not be fruitful if there is already some data at the 
location 
(5)    None of these 
240. A storage area used to store data to   a   compensate   
for   the difference in speed at which the different units can 
handle data is 
(1)    Buffer  (2)   Memory 
(3)    Accumulator 
(4)   Address 
(5)    None of these  
241. To locate a data item for storage is  
(1)    Field  (2)   Feed 
(3)    Fetch (4)    Database 
(5)   None of these 
242.Time during which a job is processed by the computer is 
(1)   Delay times   (2)    Execution time 
(3)   Real time 
(4)    Down time 
(5)   None of these 
243. A directly accessible appointment calendar is feature of 
a ... resident package  
(1)    CPU  (2)   ALU  
(3)    Buffer         (4)   Memory 
(5)    None of these 
244. The term gigabyte refers to 
(1)    1 024 megabytes 
(2)    1 024 kilobytes 
(3)    1024 bytes 
(4)    1 024 gigabyte 
(5)    None of these 
245. Which     of    the    following processors use RISC 
technology? 
(1)     486dx  (2)   486SX 
(3)    PowerPC     (4)   6340 
(5)    None of these 
247. The two major types of computer chips are 
(1)    External memory chip 
(2)    Primary memory chip 
(3)    Microprocessor chip 
(4)    None of these  
(5)    Both 2 and 3  
248. As compared to the secondary memory, the primary 
memory of a computer is 
(1)    Large  (2)   Cheap 
(3)    Slow  (4)   Fast 
(5)    None of these 
249.  Which of the following is a way to access secondary 
memory? 
(1)    Action method 
(2)   Transfer method 
(3)    Density method 
(4)    None of these 
(5)    Random access memory .  
250. Which of the following memories allows simultaneous 
read and write operations?  
(1)    ROM  (2)   EPROM 
(3)    RAM 
(4)    None of above 
(5)    None of these .  
251. Which of the following memories has the shortest 
access times? 
(1)    Magnetic bubble memory  
(2)   Cache memory 
(3)    Magnetic core memory 
(4)    RAM 
(5)    None of these 
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253. A set.of information that defines the status of resources 
allocated to a process is 
(1)    Process control 
(2)    ALU 
(3)    Register Unit 
(4)    None of these  
(5)    Process description 
254.Any method for controlling access to or use of memory 
is known 
(1)    Memory map 
(2)    None of these 
(3)    Memory management 
(4)    Memory instruction  
(5)    Memory protection 
255. A type of core store that has a lower access time than 
the de-vices used for working store in   the   same   
processor   is known as  
(1)    Core memory   
(2)    Address register  
(3)    Fast core      
(4)   Buffer  
(5)    None of these 
257. A disk storage medium in the form of an assembly 
contain-ing a single rigid magnetic disk permanently is 
(1)    Fixed disk 
(2)    Card reader 
(3)    Card punch   
(4)    Disk cartridge 
(5)    None of these 
258. A memory that is capable of determining whether a 
given da-tum is contained in one of its address is 
(1)    ROM  
(2)   CAM  
(3)    PROM  
(4)    RAM 
(5)    None of these 
259. A method of implementing a memory management 
system is 
(1)   All of the above    
(2)    Bridgeware 
(3)    Broadband coaxial system  
(4)    Buddy system 
(5)    None of these 
260. A plastic card similar to a credit card but having some 
memory and a microprocessor embedded within it is 
(1)    Chip card 
(2)    Card punch 
(3)    Magnetic tape 
(4)    None of these  
(5)    Punched paper tape 
261. The use of spooler programs and/or .........Hardware 
allows personal computer operators to do the processing 
work at the same time a printing operation is in progress  
(1)    Registered mails . 
(2)    Buffer 
(3)    CPU  
(4)   Memory  
(5)    None of these 
262.Which chips using special ex-ternal equipment can 
reprogram 
(1)    PROM  (2) ROM  
(3)   SAM  (4) RAM  
(5) None of these 
263. Interface electronic circuit is used to interconnect I/O 
de-vices to a computer's CPU or  
(1) ALU   (2) Register  
(3) Buffer  (4) Memory  
(5) None of these 
264. Which term is used to describe RAM? 
(1)    Dynamic RAM (DRAM) 
(2)    Static RAM (SRAM) 
(3)    Videc RAM (VRAM) 
(4)    None of these  
(5)    All of the above 

265. Which is the type of memory for information that does 
not change on your computer?   
(1)    ROM 
(2)    RAM 
(3)    ERAM 
(4)    RW/RAM 
(5)    None of these 
266. A typical personal computer used for business purposes 
would have... of RAM.  
(1)    4KB  (2)   256 K  
(3)    64 K             (4)   16 K  
(5)    None of these 
267.Which computer memory is used for storing programs 
and data currently being processed by the CPU? 
(1)    Mass memory 
(2)    None of these 
(3)    Non-volatile memory 
(4)    PROM  
(5)    Internal memory 
268.Which of the following is a sec-ondary memory device? 
(1)    Disk 
(2)    Keyboard 
(3)    ALU 
(4)    All of the above 
(5)    None of these 
269. The difference between memory and storage is that 
memory is ......and storage is... 
(1)    Permanent, temporary ..  
(2)   Temporary, permanent 
(3)   Slow, fast 
(4)    All of above 
(5)    None of these 
270. Which of the following regis-ters is used to keep track of 
address of the memory location where the next instruc-tion is 
located? 
(1)   Memory address register 
(2)    Memory data register 
(3)    Instruction register 
(4)   None of these  
(5)    Program counter 
271. How many'address lines are needed to address each 
memory location in a 2048 x 4 memory chip?  
(1)    10   (2)   12  
(3)    8                 (4)   11  
(5)    None of these 
272.The     memory     which     is pro-grammed at the time it 
is manufactured  
(1)    PROM  (2)   RAM  
(3)    POM (4)    EPROM 
(5)    None of these   
273. Registers, which are partially visible to users and used 
to hold conditional, are known as 
(1)   PC 
(2)    General purpose register 
(3)    Memory address registers 
(4)    Flags 
(5)    None of these 
274. The two basic types of record access methods are: 
(1)   Online and real time 
(2)    Sequential and indexed 
(3)   Direct and immediate   
(4)   Sequential and random  
(5)    None of these 
275.Which    of    the    following memo-ries needs refresh? 
(1)    DRAM  (2)   SRAM 
(3)    ROM (4)   All of above 
(5)    None of these 
276. Access time is 
(1)   seek time 
(2)   seek time + latency time 
(3)   seek time - latency time 
(4)   latency time 
(5)    None of these 
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277. Seek time is 
(1)   time to position the head over proper cylinder 
(2)   time to position the head over proper sector   
(3)   time to position the head over proper track 
(4)   none of above 
(5)    None of these 
278.A name or number used to identify a storage location 
devices?  
(1)   A byte  (2)   A record  
(3)   All of above   (4)   An address  
(5)    None of these 
279. Which of the following regis-ters is loaded with the con-
tents of the memory location pointed by the PC? 
(1)    Memory address registers  
(2)   Instruction register 
(3)   Memory data registers 
(4)   Program counter 
(5)   None of these 
280. Codes consisting of bars or lines of varying widths or 
lengths that are computer-readable are known as— 
(1)   an ASCII code 
(2)   a magnetic tape  
(3)   a bar code 
(4)   an OCR scanner 
(5)   None of these  
281. A __ represents approximately one billion memory 
location. 
(1)   kilobyte      (2)   gigabyte  
(3)    megabyte     (4)   terabyte  
(5)   None of these 
282. In a database ___ fields store numbers   used  to   
perform calculation.  
(1)    Next  (2)   Key 
(3)   Alphanumeric 
(4)    None of these  
(5)   Numeric 
283. A (n)_ is a program that makes the computer easier to 
use. 
(1)   Operating system 
(2)   Application 
(3)    Network    
(4)   Utility  
(5)   None of these 
284. Storage that retains its data after the power is turned off 
is referred to as  
(1)     non-volatile storage  
(2)    volatile storage 
(3)    sequential storage  
(4)    direct storage  
(5)    None of these   
285. Which of the following is the largest unit of storage ?  
(1)    KB   (2)   GB  
(3)    MB       (4)   TB  
(5)    None of these 286.  
286. The person contributing the idea of the stored program 
was  
(1)    Daniel Thomas  
(2)   Charles Babbage  
(3)    Howard Aiken  
(4)    John Neumann         
(5)    Dennis Ritenie.  
287. Which of the following refers to the memory in your 
computer?  
(1)    USB            (2)   DSL       
(3)    RAM            (4)    LAN  
(5)    CPU 
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121.(1) 122.(3) 123.(5) 124.(3) 

125.(4) 12G.(5) 127 .(2) 128.(3) 

129.(1) 130.(2) 131 .(4) 132.(3) 

133.(5) 134.(1) 135.(2) 136.(3) 

 

137.(4) 138.(2) 139.(1) 140.(5) 

141 .(4) 142.(2) 143.(3) 144.(5) 

145.(1) 146.(3) 147.(4) 148.(3) 

149.(1) 150~(3) 151 .(2) 152.(2) 

153.(1) 154.(4) 155.(2) 156.(3) 

157 .(2) 158.(4) 159.(3) 160.(5 

161 .(2) 162.(3) 163.(4) 164.(1) 

165.(2) 166.(4) 167-(1) 168,(2) 

169.(3) 170.(4) 171 .(5) 172.(3) 

173.(1) 174.{2) 175.(5) 176.(1) 

177.(3) 178.(4) 179.(1) 180.(4) 

181 .(5) 182.(2) 183.(1) 184.(3) 

185.(2) 186.(4) 187.(1) 188.(3) 

189.(3) 190.(1) 191 ,(4) 192.{2) 

193.(3) 194.(1) 195.(2) 196.(4) 

197.(1) 198.(5) 199.(4) 200.(2) 

201 .(3) 202.(4) 203.(3) 204.(4) 

205.{1) 206.(2) 207.(3) 208.(4) 

209.(3) 210.(1) 211. (5) 212.(1) 

213.(4) 214.(3) 215.(2) 216.{1) 

217.(4) 218.(2) 219.(5) 220.(3) 

221 .(1) 222.(2) 223.(3) 224.(4) 

225.(1) 226.(4) 227.(2) 228.(3) 

229.(5) 230.(1) 231 .(2) 232.(4) 

 

233.(5) 234.(1) 235.(3) 236.(2) 

237.(4) 238.(1) 239.(2) 240.(1) 

241 .(3) 242.(2) 243.(4) 244.(1) 

245.(3) 246.(4) 247.(5) 248.(4) 

249.(5) 250.(3) 251.(2) 252.(1) 

253.(5) 254.(5) 255.(2) 256.(1) 

257.(4) 258.(2) 259.(4) 260-(5) 

261 .(2) 262.(1) 263;(4) 264.(5) 

265.(1 266.(2) 267.(5) 268.(1) 

269.(2) 270.(5) 271 .(4) 272.(3) 

273.(2) 274.(4) 275.(1) 276. (2) 

277.(3) 278.(4) 279.(2) 280. (3) 

281. (2) 282.(5) 283.(4) 284.(1) 

285.  (2) 286. (4) 287. (3) 
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Computer Networks 
1.    _____terminals (formerly known as cash registers) are 
often connected to complex inventory and sales computer 
systems. 
(1)   Point-of-sale (POS) 
(2)   Data  (3)   Sales 
(4)   Query 
(5)   None of these 
2.    Smaller and less expensive PC-based servers are 
replacing ____ in many busi-nesses. 
(1)    supercomputers 
(2)    mainframes 
(3)   laptops        (4)   clients  
(5)    None of these 
3.    DSL is an example of a(n) _____  connection. 
(1)   network       (2)   wireless 
(3)   slow 
(4)   None of these 
(5)   broadband 
4.    A term used to describe interconnected computer 
configuration is 
(1)   Micro program sequence 
(2)   Modulation 
(3)   Multiprocessing 
(4)   Multiprogramming 
(5)   None of these 
5.    What is required when more than one person uses a 
central computer at the same time? 
(1)    Light pen      (2)   Mouse  
(3)    Terminal       (4)   Digitizer  
(5)    None of these 
6.    Multi user systems provided cost savings for small 
business because they use a single pro-cessing unit to link 
several 
(1)    Personal computers 
(2)    Dumb terminals 
(3)    Workstations 
(4)    Mainframes 
(5)    None of these 
7.    A dumb terminal has 
(1)    An   embedded   micro-proces- 
(2)    Extensive memory 
(3)   A keyboard and screen 
(4)    Independeh I processing 
(5)    None of these 
8.    What is the full form of USB as used in computer related 
activities ? 
(1)    Universal Serial Bus 
(2)   Ultra Serial Block 
(3)    United Service Block 
(4)    Universal Security Block 
(5)    None of these  
9.    A device that connects to a network without the use pf 
cables is said to be—  
(1)   distributed 
(2)    open source 
(3)    centralized    
(4)   wireless  
(5)    None of these  
10. A ___ is a collection of com-puters and device connected 
together. 
(1)    network 
(2)    memory card 
(3)    protocol 
(4)    central processing unit 
(5)    None of these Allahabad Bank Clerk Exam, 31.08.2008 
11.   Multiplexing involves_ path and _ channel. 
(1)    one, one 
(2)    multiple, one 
(3)   one, multiple 
(4)    multiple, multiple 
(5)   None of these 
 

12. Which one amongst them is not an inter network ?  
(1)    LAN  (2)   WAN 
(3)    MAN 
(4)   All are internet works 
(5)    None of these 
13.  A proxy server is used for which of the following ? 
(1)   To provide security against unauthorized users  
(2)   To provide TCP/IP 
(3)   To process client requests for datab'ase access 
(4)   To process client requests for Web pages 
(5)   None of these 
14. The ability to easily add addi-tional users means that a 
net work is 
(1)   secure 
(2)   dedicated 
(3)   decentralized 
(4)   scalable 
(5)    None of these 
15. If you wish to extend the length of the network without 
having the signal degrade, you would use a  
(1)    repeater       
(2)   switch  
(3)   gateway        
(4)   router  
(5)    None of these 
16. A(n) __ is a private corporate network, used exclusively 
by company employees. 
(1)    intranet 
(2)   local area network 
(3)    peer-to-peer 
(4)   Internet 
(5)    None of these 
17. A characteristic of a file server is which of the following ? 
(1)   Acts as a fat client and is limited to one PC 
(2)   Manages file operations and is limited to one PC 
(3)   Acts as a fat client and is shared on a network 
(4)   Manages file operations and is shared on a network 
(5)    None of these 
18. Which of the following terms is just the connection of net-
works that can be joined together? 
(1)    Virtual private network 
(2)    Internet 
(3)    None of these 
(4)    Extranct      (5)   Intranet  
19. Servers are computers that provide resources to the 
other computers connected to a _  
(1)    Mainframe     (2)   Network 
(3)    Super computer 
(4)    Client 
(5)    None of these  
20. The most important or power-ful computer in a typical 
network is 
(1)    desktop 
(2)    network cliejit 
(3)    network station 
(4)    network server 
(5)    None of these SBI Clerk Exam, O6.07.200S 
21. To make a notebook act as a desktop model, the 
notebook can, be connected to a__ which is connected to a 
monitor and other devices. 
(1)    bay  (2)   network 
(3)    port 
(4)    docking station 
(5)    None of these 
22. A set of rules that computer on a network use to commu-
nicate with each other are called 
(1)    Protocol 
(2)    Regulations 
(3)    Rules 
(4)    Netiquettes 
(5)    None of these  
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23. Which of the following refers to a small, single site 
network?  
(1)    CPJ  (2)   DSL 
(3)    RAM  (4)    USB 
(5)    LAN 
24.  Computer connected to a LAN {Local Area Network) can 
(1)    share information and/or share peripheral equipment 
(2)    go on line 
(3)    run faster     (4)   E-mail  
(5)    None of these 
25. The __ is a device that connects n inputstom outputs, 
(1)    Crosspoint 
(2)    Crossbar 
(3)    None of these 
(4)    RAM  
(5)   Modem  
26. The sharing of a medium and its path by 2 or more 
devices is called _. 
(1)    Multiplexing 
(2)    Encoxing 
(3)    Line discipline 
(4)    Modulation 
(5)    None of these  
27. Which multiplexing technique transmits ariatog signals ? 
(1)    Asynchronous TDM 
(2)    Synchronous TDM 
(3)    FDM 
(4)    Both (2) and (3) 
(5)    None of these 
28.  Network   components   are connected to the same 
cable in the— topology,  
(1)    mesh  (2)   ring  
(3)   bus              (4)   star  
(5)    mixed 
29.  Two    or    more   computers connected to each other 
for shar-ing information form a ——  
(1)    pipeline        (2)   router  
(3)    server          (4)   tunnel 
(5)    network  
30.  Office LANs that are spread geographically apart on a 
large scale can be connected using a corporate ——  
(1)    CAN  (2)   WAN  
(3)    DAN             (4)   LAN  
(5)    TAN  
31.  For separating channels in FDM, it is necessary to use 
(1)    Differentiation 
(2)    Bandpass filters 
(3)    Time slots 
(4)   All of the above 
(5)    None of these 
32.  Encryption and decryption are functions of 
(1)   Transport layer 
(2)    None of these 
(3)    Presentation layer 
(4)    Allot the above 
(5)    Session layer 
33.  Which type of switching uses the  entire capacity of a 
dedicated link? 
(1)    Datagram Packet Switch-ing 
(2)    Virtual   Circuit   Packet Switching 
(3)   Circuit switching 
(4)    Message Switching 
(5)    None of these 
34. A peimanent virtual circuit involves 
(1)    All of the above (2)    Data transfer 
(3)    Connection release 
(4)   Connection establishment 
(5)    None of these 
35.  X.21 protocol consists of 
(1)    Only physical level 
(2)    Frame and packet levels 
(3)    Physical,    frame    and pack-et levels 
(4)   Physical and frame levels 
(5)    None of these 

36.  In OSI network architecture, the dialogue control and 
token management are responsibility of 
(1)    transport layer 
(2)    network layer 
(3)    session layer 
(4)    data link layer 
(5)    none of above 
37.   In OSI network architecture, the routing is performed by 
(1)    data link layer 
(2)    network layer 
(3)   .transport layer 
(4)    session layer 
(5)    none of above 
38. Which of the following performs modulation and 
demodulation?  
(1)    modem        (2)   satellite 
(3)    coaxial cable 
(4)    fiber optics 
(5)    none of the above 
39. The process of converting analog signals into digital 
signals so they can be processed by a receiving computer is 
referred to as: 
(1)    modulation 
(2)    digitising 
(3)    synchronizing 
(4)    demodulation 
40. How many OSI  layers are covered in the X.25 standard? 
(1)    Two  (2)   Seven  
(3)    Three           (4)   Six  
(5)    None of above 
41. Layer one of the OSI model is 
(1)    transport layer 
(2)    link layer 
(3)    physical layer 
(4)    network layer 
(5)    none of above   . 
42. The x.25 standard specifies a 
(1)   technique for start-stop data  
(2)    technique for dial access 
(3)   data bit rate 
(4)    DTE/DCE interface 
(5)   none of above 
43. Which    of    the    following communication modes 
support -two-way traffic but in only one direction at a time? 
(1)    half duplex    
(2)   simplex 
(3)    three-quarters duplex 
(4)    all of the above 
(5)    none of the above 
44. Wh ch of the following might be used by a company to 
satisfy following communications needs? 
(1)   front end processor 
(2)    all of the above 
(3)    controller 
(4)    concentrator ,, 
(5)    multiplexer 
45. The interactive transmission of data within a time sharing 
system may be best suited to 
(1)    simplex lines 
(2)    biflex-lines 
(3)   full duplex lines 
(4)    half-duplex lines 
46.  Which of the following statement is incorrect? 
(1)    Batch processing is the prefered processing mode for 
telecommunication operation. 
(2)    Half duplex line is a communication line in which data 
can move in two directions, but not at the same time. 
(3}   Teleprocessing combines telecommunications and DP 
techniques in online activities 
(4)    The difference between synchronous and asy-
nchronous trans mission is the clocking derived from the 
data in synchronous transmission. 
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47. Which of hte fallowing is considered a broad band 
communication channel? 
(1)   coaxial cable 
(2)   fiber optics cable 
(3)   all of above 
(4)   microwave circuits 
48.  Which of the following is not a transmission medium? 
(1)   telephone lines 
(2).   modem 
(3)   coaxial cables 
(4)   microwave systems 
49. Which of the following does not allow multiple uses or 
devices to share one communication line? 
(1)   concentrator 
(2)    multiplexer 
(3)   doubleplexer 
(4)   controller 
50. Which of the following signal is not standard RS 232-C 
signal?  
(1)    CIS  (2)   RTS  
(3)    VDR             (4)    DSR 
51. Which of the following statement is incorrect? 
(1)    Multiplexers are designed to accept data from several 
I/O devices and transmit a unified stream of. data on one 
communication tine 
(2)    RTS/CTS is the way the terminal indicates ringing 
(3)    RTS/CTS is the way the DTE indicates that it is ready 
to transmit data and the way the DCW indicates that it is 
ready to accept data 
(4)    HDLC is a standard synchronous communication 
protocol. 
52. Which of the following is an advantage to using fiber 
optics data transmission? 
(1)    resistance to data theft 
(2)   fast data transmission rate 
(3)    all of above 
(4)    low noise level 
53. Which of the following is required to communicate 
between two computers? 
(1)    all of above including access to transmission medium 
(2)    protocol 
(3)    communication hardware 
(4)    communications software 
54.  The transmission signal coding method of Tl carrier is 
called  
(1)    NRZ  (2)    Bipolar  
(3)    Manchester  (4)    Binary 
55. Which data communication method is used to transmit 
the data over a serial communication link? 
(1)    simplex (2)   half-duplex 
(3)    None of above 
(4)    band c 
(5)    full-duplex 
56. What is the minimum number of wires needed to send 
data over a serial communication link layer?  
(1)    2  (2)    1  
(3)    4   (4)    6  
(5)    none of above 
57.  Which of the following types of channels moves data 
relatively slowly? 
(1)    narrow band channel 
(2)    voice band challen 
(3)-   wide band channel 
58.  Most data communications involving telegraph lines use: 
(1)    simplex lines 
(2)    wideband channel 
(3)   dialed service 
(4)    narrowband channel 
59. A communications device that combines transmissions 
from several I/O devices into one line is a 
(1)    concentrator 
(2)    modifier 
(3)   full-duplex line 
(4)    multiplexer 

60. How much power (roughly) a light emitting diode can 
couple into an optical fiber? 
(1)    100 picowatts 
(2)    440 microwatts 
(3)    100 microwatts 
(4)    10 miliwatts 
61. The synchronous modems are more costly than the 
asynchronous modems because 
(1)  they contain clock recovery circuits 
(2)    they produce large volume of data 
(3)    they transmit the data with stop and start bits 
(4)   they operate with a larger bandwidth 
(5)    none of above 
62. Which of the following statement is correct? 
(1)   terminal section of a synchronous modem contains the 
scrambler 
(2)    transmission section of a synchronous modern contains 
the scrambler 
(3)    receiver section of a synchronous modem contains the 
scrambler 
(4)    control section of a synchronous modem contains the 
scrambler 
(5)    none of the above 
63.   In a synchronous modem, the digital-to-analog 
converter transmits signal to the 
(1)    demodulator 
(2)    modulator 
(3)    equilizer 
(4)   terminal 
(5)    none of aobve 
64. Which of the following communications lines is best 
suited to interactive processing appJIcatjons? 
(1)    narrow band channel 
(2)    simplex lines 
(3)    mixed band channels 
(4)    full duplex lines 
(5)    none of the above 
65. A remote batch-processing I operation in which data is 
solely input to a central computer would require 
(1)   telegraphp line 
(2)    none of the above 
(3)   mixed bad channel 
(4)   all of above 
(5)   simplex lines 
66. A band is always equivalent to  
(1)   a byte  
(2)   a bit 
(3)    100 bits 
(4)    none of the above .     
(5)   all of above 
67. The loss in signal power as light travels down the fiber is 
called 
(1)    interruption 
(2)    progragation 
(3)    scattering 
(4)   attenuation 
(5)    none of the above 
68. Avalanche photodiode receivers can detect bits of 
transmitted data by receiving 
(1)   200 photons 
(2)    100 photons 
(3)    2000 photons 
(4)    300 photons' 
(5)    none of the above 
69. Communiction circuits that transmit data in both 
directions but not at the same time are operating in 
(1)   a simplex mode 
(2)    all the options 
(3)    a full duplex mode 
(4)   a half duplex mode 
(5)   an asynchronous mode 
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70. An example of a medium speed, switched 
communications service is 
(1)   series 1000 
(2)   data phone 50  
(3)   All of the above 
(4)    ODD 
(5)   none of the above 
71.  In communication satellite,multiple repeaters are known as 
(1)   detector 
(2)    modulator 
(3)   transponders 
(4)    stations 
(5)    none of the above 
72. While transmitting-odd-parity coded symbols, the number 
of zeros in each symbol is 
(1)    odd 
(2)    unknown 
(3)   a and b both 
(4)    even 
(5)    none of the above 
73.  Data communications monitors available on the software 
marked include 
(1)   TOTAL 
(2)   ENVIRON/1 
(3)    BPL 
(4)    Tel net 
(5)    none of the above 
74. An exajnple of an analog communication method is 
(1)    laser beam 
(2)   microwave 
(3)    voice grade telephone line 
(4)    none of the above 
(5)   all of the above 
75. Number of bits per symbol used in Baudot code is . 
(1)    7  (2)   9  
(3)    8  (4)   5  
(5)    none of the above 
76. What is the main difference between DDCMP and 
SDLC? . 
(1)    DDCMP has a message header 
(2)    DDCMP does not need special hardware to final the 
beginning of a message 
(3)    SDLC has a IP address 
(4)    SDLC does not use CRC 
(5)    none of the above 
77. An example of digital, ratherthan analog, communication 
is  
(1)    DOS  (2)   DDD  
(3)    WATS   (4)    DOT  
(5)  none of the above 
78.  Terminals are required for 
(1)    real-time, batch processing & time-sharing 
(2)    real time, timesharing & distributed message 
processing 
(3)    real-time, time sharing & message switching 
(4)    real time, distributed processing & manager inquiry 
(5)    none of the above 
79. The receive equilizer reduces delay distortions using a 
(1)    gearshift 
(2)    descrambler 
(3)   tapped delay lines 
(4)    difference engine 
(5)    none of the above 
80.  Ina synchronous modem, the receive equilizer is known as 
(1)    impariment equilizer 
(2)    adaptive equilizer 
(3)    statistical equilizer 
(4)    compromise equilizer 
(5)    none of the above 
81. The channel in the data-communication model can be 
(1)    postal mail services 
(2)   telephone lines 
(3)    none of the above 
(4)    radio lines  (5)   all the above 

82. A data terminal serves as an 
(1)    Effector 
(2)    sensor 
(3)    neither a nor b 
(4)    both a and b 
(5)    none of the above 
83. Which of the following transmission systems provide the 
highest data rate to in individual device? 
(1)   telephone lines 
(2)    computer bus 
(3)   voice and mode 
(4)    lease lines 
(5)    none of the above    . 
84.  A protocol is a set of rules governing a time sequence of 
events that must take place 
(1)   between modems 
(2)    between an interface 
(3)    between peers 
(4)   across an interface 
(5)    none of the above 
85. __ is used in operating system to separate mechanism 
from policy 
(1)   Two level implementation 
(2)    Single level implementation 
(3)    Multi level implementation 
(4)    All of the above 
(5)    none of the above 
86. The operating  system creates. 
(1)    Virtual computers 
(2)    All the above 
(3)    Virtual device 
(4)   Virtual space 
(5)    none of the above 
87. from the physical computer__shares characteristics with 
both hardware and software 
(1)   All the above 
(2)    Software      (3)   Data 
(4)    Operating system 
(5)    none of the above 
88. Multiprogramming systems: 
(1)   Are easier to develop than single programming systems 
(2)    Execute more jobs in the same time period 
(3)    Execute each job faster 
(4)   Are used only one large mainframe computers. 
(5)   none of the above 
89. Which is the first program run on a computer when the 
computer boots up? 
(1)   Operating system 
(2)    System software 
(3)   System operations 
(4)   All the above .  
(5)   none of the above 
90.  Which is built directly on the hardware? 
(1)    Computer Environment 
(2)   Application Software 
(3)    Data base System 
(4)    Opera ti ng System 
(5)    none of the above 
91.  Which of the following-Operating System does not 
implement multitasking truly? ^ 
(1)    Windows 98  
(2)    Windows NT 
(3)    Windows XP 
(4)    none of the above  
(5)    MS DOS 
92. Which runs on computer hardware and serve as platform 
for other software to run on? 
(1)    Application Software 
(2)    Opera ti ng System 
(3)    System Software 
(4)    All the above 
(5)    none of the above 
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93. Which Is the layer of a computer system between the 
hardware and the user program 
(1)    Operating environment 
(2)    System environment 
(3)    Operating system 
(4)    All the above 
(5)    none of the above 
94. The primary purpose of an operating system Is: 
(1)    To make computers easier to use 
(2)   To allow peopleto use the computer, 
(3)   To keep systems programmers employed 
(4)    To make the most efficient use of the computer 
hardware 
(5)   none of the above 
95. When a computer is first turned on or restarted, a special 
type of absolute.loader called _ is executed  
(1)    Compile and Go loader 
(2)    Bootstrap loader 
(3)    Boot loader 
(4)    Relating loader 
(5)    none of the above 
96.  Which of the following Operating systems is better for 
Implementing a Client-Server network 
(1)    MS DOS 
(2)    Windows 2000 
(3)    Windows 98 
(4)    Windows 95 
(5)    none of the above 
97.  The operating system manages 
(1)    all the above 
(2)    Processes 
(3)    Disks and I/O devices/ 
(4)    Memory 
(5)    none of the above 
98.   Usually, in MSDOS, the primary hard disk drives has 
the drive letter __ 
(1)    A  (2)   B  
(3)    D (4)   C   
(5)    none of the above 
99.  What is the function of an operating system? 
(1)    Manages     computer's resources very efficiently 
(2)    Takes care of scheduling jobs for execution 
(3)    Manages the flow of date and instructions 
(4)    none of the above 
(5)   All of the above 
100. Which is not the function of the Operating System? 
(1)    Memory management 
(2)    Disk management 
(3)    Virus Protection 
(4)    Application management 
(5)    none of the above 
101. Which Operating System doesn't support networking 
between computers? 
(1)    Windows 95 
(2)   Windows 3.1 
(3)    Windows 2000 
(4)   Windows NT 
(5)    none of the above 
10a.Which    Operating System doesn't support long file 
names?  
(1) MS-DOS  
(2) OS/2 
(3)    Windows 95 
(4)    Windows NT 
(5)    none of the above 
103. Which file keeps commands to execute automatically 
when OS Is started? 
(1)    autoexec.bat 
(2)    any batch file 
(3)   command.com 
(4)    config.sys 
(5)    none of the above 
 
 

104. What should be the extension to execute files? 
(1)    .EXE 
(2)   All of the above 
(3)    .COM 
(4)    .BAT 
(5)    none of the above 
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MS-Word 
1. Pressing F8 key for three times select 
(1)   A word 
(2)   A sentence  
(3)   A paragraph 
(4)   Entire document 
(5)   None of these 
2.  What happens if you press Ctrl + Shift + F8? 
(1)   It   activates   extended selection 
(2)   It activates the rectangular selection 
(3)   It selects the paragraph on which the insertion line is. 
(4)   Insert picture  
(5)  None of these 
3.    How can you disable extended selection mode? 
(1)    Press F8 again to disable 
(2)    Press Del to disable 
(3)    Press Esc to disable 
(4)    Press Enter to disable 
(5)    None of these 
4. What does EXT indicator on status bar of MS Word 
indicate? 
(1)    It indicates whether the external text is pasted on 
document or not 
(2)    It indicates whether extended add-ons are installed on 
MS Word or not 
(3)    It indicates whether Extended Selection mode is turned 
on or off 
(4)    Jobs in printing 
(5)    None of these 
5.  What is the maximum number of lines you can set for a 
drop cap? 
(1)    3  (2)    10 
(3)    15  (4)   20 
(5)    None of these 
6.    What is the default number of lines to drop for drop cap? 
(1)    3 
(2)    10 
(3)    15  
(4)   20  
(5)    None of these 
7.    What is the shortcut key you can press to create a 
copyright symbol? 
(1)   Alt+Ctrl+C 
(2)    Alt + C 
(3)    Ctrl + C 
(4)    Ctrl + Shift + C 
(5)    None of these 
8.     How many columns can you insert in a word document 
in maximum? 
(1)    35  (2)   45  
(3)    55  (4)   65    
(5)    None of these 
9. What is the smallest and largest font size available in Font 
Size tool on formatting toolbar?  
(1)    8 and 72       (2)   8 and 64  
(3)    12 and 72     (4)    12&16  
(5)    None of these  
10. What is the maximum font size you can apply for any 
character? 
 (1)    163  (2)    1638  
(3)    16038        (4)    16388  
(5)    None of these 
11. Which   of  the  following   is graphics solution for Word 
Processors?  
(1)    Clipart  (2)   WordArt 
(3)    Drop Cap (4)   All of above 
(5)    None of these 
12. The keystrokes Ctrl  +  I  is "    used to 
(1)    Increase font size 
(2)    Inserts a line break 
(3)    Indicate the text should be bold 
(4)   Applies italic format to selected text 
(5)    None of these 

13. A character that is raised and smaller above the baseline 
is known as 
(1)    Outlined 
(2)    Raised   
(3)    Superscript 
(4)    Subscript 
(5)    None of these 
14.. What is the purpose of inserting header and footer in 
document? 
(1)   To enhance the overall appearance of the document 
(2)   To mark the starting and ending of page 
(3)   To make large document more readable To allow page 
headers and footers appear on document when printed 
(5)    None of these 
15.  Which of the following function key activates the speller? 
(1)    F5  
(2)    F7  
(1)    F9 
(4)    Shift +F7 
(5)    None of these 
16. The minimum number of rows and columns in MS Word 
document is 
(1)    1and1  (2) 2 and 1  
(3) 2 and 2  (4) 3 and 3  
(5) None of these 
17.  Thesaurus tool in MS Word is used for 
(1)    Spelling suggestions 
(2)    Grammar options  
(3)    Synonyms and Antonyms words 
(4)    All of above 
(5)    None of these 
18.  Why Drop Caps are used in document? 
(1 )    To drop all the capita! letters 
(2)    To automatically begin each   paragraph   with 
capital letter  
(3)    To begin a paragraph with a large dropped initial 
capital letter 
(4)    All of above 
(5) None of these  
19. A bookmark is an item or location in document that you 
identify as a name for future reference. Which of the 
following task is accomplished by using bookmarks? 
(1 )    To add anchors in web page  
(2)    To mark the ending of a paragraph of document  
(3)    To quickly jump to specific location in document 
(4)    To   add   hyperlinks in webpage 
(5)    None of these 
20.  A word processor would most likely be used to do 
(1 )    Keep . n account of money spent 
(2)    Do a computer search in media center 
(3)    Maintain an inventory  
(4)    Type a biography  
(5)    None of these 
21.  What happens when you click on Insert > > Picture > > 
Clip Art 
(1)    It inserts a clipart picture into document 
(2)    It lets you choose clipart to insert into document  
(3)    It opens Clip Art taskbar 
(4)    All of above 
(5)    None of these 
22. Which option is not available in Insert Table Autofit 
behavior? 
(1)    Fixed Column Width 
(2)    AutoFit to Contents 
(3)    Autofit to Window  
(4)    Autofit to Column  
(5)    None of these 
23. To autofit the width of column ' 
(1)    Double  click the  right border of column 
(2)    Double click the left border of column 
(3)    Double click the column header 
(4)    All of above 
(5)    None of these 
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24.   From which menu you can insert Header and Footer? 
(1)    Insert Menu  
(2)    View Menu 
(3)    Format menu 
(4)    Tools Menu 
(5)    None of these 
25. After typing header text, how can you quickly enter footer 
text?  
(1)    Press PageDown key and type the text for footer  
(2) Click on Switch between Heder & Footer then type the text 
(3)    Both of above 
(4)    By pressing F8 
(5)    None of these 
26. Which of the following statement is false?  
(1)   You can set different header footer for even and odd 
pages 
(2)    You can set different page number formats for different 
sections 
(3)    You  can   set  different header footer for first page of a 
section  
(4)   You  can  set  different header and footer for last 
page of a section  
(5)    None of these 
27. Where can you change the vertical alignment? 
(1)    Formatting toolbar 
(2)    Paragraph dialog box 
(3)    Page Setup dialog box 
(4)    Standard toolbar 
(5)    None of these 
28. To get to the 'Symbol' dialog box, click on the __ menu 
and choose 'Symbol',  
(1)    Insert  (2)   Format  
(3)    Tools            (4)   Table  
(5)    None of these 
29. Which of the following symbol sets would be most likely 
to contain a mathematical symboL such as a degree sign, 
greater than or equal to, or a Greek letter? 
(1)   Wingdings (2)    Wingdings 3 
(3)   Webdings 
(4)   Symbol     
(5)    None of these 
30. When assigning a shortcut key to a symbol, you should 
always try to select a key or key combination that is: 
(1)   unassigned 
(2)   Located on the ten-key pad section of your keyboard. 
(3)   Assigned to another task. 
(4)    From the same font family as the symbol. 
(5)    None of these 
31. Suppose you wanted to create j an AutoCorrect entry 
that would type the words 'We regret to , inform you that your 
submission has been declined' Of the following choices, 
which would be the best name you could assign to this 
entry?  
(1)   Regret  (2)    Subdual 
(3)    We regret to inform you that your submission has been 
declined 
(4)    Import (5)    None of these 
32.  If you want to convert a symbol or several lines of text 
into an AutoCorrect entry, you should: 
(1)    Insert the symbol or type the text in a Word document 
first. Then, select the text or symbol and go to the 
AutoCorrect dialog box. 
(2)    Click the Tools menu and choose AutoCorrect Options. 
Then, click the Insert menu and choose Symbol (or click the 
Format menu and choose Paragraph) to add the symbol or 
paragraph to AutoCorrect. 
(3)    AutoCorrect can only accommodate one line of text. It 
is not possible to convert a symbol or multiple lines of text 
into an Auto Correct entry. 
(4)    Insert the symbol or type the text in a Word document 
first. Then, select the text or symbol and click the Edit menu 
followed by Paste Special. Select New AutoCorrect Entry 
and then click OK. 
(5)    None of these 

33. AutoCorrect was originally designed to replace __ words 
as you type. 
(1)    Short, repetitive 
(2)    Grammatically incorrect 
(3)    Misspelled 
(4)    All of the above 
(5)    None of these 
34. Which of the following is the second step in creating a 
macro? 
(1)   Start recording 
(2)    Using  your  mouse  or keyboard, perform the task you 
want to automate  
(3)   Assign a keyboard shortcut to the macro 
(4)   Give the macro a name 
(5)    None of these 
35.  If you will be displaying or printing your document on 
another computer, you'll want to make sure and select the 
______ option under the 'Save' tab. 
(1)    Embed Fonts 
(2)    Embed True Type Fonts 
(3)    Save True Type Fonts 
(4)    Save Fonts 
(5)    None of these 
36.  In Word, the mailing list is known as the 
(1)    Datasheet    
(2)   Source . 
(3)    Data source 
(4)    Sheet 
(5)    None of these 
37. Which of the following is not one of the three 'Mail Merge 
Helper' steps? 
(1)    Merge the two files 
(2)    Create the main document  
(3)   Set   the   mailing   list parameters  
(4)   Create the data source 
(5)   None of these 
38. Which of the following button will allow you to add, 
delete, or change records in your Data Source? 
(1) 'Data Source1 button 
(2) 'Edit' button 
(3) 'Edit Data Source' button 
(4) 'Data editing' button • 
(5) None of these  
39.  It is possible to __ 
(1) Create         (2)   Modify 
(3) Sort 
all of the above (5)   None of these  
40. What is the default font size of a new Word document 
based on Normal template?  
(1)    10pt  (2)    12 pt 
(3)    14 pt (4)   All of above 
(5)   None of these 
41. What is the default font used in MS Word document?  
(1)   Times New Roman 
(2)   Arial 
(3)   Algerian (4)    Preeti 
(5)    None of these 
42. Which tab in Font dialog box contains options to apply 
font effects?  
(1)    Font tab 
(2)   Character Spacing 
(3)    Text Effects 
(4)    Standard Toolbar 
(5)    None of these 
43.  If you need to double underline a woTd, how will you do 
that? 
(1)    Go to Format menu and then Font option. Open 
Underline Style and choose Double Underline 
(2)    From Format menu choose Font option and then from 
Font tab open Underline Style and select Double Underline 
(3) Select the text then choose Format > > Font and on Font 
tab open Underline Style and choose Double Underline 
(4)    Click double underline tool on formatting toolbar 
(5)    None of these 
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44.  DropCap means 
(1)    All Caps 
(2)   Small Caps 
(3)   Title case  
(4)    All of above  
(5)   None of these 
45. What is the short cut key to open Font dialog box? 
(1)    Ctrl + F 
(2)    Alt + Ctrl + F  
(3)    Ctrl'+D 
(4)    Ctrl + Shift + D 
(5)    None of these 
46.  How can you access the font size tool on formatting 
toolbar? 
(1)    Ctrlt S 
(2)    Ctrl + Shift + S 
(3)    Ctrl + P  
(4)    Ctrl + Shift + P  
(5)    None of these 
47. How can you make the selected character superscripted?  

(1)   'Ctrl + - 
(2)    Ctrl + Shift + = 
(3)    Alt -*- Ctrl -t- Shift + = 
(4)    All of above 
(5)    None of these 
48.  What does Ctrl + - key effect?  
(1)    Superscript  
(2)    Subscript  
(3)    All Caps        
(4)   Shadow  
(5)    None of these 
50.  How can you increase the font size of selected text by 
one point every time? ^1)    By pressing Ctrl+ ] 
(2)    By pressing Ctrl + [ 
(3)    By pressing Ctrl + } 
(4)    By pressing Ctrl + { 
(5)    None of these 
51. Which of the following line spacing is invalid?  
(1)    Single  (2)   Double 
(3)    Triple            (4)    Multiple  
(5)    None of these 
54. On which toolbar can you find Format Painter tool?  
(1)   Standard toolbar  
(2)    Formatting toolbar 
(3)    Drawing Toolbar 
(4)    Picture Toolbar  
(5)   None of these 
55.  Which indent marker controls all the lines except first 
line? 
(1)    First Line Indent Marker  
(2)    Left Indent Marker 
(3)    Hanging Indent Marker 
(4)    Right Indent Marker 
(5)    None of these 
56.  How can you remove tab stop markers from ruler?  
(1)    Double click the tab marker and choose Clear All  
(2)    Drag the tab stop marker out of the ruler 
(3)    Right click the tab stop marker and choose remove 
(4)    All of above 
(5)    None of these 
57.  Which operation you will perform if you need to move a 
block of text?  
(1)   Copy and Paste 
(2)   Cut and Paste 
(3)    Paste and Delete 
(4)    Paste and Cut 
(5)    None of these 
58. What is the extension of Word files? 
(1)    RL  
(2)   DOT  
(3)    DOC  
(3)    TXT  
(5)    None of these 

59.  Which of the following option Is not available in Insert» 
Picture?  
(1)    Chart  (2)   Word Art  
(3)    Clip Art   (4)   Graph  
(5)    None of these 
60. To insert a drop cap in one of the paragraph you should 
access  
(1)    Insert Menu  
(2)   Format 
(3)   Tools 
(4)   All of above 
(5)    None of these 
61.  How many different positions can you set for drop cap? 
(1) 1                  (2)   2 
(3) 4                   (4)   6 
(5) None of these 
62.  What is the maximum number of lines you can set for 
lines to drop box? 
(1)    3   (2)   5  
(3)    10                 (4)    15  
(5)    None of these  
63.  Which of the following can NOT be used to create 
parallel style column? 
(1)    Format Tabs 
(2)    Table Insert Table 
(3)    Insert Textbox  
(4)    Format Columns  
(5)    None of these  
64.  Which of the following is used to create newspaper style 
columns? 
(1)    Format Tabs 
(2)    Table Insert Table 
(3)    Insert Textbox  
(4)    Format Columns  
(5)    None of these  
65.  Columns dialog box can be opened from 
(1)    Format menu Columns submenu 
(2)    Double click on column space in ruler 
(3)    Press Alt+ O + C  
(4)   All of above  
(5)    None of these  
66.  You can jump to the next column by 
(1)    Clicking with your mouse on the next column 
(2)    Press Alt + Down-arrow  
(3)    Both of above 
(4)    Press Alt + Right Arrow 
(5)    None of these  
67.  How can you break the current column and start a new 
column immediately?  
(1)    Press Ctrl + Shift + Enter 
(2)    Press Alt + Enter 
(3)    Press Ctrl + Enter  
(4)    Press Alt + Shift + Enter  
(5)    None of these  
68.  What is the smallest width of a column? 
(1)    0"   (2)   0.5"  
(3)    0.5"               (4)   1.5"    
(5)    None of these 
69.   If the number of columns is selected 1 and the line 
between check box is marked, where is the line drawn? 
(1)    in the left margin 
(2)    in the right margin 
(3)    both in left and right margin  
(4)    None of Above 
70.  The other Col# are inactive when you've select 3 
columns. How   will you activate those boxes? 
(1)    double click on spacing box 
(2)   double click on inactive Col# 
(3)    Remove mark from Line 
between checkbox   
(4)    Remove mark from Equal Column Width check box 
(5)    None of these 
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71. How much space in minimum must be provided between 
columns? 
(1)    0"   (2) 0.5"  
(3)    1"   (4) 1.5"  
(5) None of these 
72. To open Columns dialog box quickly  
(1)    double click on the left margin area of ruler  
(2)    double click the space between area on ruler 
(3)   double  click the  right margin in ruler 
(4)    All of above 
(5)    None of these 
73.  Which of the following command is not available in Tools 
menu?  
(1)    Auto text  (2)   Autocorrect 
(3)    Auto summarize (4)    Macro 
(5)    None of these 
74. To move the cursor page to page of document  
(1)   Ctrl+PgDn 
(2)   Ctrl+PgUp  
(3)   Both of above 
(4)    Ctrl + RightKey 
(5)   None of these 
75. Text boundary can be displayed or hidden from  
(1)   Auto text option from Insert menu  
(2)   Options from Tools menu 
(3)   Customize from  Tools menu 
(4)   All of above 
(5)    None of these 
76. Which of the following are word processing software? 
(1)   WordPerfect  
(2)    Easy Word 
(3)    MS Word  
(4)   All of above  
(5)    None of these 
77. MS Office provides help in many ways, which of these is 
one of them? 
(1)   What is this? 
(2)    Office Assistant 
(3)    Help menu  
(4)   All of the above  
(5)    None of these 
78. You wished to justify text over the height of paper, which 
option will you choose  
(1)   Page Setup from File menu 
(2)    Paragraph from Format menu 
(3)    From formatting toolbar .  
(4)    Font from Format menu  
(5)    None of these 
79. Which of the following is not of the merge process?  
(1)    Sort   the   data   source records 
(2)    Format a main document 
(3)    Edit a data source 
(4)   Merge the two files to print or create a new document 
(5)    None of these 
80. There can be many ways to insert   page   number   in   a 
document.   Which   of   the following lets you insert page 
number  
(1)    Page number from Insert menu  
(2)   Page Setup from file menu 
(3)   Footnote from Insert menu 
(4)    Both a & c 
(5)    None of these  
81.  Which is not a data source component?  
(1)    mail merge toolbar 
(2)    header row 
(3)    data fields 
(4)    data records 
(5)    None of these 
82. Which of the following is not the part of standard office 
suite? 
(1)   Word Processor (2)    Database 
(3)    Image Editor  (4)    File manager  
(5)    None of these 
 

83. Where can you find the Draw Table tool button? 
(1)    Standard toolbar 
(2)    Formatting toolbar 
(3)    Drawing toolbar  
(4)    Tables and Formatting toolbar  
(5)    None of these 
84. Which of the following option in File pull down menu is 
used to close a MS Word document?  
(1)    Quit  (2)   Close 
(3)    Exit 
(4)    New 
(5)    None of these 
85. You need to jump to the next column breaking current 
column right at the cursor position. How can you break 
column? 
(1)    Pressing Ctrl + Enter 
(2)    Pressing Alt + Shift + Enter  
(3)    Break  command   from Insert menu 
(4)    Both 2 and 3 
(5)    None of these 
86. Superscript, subscript, outline, emboss, engrave are 
known as  
(1)    font style  (2)   font effects 
(3)    word art 
(4)   text effects 
(5)    None of these 
87.  Shimmer, Sparkle text, Blinking Background etc. are 
known as 
(1)   font styles 
(2)   font effects 
(3)   word art  
(4)   text effects  
(5)    None of these 
88.  The feature of Word that automatically adjusts the 
amount of space between certain combination of characters 
so that an entire word looks more evenly spaced. What is 
that feature called? 
(1)    Spacing       (2)   Scaling  
(3)    Kerning 
(4)    Positioning  
(5)    None of these 
89. Which of the following is not available in Font Spacing? 
(1)    Normal       (2)   Loosely 
(3)    Condensed 
(4)    Expanded 
(5)    None of these 
90. Which of.the following position-is not available for fonts 
on MS Word? 
(1)    Normal         
(2)   Raised  
(3)    Lowered  
(4)    Centered  
(5)    None of these 
91.  What is the maximum scale percentage available in 
Scale drop down box?  
(1)    500  (2)   200  
(3)    100   (4)   90  
(5)    None of these 
92.  Bold, Italic, Regular are known as 
(1)   font styles  (2)    font effects 
(3)    word art (4)    text effects 
(5) None of these  
93. Uppercase on Change Case dialog box and All Caps on 
Fonts dialog box both converts selected text into Capital 
Letters. What's the difference between the two? 
(1)    Both are same. They are only two different ways of 
capitalize text. " 
(2)    It is faster to convert from Change Case than from Font 
dialog box 
(3)    Change Case makes conversion permanent but All 
Caps on Font can always be reverted 
(4)   All Caps on Font dialog box makes the change per-
manent where Change Case can be always reverted 
(5)   Nohe of these 
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94. If you need to hide some paragraphs, how can you do it? 
(1)    From Paragraph dialog box  
(2)    From Font dialog box 
(3)    From Options Dialog box 
(4)    All of above 
(5)    None of these 
95.  Changing the appearance of a document is called  
(1)    Proofing       (2)   Editing 
(3)    Formatting  (4)   All of above 
96.  In a document what is the maximum number of columns 
that can be inserted in MS Word Table?  
(1)    35  (2)    15 
(3)    63  (3)   65  
(5)    None of these 
97.  You can detect spelling and grammar errors by 
(1)   Press Shift + F7 
(2)    Press Ctrl+ F7 
(3)    Press Ait+ F7 
(4)    Press F7 
(5)    None of these  
98. A screen element of MS Word that is usually located 
below the title bar that provides categorized options is  
(1)    Menu mar    (2)   Tool Bar 
(3)    Status Bar 
(4)    All of the above 
(5)    None of these  
99.  Which of the following is not valid version of MS Office? 
(1)    Off ice XP  (2)    Office Vista 
(3)    Office 2007 
(4)    Office Classic 
(5)    None of these 
100. You cannot close MS Word application by 
(1)    Choosing File menu then Exit submenu 
(2)    Press Alt+F4 
(3)    Click X button on title bar 
(4)    From File menu choose Close submenu 
(5)    None of these 
101. The key F12 opens a  
(1)    Save As dialog box 
(2)   Open dialog box 
(3)    Save dialog box 
(4)    Close dialog box 
(5)    None of these 
102. What is the short cut key to open the Open dialog box? 
(1)    F12 
(2)    Shift F12 
(3)    Alt + F12  
(4)    Ctrl + F12  
(5)    None of these 
103. A feature of MS Word that saves the document 
automatically after certain interval is available on Save tab 
on Options dialog box 
(2)    Save As dialog box 
(3)    Both of above 
(4)    Save immediately 
(5)    None of these 
104. Where can you find the horizontal split bar on MS 
Wordscreen ? 
(1)    On the left of horizontal scroll bar 
(2)    On the right of horizontal scroll bar 
(3)    On the top of vertical scroll bar 
(4)    On the bottom of vertical scroll bar 
(5)    None of these 
105. Which of the following is not available on the Ruler of 
MS Word screen? 
(1)   Tab stop box  (2)    Left Indent 
(3)    Right Indent    (4)    Center Indent  
(5)   All of them are available on ruler 
106. What is place to the left of horizontal scroll bar?  
(1)   Tab stop buttons  
(2)   View buttons 
(3)   Split buttons 
(4)    Indicators 
(5)    None of above 

107. Which file starts MS Word? 
(1)    Winword.exe 
(2)    Word.exe 
(3)    Msword.exe 
(4)    Word2003.exe 
(5)    None of these 
108. How many ways you can save a document? 
(1)    3  (2)   4 
(3).    5 
(4)    6 
(5)    None of these  
109. If you want to keep track of different editions of a 
document which features will you use? 
(1)    Editions 
(2)    Versions 
(3)   Track Change 
(4)   All of above 
(5)    None of these 
110. Background color or effects applied on a document is 
not visible in 
(1)    Web layout view 
(2)    Print Layout view  
(3)    Reading View  
(4)    Print Preview V1  
(5)   None of these 
111. What is a portion of a document in which you set certain 
page formatting options? 
(1)    Page 
(2)    Document  
(3)    Section 
(4)    Page Setup 
(5)    None of these 
112. Borders can be applied to 
(1)   Cells 
(2)    Paragraph 
(3)   Text  
(4)   All of above  
(5)    None of these 
113. Which of the following is not a type of page margin?  
(1)    Left  (2)   Right  
(3)   Center    (4)   Top  
(5)    None of these 
114. What is the default left margin in Word 2003 document? 
(1)    1"   (2)   1.25"  
(3)    1.5"              (4)   2"  
(5)   None of these 
115. What is gutter margin? 
(1)   Margin that is added to the left margin when printing 
(2)    Margin that is added to right margin when printing  
(3)   Margin that is added to the binding side of page when 
printing 
(4)    Margin that is added to the outside of the page when 
printing 
(5)    None of these  
116. Portrait and Landscape are  
(1)   Page Orientation  
(2)    Paper Size  
(3)   Page Layout 
(4)    All of above 
(5)    None of these 
117. If you need to change the typeface of a document, 
which menu will you choose?  
(1)    Edit  
(2)   View  
(3)    Format          
(4)   Tools  
(5)    None of these 
118. Which of the following is not a font style? 
(1)    Bold  
(2)    Italics  
(3)    Regular  
(4)    Superscript  
(5)    None of these 
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119. Single spacing in MS-WORD document causes _ point 
line spacing? 
(1) 10   (2) 12  
(3) 14   (4) 16  
(5) None of these 
120.Which would you choose to display the statistics about a 
document? . 
(1)    tools, word count 
(2)    insert, statistics 
(3)    tools,      spelling     and grammar 
(4)    tools, statistics 
(5)    None of these  
121.Which feature do you use to create a newspaper like 
document? 
(1)    Bullets & numbering 
(2)    Tables  
(3)    Columns 
(4)    Tab stops 
(5)    None of these 
122. Which would you choose to list Synonyms & Antonyms 
of a selected word? 
(1)    Tools, Spellings Grammar  
(2)    Tools, Language 
(3)    Tools, Options 
(4)    Insert, Cross-reference 
(5)    None of these 
123. Which language does MS-Word use to create Macros? 
(1)    Visual C++ 
(2)    Visual Basic  
(3)    FoxPro          
(4)   Access  
(5)    None of these 
124. What do you call 'a collection of character  and 
paragraph formatting commands'? 
(1)   the defaults  
(2)    a template  
(3)    a style 
(4)    a boiler plate 
(5)    None of these 
125. In MS Word, Ctrl+S is for.....  
(1)    Scenarios    (2)   Size  
(3)    Save 
(4)    Spelling Check 
(5)    None of these 
126. Which key is used to increase left indent? 
(1)    Ctrl+L   
(2)   Ctrl+M  
(3)    Alt+L      
(4)    F10  
(5)    None of these 
127.Which key is used to select all the text In the document?  
(1)    Ctrl+T  (2)    Ctr+A  
(3)    Ctrl+F           (4)    Ctrl+N  
(5)    None of these 
128.To undo the last work, press.....  
(1)    Ctrl+U  
(2)    Ctrl+Y , 
(3)    Ctrl+Z            
(4)    Ctrl+W  
(5)    None of these 
129. Which enables us to send the same letter to different 
persons ? 
(1)    macros 
(2)    template 
(3)    mail merge  
(4)   indent  
(5)    None of these 
130. Which key deletes the character to the left of the 
cursor?  
(1)    End  
(2)    Backspace  
(3)    Home  
(4)   Delete  
(5)    None of these 

131. Which key deletes the character to the right of the 
cursor? 
(1)    End 
(2)    Backspace 
(3)    Home        
(4)   Delete None of these 
132.Which would you choose to save a document with a new 
name? 
(1)   Press Ctrl+S 
(2)   Click File, Save  
(3)   ClickTools, Options, Save 
(4)   Click File, SaveAs 
(5)   None of these 
133. Which would you choose to move selected text from 
one place to another? 
(1)    Move and Paste 
(2)   Copy and Paste  
(3)   Cut and Paste 
(4)   Delete and Paste  
(5)    None of these  
134  How do you magnify your document?  
(1)   View, Zoom 
(2)   Format, Font 
(3)    Tools, Options 
(4)    Tools, Customize 
(5)    None of these 
135. Which enables you to move directly to specific location 
In a document?  
(1)    Subdocuments  
(2)    Bookmarks 
(3)   Cross-references 
(4)    Outlines 
(5)    None of these 
136. What are inserted as cross-reference in Word? 
(1)    Placeholders 
(2)    Bookmarks 
(3)   Objects  
(4)   Word fields 
(5)   None of these 
137.Which keystroke is used for updating a field?  
(1)   F6   (2)    F9  
(3)   F11    (4)   F12  
(5)   None of these 
138. A master document contains.......... each of which 
contains a pointer to a file on a disk? 
(1)   Placeholders 
(2)   subdocuments 
(3)   bookmarks 
(4)   references 
139.When typing in a word field manually, what must you 
press to insert the code's braces?  
(1)    Ctrl + F6     (2)    Ctrl + F9 
(3)    Alt + Fll 
(4)    Shift+F12 
(5)    None of these 
140. A word field may consist of an optional field Instruction 
called a(n) 
(1)   subdocument 
(2)    symbol 
(3)    signal         
(4)   switch  
(5)    None of these 
141.Footnotes, endnotes, and Indexes are all Inserted as 
(1)    bookgiarks 
(2)    cross-references 
(3)    hyperlinks  
(4)    word fields   (5)    None of these 
142.Before   creating   a   master document, «you must 
switch to........ 
(1)    Normal View  
(2)    Outline ViJto 
(3)    Web Layout View 
(4)    Print Layout View 
(5)    None of these 
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143. Before moving a subdocument to another loftetion 
within a master document, you must switch to,  
(1)    Normal View  
(2)   Outline View 
(3)    Web Layout View 
(4)    Print Layout View 
(5)    None of these 
144. Which of the following can be used to navigate 
documents?  
(1)   frames  
(2)   hyperi inks 
(3)    web toolbar 
(4)   all of the above 
(5)   None of these 
145. Which of the following can be used to divide a web 
page Into areas? 
(1)   frames         
(2)   theme 
(3)   tableof contents 
(4)   none of theabove 
(5)    None of these 
146. By default, Word automatically formats each heading in 
a table of contents as... 
(1)   bookmarks 
(2)    cross-references  
(3)    hyperlinks 
(4)   word-fields 
(5)    None of these 
147. The ability to combine name and addresses with a 
standard document is called 
(1)   document formatting 
(2)    data base management  
(3)    mail merge 
(4)   form letters 
(5)    None of these 
148.Which feature Is used for monitoring all document 
changes? 
(1)    Edit Document 
(2)    Monitor Change  
(3)   Track Change 
(4)    Track all 
(5)    None of these 
149.When typing in a word field manually, what must you 
press to insert the code's braces?  
(1)    Ctrl + F6    
(2)   Ctrl + F9 
(3)    Alt + F11 
(4)    Shift+F12 
(5)    None of these 
150. A word field may consist of an optional field Instruction 
called a(n)A, 
(1)   subdocument 
(2). symbol' 
(3)   signal         
(4)   switch  
(5)    None of these  
151.Footnotes,   endnotes,   and Indexes are all inserted as 
(1)   bookmarks 
(2)   cross-references 
(3)    hyperlinks  
(4)   word fields  
(5)    None of these 
152. Before   creating   a   master document, you must 
switch to........ 
(1)   Normal View  
(2)   Out[ineView 
(3)   Web Layout View 
(4)   Print Layout View 
(5)   None of these 
53. Before moving a subdocument to another location within 
a master document, you must switch to, 
(1)   Normal View  (2)   Outline View 
(3)   Web Layout View (4)   Print Layout View 
(5)   None of these 

154. Which of the following can be used to navigate 
documents?  
(1)   frames  (2)   hyperlinks 
(3)   web toolbar 
(4)   all of the above 
(5)   None of these 
155. Which of the following can be used to divide a web 
page Into areas?  
(1)   frames       (2)   theme 
(3)   table of contents 
(4)   Space 
(5)   None of these 
156. By default, Word automatically formats each heading In 
a table of contents as,.. 
(1)   bookmams 
(2)   cross-references  
(3)   hyperlinks 
(4)   word-fields 
(5)   None of these  
157. The ability to combine name and addresses with a 
standard document Is called 
(1)   document formatting 
(2)   data base management mail merge , 
(4)    form letters 
(5)    None of these 
158.Which feature is used for I monitoring all document 
changes? 
(1)    Edit Document 
(2)    Monitor Change  
(4)   Track Change 
(4)   Track all 
(5)    None of these 
159. When sharing data in Office, the .........document is the 
document in which the data was first entered. 
(1)   source (2)   destination 
(3)   original         
(4)   primary  
(5)   None of these 
160.Which command Is used to establish a link between a 
source document and a destination document? 
(1)   Tools, Link, Documents 
(2)   Tools, Link 
(3)    Edit, Link 
(4)   Edit, Paste Special  
(5)   None of these 
161. Which option enables automatic updates     in     
destination documents?  
(1)   embedding  
(2)   objects 
(3)   links 
(4)   relationships  
(5)   None of these 
162. Which is an Office feature that makes It easy to edit 
embedded ,   objects?  
(1)   pasting  
(2)   visual editing  
(3)   tools, update, links   
(4)   edit, links   
(5)   None of this 
163. Which Is true when you Insert an excel worksheet Into a 
word document? / 
(1)   word Is the destination document 
(2)    excel is the destination document 
(3)   the worksheet is the destination document 
(4)    the document is the source document 
(5)    None of these 
164. What would you do when you want to update the data in 
an embedded worksheet range?.  
(1)   double click the worksheet range object 
(2)    right click worksheet range objects choose format 
object 
(3)   edit the data in the destination document 
(4)   edit the data in the source document. 
(5)   None of these 
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165. Which can be used for quick access to commonly used 
commands and tools?  
(1) Status bar  
(2) Tool bar  
(3) Menu bar  
(4) Title bar  
(5) None of these 
166. With which view can you see how text and graphics will 
appear on the printed page?  
(1)   Normal 
(2)   Print Layout 
(3)   Outline 
(4)   Web Layout 
(5)   None of these 
167. Which simplifies the process of formatting text If the 
same formatting Is required In more than one location?  
(1)   Auto Text  
(2)   Format Painter 
(3)   Font dialog box,, 
(4)   None of the above 
(5)   None of these  
168. Which of the following Is best for quick copy operation? 
(1)   Copy and Paste 
(2)   Windows Clipboard 
(3)   Drag and Drop 
(4)    Auto Text  
(5)    None of these 
169. Which simplifies the process of formatting text if the 
same formatting is required in more than one location'' 
(1)    Auto Text 
(2)    Format Painter 
(3)    Font dialog box 
(4)    All of the above 
(5)    None of these 
170. Which of the following is best for quick copy operation? 
(1)    Copy and Paste 
(2)    Windows Clipboard 
(3)    Drag and Drop 
(4)    Auto Text 
(5)    None of these 
171. Which of the following operations moves text from 
clipboard?  
(1)    Copy  
(2)    Paste 
(3)    Drag and Drop 
(4)    Cut 
(5)    None of these 
172. Which of the following provides a list of synonyms? 
(1)    Find command 
(2)    Replace Command 
(3)    Thesaurus 
(4)   Spelling and Grammar 
(5)    None of these 
173. Which of the following helps to reduce spelling error in 
the document? 
(1)   Auto Format 
(2)   Auto Correct 
(3)    Smart Tags 
(4)   Auto Text 
(5)    None of these 
174. Auto text and Auto correct are____ tools . 
(1)   styling  
(2)   editing 
(3)   designing 
(4) none of the above 
(5) None of these 
175. Which of the following enables you to make multiple 
changes In a document at once? 
(1)    find command 
(2)    Replace command 
(3)    Drag and Drop 
(4)    copy command 
(5)    None of these 

176. Which     of the following commands should you always 
use before submitting a document to others? 
(1)    find command 
(2)    Replace command 
(3)    Spelling and Grammar 
(4)    Thesaurus 
(5)    None of these 
177. Which of the following enables you to paste data 
multiple times? 
(1)    windows clipboard 
(2)    office clipboard 
(3)    both A and B 
(4)    Scroll 
(5)    None of these 
178. Which of the following do you *    use to change 
margins? 
(1)   formatting tool bar 
(2)    page setup dialog box 
(3)    Standard toolbar 
(4)    paragraph dialog box 
(5)    None of these 
179. Which do you press to force a page break? 
(1)    CTRL+ALT 
(2)    CTRL+break 
(3)    CTRL+ Enter 
(4)    Alt + Shift 
(5)    None of these 
180. Which do you choose to create footer? (in MS Office 
2003) 
(1)    format, header and footer 
(2)    view, footer 
(3)    insert, header and footer 
(4)    view, header and footer 
(5)    None of these 
181. Which do you choose to create header? (in MS Office 
2003) 
(1)    format, header and footer 
(2)    view, header 
(3)    insert, header and footer 
(4)    view, header and footer 
(5)    None of these 
182. Which do you choose to shade words and paragraph? 
(1)    format,    borders    and shading 
(2)    insert,     borders     and shading 
(3)    view, shading 
(4)    none of the above 
(5)    None of these 
183. To view headers and footers, you must switch to 
(1)    normal view 
(2)    print layout view 
(3)    print preview mode 
(4)    both B and C 
(5)    None of these 
184. Which of the following can you change using the page 
setup dialog box? 
(1)    margins 
(2)    page orientation 
(3)    vertical alignment 
(4)    all of the above 
(5)    None of these 
185. By default, your document prints with: 
(1)    1  inch top and bottom margins 
(2)    a portrait orientation 
(3)    1.25 inches left and right margins 
(4)   all of the above 
(5)    None of these 
186. Switching between portrait and landscape modes 
involves the: 
(1)    header and footer toolbar 
(2)    print layout view 
(3)    page setup dialog box 
(4)    All of the above 
(5)    None of these 
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187. What happens when you Insert an AutoShape by simply 
clicking in the document? 
(1)   it   appears   near   the insertion point 
(2)    It is inserted in its default size 
(3)    is selected 
(4)   all of the above 
(5)    None of these 
188. What must be used to control the layering of objects?  
(1)   formatting tool bar 
(2)   picture tool bar 
(3)   drawing tool bar 
(4)   image tool bar 
(5)   None of these 
189. What is the shortcut key to "Center Alien" the selected 
text?  
(1)   Ctrl + C        (2)   Ctrl + E  
(3)   Ctrl + F        (4)   Shift+Alt  
(5)   None of these 
190.What is the shortcut key to "Undo" the last action In a 
document? 
(1)    Ctrl + X        (2)   Ctrl+Y  
(3)    Ctrl+ 2         (4)   Ctrl + T 
(5)   None of these 
191. What is the shortcut key to "Insert Hyperllnk" in a 
document?  
(1)   Ctrl + H        (2)   Ctrl + L  
(3)   Ctrl + K        (4)   Ctrl + P  
(5)   None of these 
192. What is the shortcut key for "Find and Replace" dialog 
box?  
(1)    Ctrl + F        (2)   Ctrl + R 
(3)   Ctrl + H (4)   Ctrl+Shift + F 
(5)   None of these 
193. What is the shortcut key for Spelling Check in 
document? 
(1)   F7 
(2)   Shift+F7 
(3)    Ctrl + F7       
(4)   Alt + F7  
(5)   None of these 
194. What is the shortcut key to Update Formula in a table? 
(1)    F9  
(2)   Alt+FB 
(3)   Ctrl + F9 
(4)    Shift+ F9 
(5)    None of these 
195. What is the shortcut key to Close Active Document In 
Microsoft Word?  
(1)   Ctrl + F4 
(2)   Shift + F  
(3)   Ctrl+Shift + F4  
(4)    Ctrl + D  
(5)    None of these  
196. What is the shortcut key for "Font" dialog box?  
(1)    Ctrl + F        (2)   Ctrl + D  
(3)    Ctrl + G        (4)   Ctrl + F3  
(5)    None of these  
197. What is the shortcut key for "Superscript" the selected 
text?  
(1)    Ctrl + =         
(2)   Ctrl + - 
(3)    Ctrl+Shift + =  
(4)   Ctrl+Shift + - 
(5)    None of these  
198. What Is the shortcut key for "Subscript" the selected 
text?  
(1)    Ctrl + =         
(2)   Ctrl+- 
(3)    Ctrl + Shift + =  
(4)    Ctrl + Shift + - 
(5)    None of these 
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MS- EXCEL 
1.    Which of the following is not a valid Zoom 
(1) 10   (2) 100  
(3) 300   (4) 500  
{5} None of these 
2.    The spelling tool Is placed on _toolbar 
(1)   Standard 
(2)   Formatting 
(3)   Drawing 
(4)   Reviewing 
(5)   None of these 
3.    If you need a text to show vertically In a cell. How will 
you achieve this? 
(1)   Choose Vertical on Text alignment In Format Cells 
dialog box 
(2)   Choose 90 Degrees in Orientation of Format Cells 
dialog box 
(3)   Choose Distributed from the Vertical drop down list of 
Format Cells dialog box 
(4)-'Choose Center Across Selection from Horizontal combo 
box In Format Cells dialog box 
(5)   None of these 
4.    Can you set 0,5 Inch left Indentation for a cell in Excel? 
(1)   Excel  does  not  have 1 ^Indentation feature 
(2) \fybu can specify Indentation only If you turn the rulers on 
(3)   Indentation can be set from Format Cells dialog box 
(4)   The Indentation can be 
specified only when printing 
(6)   None of these 
5.    You can automatically adjust the ! size of text in a cell if 
they do not fit in width by 
(1) Double clicking on the right border of column header 
(2)  From Format choose Columns and then Autofit Selection 
(3)From Format Cells dialog box mark Shrink to fit check box 
(4)   All of above 
(5)    None of these 
6.    Formatting a cell In Currency, you can specify 
(1)   Decimal Places 
(2)   Currency Symbol 
(3)   Both of above 
(4)   None of above 
(5)    None of these 
7.    Formatting a cell In Number format you can't set 
(1)   Decimal Places 
(2)   Use 1000 separator 
(3)    Negative numbers 
(4)   Currency Symbol 
(5)   None of these 
8.    What Is entered by the function •today () 
(1)   The date value for the day according to system clock 
(2)   The time value according to system clock 
(3)   Today's date as Text format 
(4)   none of above 
(5)   None of these 
9.    Which function will you use to enter current time In a 
woksheet cell? 
(1)    =today( )     (2)   -now ( ) 
(3)    -time ( ) 
(4)   =CurrentTime ( ) 
(5)    None of these 
10. Special category of Number tab in Format Cells dialog 
box can be used to apply formats like 
(1)   Zip Code 
(2)   Phone Number 
(3)   Both of above 
(4)   None of above 
(5)   None of these 
11.  Merge cells option can be applied from 
(1)   Format Cells dialog box Alignment Tab 
(2)   Formatting toolbar 
(3)   Both of above 
(4)   All of above 
(5)   None of these 

12. Pre-made sheet formats like Simple, Classic, Accounting, 
Colorful etc can be applied from 
(1)   from Fromat » Cells 
(2)    from Format > > Auto format 
(3)   from Table > > Auto format 
(4)   All of above 
(5)   None of these 
13. Which of the following format you can decide to apply or 
not In AutoFormat dialog box? 
(1)   Number format 
(2)   Border format 
(3)   Font format 
(4)   All of above 
(5)   None of these 
14. How can you remove borders applied In cells?  
(1)   Choose None on Border ,   tab of Format cells 
(2)    Open the list on Border tool in Formatting toolbar then 
choose first tool (no border) 
(3)    Both of above 
(4)    None of above 
(5)    None of these 
15. Where can you set the shedding color for a range of cells 
in Excel? 
(1)   Choose required color form Patterns tab of Format Cells 
dialog box 
(2)    Choose required color on Fill Color tool in Formatting 
toolbar 
(3)   Choose required color on Fill Color tool in Drawing 
toolbar 
(4)   All of above 
(5)   None of these 
16. You can set Page Border in Excel from 
(1)    From Border tab in Format Cells dialog box 
(2)    From Border tool in Formatting toolbar 
(3)    From Line Style tool in Drawing toolbar 
(4)   You can not set page border in Excel 
(5)    None of these 
17. When all the numbers between 0 and 100 in a range 
should be displayed in Red Color, apply t  
(1)    Use -ifO function to format the required numbers red 
(2)   Apply Conditional Formatting command on Format 
menu 
(3)    Select the cells that contain number between 0 and 100 
then click Red color on Text Color tool 
(4)   All of above 
(5)    None of these 
18. You can check the conditions against ___ when applying 
conditional formatting 
(1)    Cell value    (2)   Formula 
(3)    Both of above 
(4)    writing 
(5)    None of these 
19. Which of the following is not true regarding Conditional 
Formatting? 
(1) You can add more than one condition to check 
(2)    You can set condition to look for Bold and apply Italics 
on them. 
(3)    You can apply Font, border and pattern formats that 
meets the specified conditions 
(4)    You can delete any condition from Conditional 
Formatting dialog box if it is not requried 
(5)    None of these 
20. Which of the following is invalid statement? 
(1)    Sheet tabs can be colored 
(2)    Some picture can be applied as a background of a 
sheet 
(3)    You can set the column width automatically fit the 
amount of text 
(4)    The width of a row and be specified manually or fit 
automatically 
(5)    None of these 
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21. Which of the following is not an option in the spelling 
dialog box?  
(1)    Edit  
(2)    Ignore  
(3)    Ignore all       
(4)   Change  
(5)    None of these 
22. You can quickly change the appearance of your work by 
choosing Auto Format from the .... Menu 
(1) Edit  
(2) View  
(3) Format  
(4) Tools  
(5) None of these 
23. To protect a worksheet, you can choose Protection and 
the Protect Sheet from the..... menu 
(1)    Edit  
(2)   Format  
(3)    Tools             
(4)   Data  
(5)    None of these 
24.  You can open the Highlight Changes dialog box by 
choosing Track Changes from the .... Menu. 
(1) Edit  
(2) Insert  
(3) Format  
(4) Tools  
(5) None of these 
25. Which of the following is not a worksheet design 
criterion? 
(1)    Efficiency 
(2)    Auditabiiity 
(3)    Description  
(4)   Clarity  
(5)    None of these 
26.  To copy cell contents using drag and drop, press the  
(1)    End key        
(2)   Shift key 
(3)    Esc key 
(4)    All the above 
(5)    None of these 
27.  If you press ..... the cell accepts your typing as its 
contents. 
(1)    Enter 
(2)    Ctrl + Enter 
(3)    TAB  
(4)   Insert  
(5)    None of these 
28.  The autofill feature 
(1)    Extends   a   sequential series of data 
(2)    Automatically adds a range of cell values 
(3)    Applies a boarder around selected cells 
(4)    All of above 
(5)    None of these 
29. What is the keyboard shortcut {button or buttons to be 
pressed) for creating a chart from the selected cells?  
(1)    F3   (2)   F5  
(3)    F7                 
(4)   F11  
(5)    None of these 
30. you can use the formula palette to 
(1)    format cells containing numbers 
(2)   create and edit formulas containing functions 
(3)   entered assumptions data 
(4)   copy a range of cells 
(5)    None of these 
31. What Pivot Table toolbar button updates the data in a 
Pivot Table or Pivot Chart report if the source data chas 
changed 
(1)    Format Report 
(2)    Pivot Table 
(3) ,'Refresh Data 
(4)    Show Detail 
(5)    None of these 

32. What is an expression that tells how the numbers in a 
determined set of cells are to be calculated? 
(1)    Formula       
(2)   Field 
(3)    Data 
(4)   Query  
(5)    None of these  
33. "Qtr 1, Qtr 2, Qtr 3" is an  example of a 
(1)   Formula 
(2)    Function      (3)   Series 
(4)   Syntax 
(5)    None of these 
34. You can edit existing Excel data by pressing the  
(1)    Flkey  
(2)   F2key  
(3)    F3key        
(4)   F4key  
(5)   None of these 
35. The cell reference for a range of cells that starts in cell Bl 
and goes over to column G and down to row 10 is .... 
(1) G1-G10  
(2) B1.G10  
(3) B1;G10  
(4) B1:G10  
(5) None of these 
36. A user wishes to remove a spreadsheet from a 
workbook. Which is the correct sequence ofsgyents that will 
do this? 
(1)   Go to File-Save As - Save As Type - Excel worksheet 
(2)   Right    click    on    the spreadsheet tab and setect 
        DELETE 
(3) Right    click    on    the spreadsheet and select Insert –  
         Entire Column 
(4) None of above 
(5) None of these 
37. What feature enables you to adjust or back solve the 
value in a cell to reach a desired outcome in a formula?  
(1)    Scenario Summary report 
(2)   Goal Seek 
(3)   Forecasting 
(4)   Trend line 
(5)   None of these 
38. what    term    describes    a background that appears as 
a grainy, non smooth surface  
(1)    gradient        
(2)   pattern  
(3)    solid  
(4)   texture  
(5)    None of these 
39. Excel is a  
(1)   Graphic program 
(2)    None of these 
(3)    Word processor 
(4)   A spreadsheet 
(5)   None of these 
40. To create an interactive Pivot Table for the web, you use 
a Microsoft       Office       Web component called  
(1)    HTML 
(2)   Pivot Table Field List 
(3)   Pivot Table List 
(4)   Pivot Table Report 
(5)   None of these 
41. What function cJtsplays row data in a column or column 
data in a row? 
(1)    Hypertink      (2)   Index  
(3)   Transpose    
(4)   Rows  
(5)   None of these  
42.  When you insert an Excel file into a Word document, the 
data are 
(1)    Hyperlinked (2)   Placed in a word table 
(3)    Linked 
(4)   Embedded 
(5)   None of these 
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43.  Except for the ...... function, a formula with a logical 
function shows the word "TRUE" or "FALSE" as a result  
(1)    IF  (2)   AND  
(3)    OR (4)   NOT  
(5)    None of these  
44. Macros are "run" or executed from the..... menu.  
(1)    Insert  
(2)   Format  
(3)   Tools           
(4)   Data  
(5)    None of these 
45. You can open the consolidate dialog   box   byt   
choosing Consolidate from the..... menu.  
(1)    Insert  
(2)   Format  
(3)   Tools            
(4)   Data  
(5)    None of these 
46.  Each excel file is called a workbook because 
(1)    It can contain text and data 
(2)    It can be modified 
(3)    It can contain many sheets including worksheets and 
chart sheets 
(4)    You have to work hard to create it 
(5)    None of these 
47. Which types of charts can excel produce? 
(1)   Line graphs and pie charts only 
(2)   Only line graphs 
(3)    Bar charts, line graphs and pie charts 
(4)   Bar charts and line graphs only 
(5)    None of these 
48.  How are data organized in a spreadsheet? 
(1)   Lines and spaces 
(2)   Layers and planes  
(3)    Rows and columns 
(4)   Height and width 
(5)  . None of these 
49. What does the VLOOKUP function do?  
(1)   Looks up text that contain V 
(2)   Checks whether text is the same in one cell as in the 
next 
(3)    Finds related records 
(4)   All of above 
(5)   None of these 
50. Gridlines 
(1)    May be turned off for display but turned on for printing 
(2)   May be turned on or off for printing 
(3)   The be turned off for display and printing 
(4)   a, b and c 
(5)   None of these 
51. You can print only an embedded chart by 
(1) Moving the chart to a chart sheet before you print. 
(2)    Formatting the chart before you print 
(3)   Selecting the chart before you print 
(4)   a and c 
(5)   None of these 
52. Which of the following is a correct order of precedence in 
a formula calculation? 
(1) Multiplication and division, exponential positive and 
negative value 
(2)   Multiplication and division, positive and negative values, 
addition and subtraction 
(3)   Addition and subtraction, positive and negative values, 
exponentiation 
(4)   All of above 
(5)   None of these 
53. A function inside another function is called a.....function. 
(1)    Nested         
(2)   Round  
(3)   Sum  
(4)   Text  
(5)   None of these 
 

54. How should you print a selected area of a worksheet, if 
you'll want to print a different area next time? 
(1)    On the file menu, point to print area, and then click set 
print area. 
(2)    On the file menu, click print, and then click selection 
under print what 
(3)    On the view menu, click custom views, then click add 
(4)   All of above 
(5)    None of these 
55. Youar German supplier still invoices for parts in deutsche 
marks. How can you have Excel convert those sums to Euros? 
(1)   On the Insert menu, click Symbol and from the currency 
symbols subset, select the Euro sign, 
(2)   On the tools menu, click Add-lns, and select the Euro 
Currency Tools check box 
(3)   Apply a selected background color 
(4)   All of above 
(5)    None of these 
56. Which function calculates your monthly mortage 
payment? 
(1)    PMT (payments) 
(2)    NPER (number of periods) 
(3)    PV (present value) 
(4)    All of above 
(5)    None of these 
57. If you are working in English (US), Chinese or Japanese, 
Excel 2002 can speak data as you enter it, to help you verify 
accuracy. How do you activate this feature? 
(1)    Point to speech on the tools menu, and then click show 
       text to speech toolbar. 
(2)   Click validation on the data menu 
(3)    Point to speech on the tools menu, and then click 
        speech recognition 
(4)   All of above  
(5)    None bf these 
58.  Which of the following methods can not be used to enter 
data in a cell? 
(1)    Pressing an arrow key 
(2)    Pressing the tab key 
(3)    Pressing the Esc key 
(4)   Qlicking the enter button to the formula bar 
59.  Which of the following will not set text in selected cells to 
italics? 
(1)    Pressing Ctrl + I on the keyboard 
(2)    Using the Tools - Wizard -Web Form menu item 
(3)    Using the Format - Cells -Font menu item 
(4)    All of the above 
(5)    None of these 
60.  Which of the following methods cannot be used to edit 
the content of cell? 
(1)    Pressing the Alt key 
(2)    Clicking the formula bar 
(3)     Pressing F2 
(4)    Double clicking the cell 
(5)    None of these 
61. You can activate a cell by 
(1)    Pressing the Tab key 
(2)    Clicking the cell 
(3)    Pressing an arrow key 
(4)    All of above 
(5)    None of these 
62. Which of the following setup options can not be set in the 
page setup dialog box? 
(1)    Printer selection 
(2)   Vertical   or   horizontal placement 
(3)   Orientation 
(4)    Row and column titles 
(5)    None of these 
63. What term refers to a specific set of values saved with 
the workbook? 
(1)    Range (2)    
(3)   Trend line 
(4)   What-if analysis 
(5)    None of these 
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64. Got functions? No? You need the insert function dialog 
box. How do you get it? 
(1)    Right click a cell and then click insert 
(2)    Click the insert menu and then click function 
(3)   Type - in a cell 
(4)   All of the above 
(5)    None of these 
65. Which of the following describes how to select all the 
cells in a single column? 
(1)    Right click on column and select Pick from list 
(2)    Use data - text to columns menu item 
(3)    Left click on the gray column title button 
(4)    Pressing Ctrl + A on the keyboard 
(5)    None of these 
66.  When you use the fill effects in the format data series 
dialog box, you can not 
(1)    rotate text on the chart 
(2)    select a fore ground color 
(3)    select a pattern 
(4)   select a background color 
(5)    None of these 
67.  Paper spreadsheets can have all the same advantages 
as an electronic spreadsheet except which of the following? 
(1)    Rows and columns 
(2)    Headings 
(3)   Speed 
(4)   All of above 
(5)   None of these 
68. Which of the following is not a basic step in creating a 
worksheet? 
(1) Save the workbook 
(2) Modify the worksheet 
(3) Enter text and data 
(4)  Copy the worksheet 
(5)  None of these 
69. What's a quick way to extend these numbers to a longer 
sequence, for instance 1 through 20? 
(1) Select both cells, and then drag the fill handle over the 
range you- want, for instance 18 more rows 
(2)    Select the range you want, include both cells, point to 
fill on the Edit menu, and then click down. 
(3)    Copy the second cell, click in the cell below it, on the 
standard toolbar click the down arrow on the Paste button, 
and then click Paste Special 
(4)    All of above 
(5)    None of these 
70. To insert three columns between columns D and E you 
would 
(1)    Select column D 
(2)    Select column E 
(3)    Select columns E, F and G 
(4)    Select columns D, E, and F 
(5)   None of these 
71. To center worksheet titles across a range of cell, you 
must 
(1) Select the cells containing the title text and use the fill 
handle to center the text across a range of cells 
(2)    Widen the columns 
(3)    Select the cells containing the title text and use the fill 
handle to center the text across a range of cells 
(4)   Widen the column 
(5)    None of these  
72.When integrating Ms-Word and Excel, Word is usually the 
(1)    Server          
(2)   Source  
(3)    Client  
(4)   None  
(5)    None of these 
73.  Charts tips can 
(1)    Show the formatting of a data label 
(2)    Show the name of a data series 
(3)    Show the value of data point 
(4)    b and c 
(5)    None of these 

74.  The Name box 
(1)    Shows the location of the previously active cell 
(2)    Appears t the left of the formula bar 
(3)    Appears below the status bar 
(4)    Appears below the menu bar 
(5)    None of these 
75.  How do you change column width to fit the contents? 
(1)    Single-click the boundary to the left to the column 
heading 
(2)    Double click the boundary to the right of the column 
heading 
(3)    Press Alt and single click anywhere in the column 
(4)    All of above 
(5)    None of these 
76. When you work with large worksheets, you may need to 
(1)   size the worksheet to fit on the specific number of pages 
(2)    add and remove page breaks 
(3)    specify only certain print areas 
(4)    all of above 
(5)    None of these  
77.  Hyperlinks cannot be 
(1)    Special shapes like stars and banners 
(2)    Drawing objects like rectangles ovals 
(3)    Pictures 
(4)    All can be hyperlinks 
(5)    None of these .  
78. You can use the horizontal and vertical scroll bars to 
(1)   Split a worksheet into two panes 
(2)   View different rows and columns 
(3)   Edit the contents of a cell 
(4)   View different worksheets 
(5)   None of these 
79. What do we call a computer pro gram that orga-nizes 
data in rows and columns of cells? You might use this type of 
program to keep a record of the money you earned moving 
lawns over the summer. 
(1)   Spreadsheet program 
(2)    Database program 
(3)    Word processor program 
(4)    Desktop publisher program 
(5)    None of these 
80. You can add an image to a template by clicking the Insert 
Picture From File button on the .... Toolbar. 
(1)    Standard 
(2)    Formatting 
(3)    Drawing        
(4)   Picture  
(5)    None of these 
81. To drag a selected range of data to another worksheet in 
the same workbook, use the  
(1)    Tab key         
(2)   Alt key 
(3)   Shift key 
(4)   Ctrl key 
(5)    None of these 
82. When creating a vertical page break 
(1)   The active cell must be Al 
(2)   The active cell can be anywhere in the worksheet 
(3)   The active cell must be in row 1 
(4)   The active cell must be in column A 
(5)    None of these 
83.To activate the previous cell in a pre-selected range press 
(1)   the Alt key 
(2)    the Tab key 
(3)   the Enter key 
(4)    none of above 
(5)    None of these 
84. When   the   formula   bar   is activated, you can see 
(1)    The Edit Formula button 
(2)   The Cancel button 
(3)    The Enter button 
(4)    All of above 
(5)    None of these 
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85.  In a worksheet you can select 
(1)    Entire worksheet 
(2)    Rows 
(3)    Columns 
(4)    a, b, and c 
(5)    None of these 
86. When you print preview a worksheet 
(1)    the entire worksheet is displayed 
(2)    the  selected   range  is displayed 
(3)   the active portion of the worksheet is displayed 
(4)    a, b and c 
(5)    None of these 
87. You can group noncontiguous worksheets with 
(1)    The group button on the standard toolbar 
(2)    The shift key and the mouse 
(3)    The Ctrl key and mouse 
(4)   The alt+enter key 
(5)    None of these 
88. Weight refers to 
(1)    The   print   density   of characters 
(2)    The height of the printed character 
(3)    Upright or Santed shape 
(4)    The       sign        and appearance   f characters 
(5)    None Of these 
89.  When you link data maintained in Excel workbook to a 
Word document 
(1)    The Word document cannot be edited 
(2)    The Word document contains a reference to the original 
source application  
(3)   The word document must contain a hyperlink 
(4)   The word document contains a copy of the actual data 
(5)    None of these 
90.  When you see a cell with a red triangle in the top right 
corner, what does this signify?  
(1)    There is an error in the cell .     
(2)    There   is   a   comment associated with the cell 
(3)    The font color for text in the cell is red 
(4)    A formula cannot be entered into the cell 
(5)    None of these 
91. To hold row and column titles in places so that they do 
not scroll when you scroll a worksheet, click the 
(1) Unfreeze panes command on the window menu 
(2)    Freeze panes command on the window menu 
(3)    Hold titles command on the edit menu 
(4)    Split command on the window menu 
(5)    None of these 
92. Which of these is a quick way to copy formatting from a 
selected cell to two other cells on the same worksheet?  
(1)    Use Ctr! to select all three cells, then click the paste 
        button on the standard toolbar  
(2)    Copy the selected cell, then elect the other two cells, 
click style on the Format menu, then click Modify 
(3)   Click format painter on the Formatting toolbar twice then 
click in each cell you want to copy the formatting to 
(4)    All of above 
(5)  None of these 
93. To edit data in an embedded Excel worksheet object in a 
Word document 
(1)    Use the Excel menu bar and toolbars insjde the word 
application 
(2)    Edit the hyperlink 
(3)    Edit the data in a Excel source application 
(4)    Use the Word menu bar and toolbars 
(5)    None of these 
94.  Status indicators are located on the 
(1)   Vertical scroll bar (2). Horizontal scroll bar 
(3)   Formula bar  (4).Formatting toolbar 
(5)   None of these 
95. You can open the scenario Manager dialog box by 
choosing scenarios from the ..... menu.  
(1) View (2) Insert 
(3)   Format 
(4)    Tools 
(5)   None of these 

96. You can open the Sort dialog box by choosing Sort from 
the ..... menu 
(1)View  
(2)   Format  
(3) Tools            
(4)   Data  
(5)  None of these 
97. When working in the page break preview, you can  
(1)   view exactly where each page break occurs 
(2)   add or remove page breaks 
(3) change the print area 
(4)   all of above 
(5)    None of these 
98. A data map is helpful 
(1)   When you have too much data to chart 
(2)   To show a geographic distribution of data 
(3)    To compare data points 
(4)    To show changes in data over time 
(5)   None of these 
99. Hounding errors can occur 
(1)    When you use multiplication, division or exponentiation 
in a formula 
(2)   When you use addition and subtraction in a formula 
(3)    Because Excel uses hidden decimal places in 
computation 
(4)   When you show the results of formulas with different 
decimal places' than the calculated results 
(5)    None of these 
100. You can copy data or formulas 
(1)   With the copy, paste and cut commands on the edit 
menu 
(2)   With commands on a shortcut menu 
(3)   With buttons on the standard toolbar 
(4)   All of the above 
(5)    None of these 
101. You can zoom a worksheet 
(1)    With the mouse pointer in Print Preview 
(2)   With the zoom button on the Print Preview toolbar 
(3)   With the Zoom command on the view menu 
(4)   All of the above 
(5)   None of these 
102. You can not link Excel worksheet data to a Word 
document 
(1)   With the right drag method 
(2)   With a hyperlink 
(3)   With the copy and paste -special commands 
(4)   With the copy and paste buttons on the standard toolbar 
(5)    None of these 
103. This type of software is similar to an accountant's 
worksheet 
(1)    Word processing 
(2)    Database 
(3)    Spreadsheets 
(4)    Graphics 
(5)    None of these 
104. which function will calculate the number of workdays 
between 6/9/2004 and 8/12/2004?  
(1)    Workday       
(2)   Date 
(3)    Networkdays 
(4)    All of the above 
(5)    None of these 
105. Data marker on a chart are linked to data points in a . 
worksheet therefore, 
(1)    You can automatically apply formatting to a data series 
(2)   You can change the position of a data marker and 
automatically change the data point value in the worksheet 
(3)   You can change a data print value and automatically are 
draw the chart 
(4)   a and b 
(5)    None of these 
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106. When you group worksheets 
(1) You can enter variable data on multiple worksheets at 
one time 
(2)   You can print more than*one worksheet at a time 
(3)   You can enter common data, formats, and formulas on 
multiple worksheets at one time 
(4)   b, and c 
(5)   None of these 
107. You can use the format painter , multiple times before 
you turn it offby 
(1)   You can use the format painter button only one time 
when you click it 
(2)   Double clicking the format painter button 
(3)   Pressing the Ctrl key and clicking the format painter  
        button 
(4)   Pressing Alt key and clicking the format painter button 
(5)   None of these 
108.The  default   header  for  a worksheet is 
(1)   Your name 
(2)   The date and time 
(3)    None 
(4)   The sheet tab name 
109. Which of the following is an absolute cell reference?  
(1)    !A!1  
(2)   SA$1  
(3)    #a#l                
(4)   Al  
(5)    None of these 
110. What symbol is used before a number to make it a 
label?  
(1)   "(quote)       
(2)   = (equal) 
(3)   _ (underscore) 
(4)   * (apostrophe) 
(5)   None of these 
111. Which symbol must ail formula begin with? 
(1) =  (2) +  
(3) (  (4) e  
(5) None of these 
112. Which of the following formulas is not entered correctly? 
(1)    =10+50          
(2)   =B7*B1  
(3)    =B7+14         
(4)   10+50  
(5)   None of these 
113. Which of the following formulas will Excel Not be able to 
calculate? 
(1)   =SUM(Sales)-A3   
(2)   =SUM(A1:A5)*.5 
(3)   =SUM(A1:A5)/(10-10) 
(4)    =SUM(A1:A5)-10 
(5)    None of these 
114.A typical worksheet has .... Number of columns  
(1)    128  
(2)    256  
(3)    512              
(4)    1024  
(5)    None of these 
115. How many characters can be typed in a single cell in 
Excel?  
(1)    256  (2)    1024  
(3)    32,000          (4)    65,535  
(5)   None of these 
116. A   worksheet   can   have   a maximum of.... Number of 
rows  
(1)    256  (2)    1024  
(3)    32,000          (4)    65,535  
(5)    None of these 
117. Which of the following is not an example of a value? 
(1)   350 
(2)    May 10,2001 
(3)    57% 
(4)    Serial Number 50771 
(5)    None of these 

118. The chart wizard term data series refers to 
(1)   A chart legend 
(2)    A collection of chart data markers 
(3)    A set of values you plot in a chart 
(4)   A data label 
(5)   None of these 
119. The Chart wizard term data categories refers to; 
(1)   A chart plot area 
(2)   A horizontal axis 
(3)   The organization of individual values with a chart's data 
series 
(4)    The data range that supply chart data 
(5)    None of these  
120. A worksheet range is a 
(1)   A command used for data modeling 
(2)   A range of values such as from 23 to 234 
(3)    A group of cells 
(4)    A group of worksheets 
121. Getting data from a cell located in a different sheet is 
called 
(1)   Accessing 
(2)    Referencing 
(3)    Updating 
(4)    Functioning 
(5)    None of these 
122. Tab scrolling button 
(1)    Allow you to view a different worksheet 
(2)    Allow you to view additional worksheet rows down 
(3)    Allow you to view additional worksheet columns to the  
         right 
(4)    Allow you to view additional sheets tabs 
(5)    None of these 
123.  Data can be arranged in a worksheet in a easy to 
understand manner using 
(1)    auto formatting 
(2)    applying styles 
(3)    changing fonts 
(4)    all of above 
(5)    None of these 
124. You can use drag-and-drop to embed excel worksheet 
data in a word document 
(1)    By dragging a range of excel data to the word button on  
        the taskbar while pressing the Ctrl key 
(2)    By dragging a range of excel data to the word button on  
         the taskbar while pressing Shift key 
(3)    By dragging a range of excel data to the word button on  
         the taskbar while pressing Alt key 
(4)    None of above 
(5)    None of these 
126. Excel uniquely identifies cells within a worksheet with a 
cell name 
(1)   Cell names  
(2)   Column numbers and row letters 
(3)    Column letters and row numbers 
(4)   Cell locator coordinates 
(5)    None of these 
127. To view a cell comment 
(1)   click the edit comment command on the insert menu 
(2)   click the display comment  command on the window 
menu 
(3)    position the mouse pointer over the cell         
(4)    click     the     comment command on the view menu 
(5)    None of these 
128. When you want to insert a blank imbedded excel object 
in a word document you can 
(1)    Click the object command on the insert menu 
(2)   Click the office links button on the standard toolbar 
(3)    Click the create worksheet button on the formatting  
        toolbar 
(4)   Click the import excel command on the file menu 
(5)    None of these  
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129. To save a workbook, you: 
(1)    Click the save button on the standard toolbar from the 
         menu 
(2)    Press Ctrl+F5 
(3)    Click Save on the Windows Start button 
(4)    Select Edit>Save 
(5)    None of these 
130. You can edit a cell by 
(t)    Clicking the formula button 
(2)    Double clicking the cell to edit it in-place 
(3)    Selecting Edit > Edit Cell from the menu 
(4)    None of above 
(5)    None of these 
131. You can select a single range of cells by 
(1)    Clicking the upper-left cell in a group of cells and then 
pressing the Shift key while clicking the lower right cell in a 
group of cells 
(2)    Pressing the Ctrl key while dragging over the desired 
cells 
(3)    Pressing the Shift key and an arrow key 
(4)    Dragging over the desired cells Correct 
(5)    None of these 
132. Which elements of worksheet can be protected from 
accidental modification 
(1)    Contents 
(2)    Objects 
(3)    Scenarios 
(4)    All of above 
(5)    None of these 
133. You can use the drag and drop method to 
(1)    Copy cell contents 
(2)    Move cell contents 
(3)    Add cell contents 
(4)    a and b 
(5)    None of these  
134. lt is acceptable of let long text flow into adjacent cells on 
a worksheet when  
(1)    Data will be entered in the adjacent cells 
(2)    No data will be entered in the adjacent cells 
(3)    There is not suitable abbreviation of the text 
(4)    There is not time to format the next 
(5)    None of these 
135. How can you delete a record? 
(1)    Delete the column from the worksheet 
(2)    Select Data > Form from the menu to open the Data 
Form dialog box, find the record and Click the Delete button 
(3)    Select Data > Delete Record from the menu 
(4)    Click the Delete button on the Standard toolbar 
(5)    None of these 
136. Right clicking something in Excel: 
(1)    Deletes the object 
(2)    Nothing the right mouse button is there for left handed   
         people 
(3)    Opens a shortcut menu listing everything you can do to  
        the object 
(4)    Selects object 
(5)    None of these 
137. Documentation should include 
(1)    Destination and users of the output data 
(2)    Source of input data 
(3)    Information on the purpose of the workbook 
(4)   All the above 
(5)    None of these 
138. Files created with Lotus 1-2-3 have an extension  
(1)    DOC  
(2)   XLS    (3)    123 
(4)    WK1 
(5)    None of these 
139. To delete an embedded objects, first 
(1)    Double click the object 
 (2)   Select   the   object   by clicking it  
(3)    Press the Shift + Delete ' keys 
(4)    Select it and then press the delete key 
(5)    None of these 

140. Comments can be added to cells using 
(1)    Edit > Comments 
(2)    Insert > Comments 
(3)    File > Comments 
(4)    View > Comments 
(5)   None of these 
141. Which of the following is not a worksheet design 
criterion?  
(1)    Efficiency     
(2)   Aditibility  
(3)    Description   
(4)   Clarity  
(5)   None of these 
142. To copy cell contents using drag and drop press the  
(1)    End key        
(2)   Shift key  
(3)   Ctrl key         
(4)   Esc key  
(5)    None of these 
143. Which of the following is the latest version of Excel 
(1)    Excel 2000 
(2)    Excel 2002 
(3)    Excel ME 
(4)    Excel XP 
(5)    None of these 
144. When you copy a formula 
(1)    Excel erases the original copy of the formula 
(2)    Excel edits cell references in the newly copied formula 
(3)    Excel adjusts absolute cell references 
(4)    Excel    doesn't   adjust relative cell references 
(5)    None of these 
145. The autofill feature 
(1)    extends   a   sequential series of data 
(2)   automatically adds range of cell values 
(3)   applies a boarder around the selected cells 
(4)    none of the above j 
(5)    None of these 
146.Which menu option can be used to split windows into two 
(1)    View > window > split 
(2)    Format > window 
(3)    Window > split 
(4)    View > split  
(5)    None of these 
147. You can use the formula palette to 
(1)    Format cells containing numbers 
(2)    Create and edit formulas containing functions 
(3)    Enter assumptions data 
(4)    Copy a range of cells 
(5)    None of these 
148. You can convert existing excel worksheet data an 
charts to an HTML document by using 
(1)    Internet assistant wizard 
(2)    FTP wizard 
(3)    Intranet wizard 
(4)    Import wizard 
(5)    None of these 
149. A circular reference is 
(1)    Geometric modeling tool 
(2)    A cell that points to a drawing object 
(3)    A formula that either directly or indirectly depends on   
         itself 
(4)    Always erroneous 
(5)    None of these 
150.Which of following is Not one of Excel's what-if function? 
(1)    Goal seek  (2)    Solver 
(3)    Scenario manager (4)    Auto Outline 
(5)    None of these 
151. When you insert an excel file into a word document. 
The data are 
(1)    Hyperlinked placed in a word table 
(2)    Linked 
(3)    Embedded 
(4)    Use the word menu bar and toolbars 
(5)    None of these 
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152. Which of the following is not information you can specify 
using the solver? 
(1)    Input cells (2)    Constraints 
(3)    Target cell 
(4)    Changing cells 
(5)    None of these 
153. Each excel file is called a workbook because 
(1)    It can contain text and data 
(2)    It can be modified 
(3)    It can contain many sheets including worksheets and   
        chart sheets 
(4)    You have to work hard to create it 
(5)    None of these 
154. Excel probably considers the cell entry January 1, 2000 
to be a  
(1)    Label  (2)   Value 
(3)    Formula 
(4)    Text string 
(5)    None of these 
155. You can enter which types of data into worksheet cells? 
(1)    Labels, values, and formulas 
(2)    Labe31s and values but not formulas 
(3)    Values and formulas but not labels 
(4)    Formulas only 
(5)    None of these 
156. All worksheet formula 
(1)    Manipulate values 
(2)    Manipulate labels 
(3)    Return a formula result 
(4)    Use the addition operator 
157.Which of the following is a correct order of precedence 
in formula palcuiation?  
(1)    Multiplication and division exponentiation positive and  
         negative values 
(2)    Multiplication and division, positive and negative values,  
         addition and subtraction 
(3)   Addition and subtraction, positive and negative values,  
        exponentiation 
(4)   All of above 
(5)   None of these 
158. The Paste Special command lets you copy and paste: 
(1)    Multiply the selection by a copied value 
(2)    Cell comments 
(3)    Formatting options 
(4)   The resulting values of a formula instead of the actual  
        formula 
(5)    None of these 
159. The numbers in our worksheet look like this: 1000. You 
want them to look like this: $1,000.00. How can you 
accomplish this? 
(1)   Click the Currency Style button on the formatting toolbar 
(2)   You have to retype everything and manually add the  
        dollar signs, commas, and decimals. 
(3)   Select Format > Money from the menu 
(4)   All the above 
(5)   None of these 
160. Which of the following is not a valid data type in excel 
(1)   Number (2)   Character 
(3)   Label 
(4)   Date/time 
(5)   None of these 
161. Excel worksheet cells work very similarly to what 
common element   of   the   windows graphical user interface 
(1)   Option buttons (2)   List boxes 
(3)   Text boxes 
(4)   Combo boxes 
(5)    None of these 
162. Which of the following options is not located in the Page 
Setup dialog box? 
(1)    Page Break Preview. 
(2)    Page Orientation 
(3)    Margins 
(4)    Headers and Footers 
(5)    None of these 

163. You want to track the progress of the stock market on a 
daily basis. Which type of chart should you use? 
(1)    Pie chart (2)    Row chart 
(3)   Line chart (4)   Column chart 
(5)    None of these 
164. Without using the mouse or the arrow keys, what is the 
fastest way of getting to cell Al in a spreadsheet? 
(1)    Press Ctrl +Home 
(2)    Press Home 
(3)    Press Shift + Home 
(4)    Press Alt + Home 
(5)    None of these 
165. Which of the following methods can not be used to edit 
the contents of  a cell? 
(1)   Press the Alt key 
(2)   Clicking the formula bar    
(3)    Pressing the F2 key 
(4)    Double clicking the cell 
(5)    None of these 
166. If you begin typing an entry into a cell and then realize 
that you don't want your entry placed into a cell, you 
(1)    Press the Erase key 
(2)    Press Esc 
(3)    Press the Enter button 
(4)    Press the Edit Formula button 
(5)    None of these 
167. Which of the following methods can not be used to 
enter data in a cell 
(1)   Pressing an arrow key 
(2)    Pressing the Tab key 
(3)    Pressing the Esc key 
(4)   Clicking on the formula bar 
(5)    None of these  
168. Which of the following will not cut information? 
(1)    Pressing Ctrl + C 
(2)   Selecting Edit >Cut from the menu 
(3)    Clicking the Cut button on the standard 
(4)    Pressing Ctrl + X 
(5)    None of these 
169. Which of the following is not a way to complete a cell 
entry? 
(1)    Pressing enter 
(2)    Pressing any arrow key on the keyboard 
(3)    Clicking the Enter button on the Formula bar 
(4)    Pressing spacebar 
(5)    None of these 
170. You can activate a cell by 
(1)   Pressing the Tab key 
(2)   Clicking the cell 
(3)    Pressing an arrow key 
(4)    All of the above 
(5)    None of these 
171. Text formulas: 
(1)    Replace cell references 
(2)    Return ASCII values of characters 
(3)   Concatenate and manipulate text 
(4)    Show formula error value 
(5)   None of these 
172. How do you insert a row? 
(1)    Right-click the row heading where you want to insert 
the new row and select Insert from the shortcut menu 
(2)    Select the row heading where you want to insert the 
new row and select Edit > Row from the menu 
(3)    Select the row heading where you want to insert the 
new row and click the Insert Row button on the standard 
toolbar 
(4)   All of the above 
(5)   None of these 
173. Which of the following is not a basic step in creating a 
worksheet? 
(1)   Save workbook (2)    Modifiy the worksheet 
(3)   Enter text and data 
(4)   Copy the worksheet 
(5)   None of these 
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174. How do you select an entire column? 
(1)   Select Edit > Select > Column from the menu 
(2)   Click the column heading letter 
(3)   Hold down the shift key as you click anywhere in the  
       column, 
(4)   Hold down the Ctrl key as you click anywhere in the   
       column 
(5)   None of these 
175. How can you print three copies of a workbook? 
(1)   Select File>Properties form the menu and type 3 in the  
       Copies to print text box. 
(2)   Select File >Print from the menu and type 3 in the  
       Number of copies text box. 
(3)   Click the Print button on the standard toolbar to print the 
        document then take it to Kinko's and have 2 more  
        copies made 
(4)   Press Ctri+P+3 
(5)   None of these 
176. To create a formula, you first: 
(1)   Select the cell you want to place the formula into 
(2)   Type the equals sign (-) to tell Excel that you're about to  
        enter a formula 
(3)   Enter the formula using any input  values  and   the 
appropriate mathematical operators that make up your 
formula 
(4)   Choose the new command from the file menu 
(5)    None of these 
177. To center 'worksheet titles across a range of cells, you 
must 
(1)    Select the cells containing the title text plus the range  
        over which the title text is to be centered 
(2)    Widen the columns 
(3)    Select the cells containing the title text plus the range  
         over which the title text is to be enfettered 
(4)    Format the cells with the comma style 
(5)    None of these 
178. How do you delete a column? 
(1)   Select the column heading you want to delete and select  
       the Delete Row button on the standard toolbar 
(2)   Select the column heading you want to delete and select  
       Insert Delete from the menu 
(3)   Select the row heading you want to delete "and select  
        Edit>Delete from the menu 
(4)   Right click the column heading you want to delet and  
       select delete from .the shortcut menu 
(5)   None of these 
179. How can you find specific information in a list? 
(1)   Select Tools > Finder from the menu 
(2)   Click the Find button on the standard toolbar 
(3)   Select Insert > Find from the menu 
(4)   Select Data > Form from the menu to open the Data  
       Form dialog box and click the Criteria button 
(5)   None of these 
180. When integrating word and excel, word is usually the 
(1)    Server 
(2)    Destination 
(3)    Client 
(4)    Both b and c 
(5)    None of these 
181. When a label is too long to fit within a worksheet cell, 
you typically must 
(1)    Shorten the label 
(2)    Increase the column width 
(3)   Decrease the column width 
(4)   Adjust the row height 
(5)   None of these 
182. The name box 
(1)   Shows the location of the previously active cell 
(2)   Appears to the left of the formula bar 
(3)   Appears below the status bar 
(4)   Appears below the menu bar 
(5)    None of these 
 
 

183. Comments put in cells are called  
(1)   Smart tip      
(2)   Cell tip  
(3)   Web tip        
(4)   Soft tip  
(5)   None of these 
184. Which is used to perform what if analysis?  
(1)   Solver         (2)   Goal seek 
(3)   Scenario Manager 
(4)   Allof above 
(5)   None of these 
185. You can use the horizontal and vertical scroll bars to 
(1) Split a, worksheet into two panes 
(2)View different rows and columns edit the contents of a cell 
(3)    Edit the contents of a cell 
(4)   view different worksheets 
(5)   None of these 
186. Hyperlinks can be 
(1)   Text 
(2)    Drawing objects 
(3)    Pictures 
(4)   All of above 
(5)    None of these 
187. To activate the previous cell in a pre-selected range, 
press 
(1)   The Alt key 
(2)   The Tab key 
(3)   The Enter key 
(4)   All of the above  
(5)    None of these 
188. Which button do you click to add up a series of 
numbers? 
(1)   The autosum button 
(2)   The Formula button 
(3)   The quicktotal button 
(4)   The total button 
(5)    None of these 
189. When the formula bar is active, you can see 
(1)   The edit formula button 
(2)   The cancel button 
(3)   The enter button 
(4)    All of the above 
(5)    None of these 
190. To copy formatting from one area in a worksheet and 
apply it to another area you would use: 
(1) The Edit>Copy Format and Edit>Paste Format com-
mands form the menu. 
(2)   The Copy and Apply Formatting dialog box, located 
under the Format>Copy and Apply menu. 
(3)   There is no way to copy and apply formatting in Excel -
You have to do it manually 
(4)   The Format Painter button on the standard toolbar 
(5)   None of these  
191. In a worksheet you can select 
(1)    The entire worksheet 
(2)    Rows  
(3)   Columns 
(4)    All of the above 
(5)    None of these 
192. When you link data maintained in an excel workbook to 
a word document 
(1)   The word document can not be edit 
(2)    The word document contains a reference to the original  
        source application 
(3)    The word document must contain a hyperlink 
(4)    The word document contains a copy of the actual data 
(5)    None of these 
193. Which area in an excel window allows entering values 
and formulas 
(1)    Title bar 
(2)    Menu bar 
(3)    Formula bar 
(4)    Standard toolbar 
(5)    None of these 
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194. To hold row and column titles in place so that they do 
not scroll when you scroll a worksheet click the 
(1) Unfreeze panes command on the window menu 
(2)    Freeze panes command on the window menu 
(3)    Hold titles command on the edit menu 
(4)    Split command on the window menu 
(5)    None of these 
195. To edit in an embedded excel worksheet object in a 
word document 
(1)    Use the excel menu bar and toolbars inside the word 
application 
(2)    Edit the hyperlink 
(3)    Edit the data in a excel source application 
(4)    Use the word menu bar and toolbars 
(5)    None of these 
196. To create a formula, you can use: 
(1)    Values but not cell references 
(2)    Cell references but not values 
(3)    Values or cell references although not both at the same  
        time 
(4)   Value and cell references 
(5)    None of these 
197. Status indicators are located on the 
(1)    Vertical scroll bar 
(2)    Horizontal scroll bar 
(3)    Formula bar 
(4)    Standard toolbar 
(5)    None of these 
198. Which of the following is the oldest spreadsheet 
package? 
(1)   VisiCalc 2)    Lotus 1-2-3 
(3)    Excel  
(4)   StarCalc  
(5)    None of these 
199. Pounding errors can occur 
(1)   When you use multiplication, division, or exponentiation 
in a formula 
(2)    When you use addition and subtraction in a formula 
(3)    Because excel uses hidden decimal places in 
computation 
(4)   When you show the results of formulas with different 
decimal places that the calculated results 
(5)    None of these 
200. You can copy data or formulas 
(1)    Wrth the copy, paste and cut commands on the edit  
        menu 
(2)   With commands on the shortcut menu 
(3)    Wjth   buttons   on   the standard toolbars 
(4)   All of the above 
(5)    None of these 
201. You can not link excel worksheet data to a word 
document 
(1)    With the right drag method 
(2)   With a hyperlink 
(3)   With the copy and paste special commands 
(4)   With the copy and paste buttons on the standard  
        toolbar. 
(5)    None of these 
202.Which of the following is a popular DOS based spread-
sheet package? 
(1)   Word 2)   Smart cell 
(3)    Excel 
(4)    Lotus 1-2-3 
(5)    None of these 
203. An excel workbook is a collection of 
(1)   Workbooks 
(2)   Worksheets 
(3)    Charts 
(4)   Worksheets and charts 
(5)    None of these 
204. Excel files have a default extension of  
(1)   Xls   (2) Xlw 
(3)   Wkl  (4)  123 
(5)    None of these 

205. You can use the format painter multiple times before 
you turn it off by 
(1)    You can use the format painter button on ly one time 
when you click it 
(2)    Double clicking the format painter button 
(3)    Pressing the Ctrl key and clicking the format painter 
button 
(4)    Pressing the Alt key and clicking the format painter 
button 
(5)   None of these 
206. You can use the formula pallette to 
(1)    format cells containing numbers 
(2)    create and edit formula containing functions 
(3)    enter assumptions data 
(4)    copy a range of cells 
(5)    None of these 
207. When a range is selected, how can you activate the 
previous cell? 
(1)    Press the Alt key 
(2)    Press Tab 
(3)    Press Enter 
(4)    All of above 
(5)    None of these 
208. Which tool you will use to join some cells and place the 
content at the middle of joined cell? 
(1)    From Format Cells dialog box click on Merge Cells 
check box 
(2)    From Format Cells dialog box select the Centered  
alignment 
(3)   -From Format Cells dialog box choose Merge and 
Center check box 
(4)    Click on Merge and Center tool on formatting toolbar 
(5)    None of these 
209. Tab scroll buttons are place on Excel screen 
(1)    towards the bottom right corner 
(2)    towards the bottom left corner 
(3)    towards the top right corner 
(4)   towards the top left corner 
(5)    None of these 
210. The Name box on to the left of formula bar 
(1)    shows the name of workbook currently working on 
(2)    shows tne name of worksheet currently working on 
(3)    shows the name of cell or range currently working on 
(4)    All of above 
(5)    None of these 
211. Each excel file is a workbook that contains different 
sheets. Which of the following can not be a sheet in 
workbook? 
(1)    worksheet 
(2)    chart sheet 
(3)    module sheet 
(4)    data sheet 
(5)    None of these 
212. Which of the following is not the correct method of 
editing the cell content? 
(1)    Press the Alt key 
(2)    Press the F2 key 
(3)    Click the formula bar 
(4)    Double click the cell 
(5)    None of these 
213.You   can   merge  the   main document with data source 
in Excel. In mail merge operation, Word is usually  
(1)    server  
(2)    source 
(3)    client 
(4)    none 
(5)    None of these 
214. How can you update the values of formula cells if Auto 
Calculate mode of Excel is disabled?  
(1)    F8  
(2)   F9  
(3)    F10               
(4)   F11  
(5)    None of these 
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215. You want to set such that when you type Baishakh and 
drag the fill .handle. Excel should produce Jestha, Aashadh 
and so on. What will you set to effect that? 
(1)    Fill Across Worksheet 
(2)    Custom List 
(3)    Auto Fill Options 
(4)    Fill Series 
(5)    None of these 
216.  Where  can you change automatic or manual 
calculation mode in Excel? 
 (1)    Double CAL indicator on status bar 
(2)    Go to Tools > > Options > > Calculation and mark the  
         corresponding radio button 
(3)   Both of above 
(4)    Press F7 
(5)   None of these 
217. How can you show or hide the gridlines in Excel 
Worksheet? 
(1)   Go to Tools >> Options > > View tab and mark or  
         remove the check box named Gridline 
(2)    Click Gridline tool on Forms toolbar 
(3)    Both of above 
(4)    Press F7 
(5)    None of these 
218. Which of the following Excel screen components can 
NOT be turned on or off ? 
(1)    Formula Bar 
(2)    Status Bar 
(3)   Tool Bar 
(4)   All of above 
(5)    None of these 
219. What happens when you press Ctrl + X after selecting 
some cells in Excel? 
(1) The cell content of selected cells disappear from cell and  
     stored in clipboard 
(2) The cells selected are marked for cutting 
(3)The selected cells are deleted and the ceils are shifted left 
(4)The selected cells are deleted and cells are shifted up 
(5) None of these 
220. Which of the following option is not available in Paste 
Speciat dialog box? 
(1)   Add  (2)   Subtract  
(3)    Divide          (4)   SORT  
(5)    None of these 
221. Which command will you choose to convert a column of 
data into row? 
(1)    Cut and Paste 
(2)    Edit » Paste Special » Transpose 
(3)    Both of above 
(4)    Press F7 
(5)    None of these 
222. It is acceptable to let long text flow into adjacent cells on 
a worksheet when 
(1)   data will be entered in the adjecent cells 
(2)    no data will be entered in the adjacent cells 
(3)    there   is   no   suitable abbrevition for the text 
(4)   there is not time to format the text 
(5)    None of these 
223. Which of the cell pointer indicates you that you can 
make selection? 
(1)    Doctor's symbol (Big Plus) 
(2)    small thin plus icon 
(3)    Mouse Pointer with anchor at the tip 
(4)    Press F3 + Ctrl 
(5)    None of these 
224.Which   of the cell pointer indicates that you can fill 
series? 
(1)    Doctor's symbol (Big Plus) 
(2)   small thin plus icon 
(3)    Mouse Pointer with anchor at the tip 
(4)   All of above 
(5)    None of these 
 

225. Which of the cell pointer indicate that you can move the 
content to other cell? 
(1)    Doctor's symbol (Big Plus) 
(2)   small thin plus icon 
(3)    Mouse Pointer with anchor at the tip 
(4)   All of above 
(5)    None of these 
226. You can auto fit the width of column by 
(1)    double clicking on the column name orr-column header 
(2)    Double click on the cell pointer in worksheet 
(3)    Double clicking on column right border on column  
         header 
(4)    Double clicking on the column left border of column  
         header 
(5)    None of these 
227. Long text can be broken down into many lines within a 
cell. You can do this through We have 83 
(1)   Wrap Text in Format > > Cells guests online 
(2)   Justify in Edit > > Cells 
(3)    Text Wraping in Format » Cells, Layout tab 
(4)    All of above 
(5)    None of these 
228. When a row of data is to be converted into columns 
(1)    Copy the cells in row, select the same number of cells 
in row and paste 
(2)    Copy the cells in column then choose Edit > > Paste 
Special, then click Transpose and OK 
(3)    Copy the cells then go to Format > > Cells then on 
Alignment tab click Transpose check box and click OK 
(4)   Select the cells then place the cell pointer on new cell 
and choose Edit » Paste Special, mark Transpose check box 
and click OK. 
(5)    None of these 
229. Ctrl +p shortcut key in Excel will 
(1)   Open the font dialog box 
(2)   Apply double underline for the active cell 
(3)    Fill down in the selection  
(4)   All of above 
(5)   None of these .  
230.The short cut key Ctrl +R is used in Excel to 
(1)   Right align the content of cell 
(2)   Remove the cell contents of selected cells  
(3)   Fill the selection with active t cells to the right 
(4)   All of above 
(5)   None of these 
231. The command Edit »Fill Across Worksheet is active 
only when 
(1)   One sheet is selected 
(2)   When many sheets are selected 
(3)   When no sheet is selected 
(4)   All of above 
(5)   None of these 
232. Which of the following series type is not valid for Fill 
Series dialog box? 
(1)   Linear         (2)   Growth  
(3)   Autofill        (4)   Time  
(5)   None of these 
233. Which of the following you can paste selectively using 
Paste Special command?  
(1)   Validation     (2)   Formats 
(3)   Formulas (4)  All of above 
(5)   None of these 
234. Paste Special allows some operation while you paste to 
new cell. Which of the following operation is valid? 
(1)   Square (2)  Percentage 
(3)   Goal Seek    (4)  Divide  
(5)   None of these 
235. L Edit» Delete command 
(1)   Deletes the content of a cell 
(2)   Deletes Formats of cell 
(3)   Deletes the comment of cell 
(4)   Deletes selected cells 
(5)   None of these 
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236.To remove the content of selected cells you must issue 
_____ command 
(1)    Edit» Delete 
(2)    Edit » Clear » Contents  
(3)    Edit »> Clear» All 
(4)    Data » Delete 
(5)    None of these 
237. The Delete key of keyboard is assigned to which 
command in Excel? 
(1)    Edit » Clear» Contents 
(2)    Edit» Clear» All 
(3)    Edit» Delete 
(4)   All of above 
(5)    None of these 
238. If you need to remove only the formatting done in a 
range (numbers and formula typed there should not be 
removed), you must 
(1)    From Edit menu choose Clear and then Formats 
(2)    From Edit menu choose Delete 
(3)    Click on Remove Formatting tool on Standard Toolbar 
(4)    Double click the Format Painter and then press Esc key 
in keyboard 
(5)   None of these 
239. By default Excel provides 3 worksheets. You need only 
two of them, how will you delete the third one? 
(1) Right click on Sheet Tab of third sheet and choose Delete 
from the context menu 
(2)   Click on Sheet 3 and from Edit menu choose Delete 
(3)   Click on Sheet 3 and from Edit menu choose Insert 
(4)   None of above 
(5)    None of these 
240. Which of the following action removes a sheet from 
workbook? 
(1)    Select the sheet, then choose Edit > > Delete Sheet 
(2)    Select the sheet then choose Format » Sheet » Hide 
(3)    Press Insert 
(4)    All of above 
(5)    None of these 
241. While Finding and Replacing some data in Excel, which 
of the following statement is valid? 
(1)    You can Find and Replace within the sheet or workbook 
(2)    Excel does not have option to match case for find 
(3)    Excel cannot replace 
(4)    None are valid 
(5)    None of these 
242. Which of the following is not true about Find and 
Replace in Excel 
(1)    You can search for bold and replace with italics 
(2)  You can decide whether to look for the whole word or not 
(3)    You can search in formula too 
(4)    You can search by rows or columns or sheets 
(5)    None of these 
243. You can move a sheet from one workbook into new 
book by 
(1)    From Edit menu choose Move or Copy sheet mark the 
Create a copy and Click OK 
(2)    From Edit menu choose Move of Copy then choose 
{Move to end) and click OK 
(3)    From Edit menu choose Move or Copy then select {new 
book) from To Book list and click OK 
(4)    All of above 
(5)    None of these 
244. What is the short cut key to replace a data with another 
in sheet? 
(1)    Ctrl + R (2)    Ctrl + Shift + R 
(3)    Ctrl + H        (4)   Ctrl + F  
(5)    None of these 
245. Which of the following is invalid regarding the Protection 
in Excel? 
(1)    Protect Sheet 
(2)    Protect Workbook 
(3)   Protect Workspace 
(4)   All of above are valid 
(5)    None of these 

246.The Trace Precedence on Auditing shows 
(1)   Which cells are used in current formula 
(2)    In which formula the current cell is used 
(3)   Which cells are used in this formula and in which  
         formula this cell is used 
(4)    None of above 
(5)    None of these 
247.The Trace Dependence in auditing shows 
(1)   Which cells are used in current formula 
(2)    In which formula the current cell is used 
(3)   Which cells are used in this formula and in which  
        formula this cell is used 
(4)   All of above 
(5)    None of these 
248. The arrows created by Auditing can be removed by 
(1)   Click on the arrow and press Delete ' 
(2)    Click on Remove All arrows on Formula Auditing  
        toolbar 
(3)   Both of above 
(4)   Press insert 
(5)   None of these 
249. Which of the following options i not available to remove 
arrows of Formula Auditing?  
(1)   Remove all preceden arrows 
(2)    Remove all dependent arrows 
(3)    Remove all arrows 
(4)    Remove all arrows for this cell 
(5)    None of these 
250. Excel is a good application for What IF analysis. Which 
of the following tool help you for this? 
(1)    Formul Auditing 
(2)    Research 
(3)   Track Change 
(4)   Goal Seek 
(5)    None of these 
251. Which of the following tool you will use in Excel to see 
what must be the value of a cell to get required result? 
(1)    Formul Auditing 
(2)    Research 
(3)   Track Change 
(4)   Goal Seek   
(5)    None of these 
252. To apply Goal Seek command your cell pointer must be in 
(1)    The Changing cell whose value you need to find 
(2)   The Result Cell where formula is entered 
(3)    The   cell   where   your targeted value is entered 
(4)    All of above 
(5)    None of these 
253. Which of the following is not What IF analysis tool in 
Excel? 
(1)   Goal Seek (2)    Scenarios 
 (3)    Macros 
(4)    All of above 
(5)    None of these 
254. You can set Excel in Automatic or Manual calculation 
mode. If it is in manual mode which key you will press to 
update the formula values? 
(1)    F9   (2)   F5 
(3)    F8  (4)   F11 
(5)    None of these 
255. By default the cell pointer moves down when you press 
Enter. From where can you change this setting? 
(1)    Tools > > Options » View tab 
(2)    Tools     »     Options     » Calculation tab 
(3)    Tools » Options » Edit tab 
(4)    Tools     »     Options     » Transition tab 
(5)    None of these 
256. When you start typing the same value as of some cells 
on same column, Excel automatically shows that text. This 
feature is known as 
(1)    AutoFill (2)    AutoCorrect 
(3)    AutoComplete 
(4)    AutoFormat 
(5)    None of these 
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257. The default and maxium number of sheets for a new 
workbook in Excel 2003 is  
(1)    3 and 255    (2)   3 and 256 
(3)    1 and 255 
(4)    1 and 256 
(5)    None of these 
258. When you enter Sunday and fill right, Excel fill in with 
Monday, Tuesday and so on. From where Excel knows what 
to fill in next? 
(1)   Auto Complete 
(2)    AutoFormat 
(3)    Custom List 
(4)    Calculation Automatic 
(5)    None of these 
259.The minimum and maximum value you can set for Save 
AutoRecovery Info in Excel are 
(1)    1 and 120 minutes 
(2)   O and 120 minutes 
(3)   2 and 60 minutes 
(4)    1 and 10 minutes 
(5)    None of these  
260. Which of the following can not be  hidden from Tools > 
> Options then View tab? 
(1)   Startup Task Pane 
(2)   Formula bar 
(3)   Status bar 
(4)    Scroll Bar 
(5)   None of these 
261. What happens if you remove the check mark from Row 
& Column headers on Options dialog box? 
(1)   This will remove row headings and column headings of 
your data 
(2)   This will remove the column headings (A, B, C, 
(3)   This will remove row and column heading of chart 
(4)   This will remove row and column heading of table 
(5)   None of these  
262. The default font size in Excel worksheet is 
(1)   10 points 
(2)   12 points 
(3)   14 points 
(4)   None of above  . 
(5)   None of these 
263. The default font used In Excel is  
(1)    Arlal   (2) Algerial 
(3)   Times New Roman 
(4)    Preetl 
(5)   None of these 
264. Comments put in cells are called..... 
(1) Smart Tip  
(2) Cell Tip  
(3) Web Tip  
(4) Soft Tip  
(5) None of these 
265. Comments can be added to cells using..... 
(1)   Edlt-> Comments 
(2)   Insert •> Comment 
(3)   Fl I e-> Qomments 
(4)   Vlew-> Comments 
(5)   None of these 
266. Which menu option can be used to split windows Into 
two? 
(1)   Format •> Widow 
(2)   VI ew •> Widow=> Split 
(3)   Wlndow->Spllt 
(4)   Vlew->Spllt 
(5)    None of these 
267. Getting data from a cell located in a different sheet is 
called. 
(1)   Accessing 
(2)    Referencing 
(3)    Updating 
(4)    Functioning 
(5)   None of these 
 

268. Which of the following is not a valid data type in Excel? 
(1)   Number 
(2)   Character 
(3)   Label 
(4)   Date/Time 
(5)   None of these 
269. Which elements of a worksheet can be protected from 
accidental modification?  
(1)   Contents     (2)   Objects 
(3)   Scenarios 
(4)   All of the above 
(5)   None of these 
270. A numeric value can be treated as label value If...... 
precedes It. 
(1)   Apostrophe (') 
(2)   Exclamation (I) 
(3)   Hash (#) 
(4)   Tilde(~) 
(5)   None of these 
271. Concatenation of text can be done using 
(1)   Apostrophe (') 
(2)   Exclamation (I) 
(3)   Hash(#) 
(4)   Ampersand (&) 
(5)   None of these 
272. Which area In an Excel window allows entering values 
and formulas? 
(1)   Title Bar 
(2)   Menu Bar 
(3)   Formula Bar 
(4)   Standard Tool Bar 
(5)   None of these 
273. Multiple calculations can be made In a single formula 
using.... 
(1)   Standard Formulas 
(2)   Array Formula 
(3)   Complex Formulas 
(4)    Smart Formula 
274.An   Excel Workbook is a collection of....... 
(1)   Workbooks 
(2)   Worksheets 
(3)    Charts 
(4)   Worksheets and Charts 
(5)    None of these 
275.What  do you mean by a Workspace? 
(1)   Group of Col umns 
(2)   Group of Worksheets 
(3)    Group of Rows 
(4)   Group of Workbooks 
(5)   None of these 
276. MS-EXCEL is based on .-.....-?  
(1)   WINDOWS    (2)   DOS  
(3)    UNIX  (4)    OS/2  
(5)   None of these 
277. In EXCEL, you can sum a large range of data by simply 
selecting a tool button called .....? 
(1)   AutoFill 
(2)   Auto correct 
(3)   Auto sum 
(4)   Auto format 
(5)   None of these 
278. To select an entire column in MS-EXCEL, press? 
(1)   CTRL + C 
(2)   CTRL + Arrow key 
(3)   CTRL + S 
(4)   All of the above 
(5)   None of these 
279. To return the remainder after a number Is divided by a 
divisor In EXCEL we use the function?  
(1)    ROUND ( )    
(2)   FACTQ  
(3)    MODQ         
(4)   DIV()  
(5)   None of these 
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280. Which function Is not available In the Consolidate dialog 
box?  
(1)   Pmt  
(2)   Average  
(3)   Max             
(4)   Sum  
(5)   None of these 
281. Which Is not tha function of "Edit, Clear" command? 
(1)    Delete contents 
(2)   Del ete notes 
(3)    Delete eel Is 
(4)    Del ete formats 
(5)    None of these 
282. Microsoft Excel Is a powerful........... 
(1)   Word processing package 
(2)   Spreadsheet package 
(3)   Communication S/W  Package , 
(4)    DBMS package 
(5)    None of these 
283. How do you rearrange the data In ascending or 
descending order? 
(1)    Data, Sort 
(2)    Data, Form 
(3)   Data, Table 
(4)    Data Subtotals 
(5)    None of these 
284. Which Chart can be created in Excel?  
(1)   Area  
(2)   Line 
(3)    Pie    
(4)    All of the above 
(5)   None of these 
285. What will be the output If you format the cell containing 
5436.8 as '#,##0.00'? 
(1)   5,430.00 
(2)    5,436.80. 
(3)    5,436.8          
(4)   6.8  
(5)   None of these 
286. How do you display current date and time In MS Excel? 
(1)   date(  )         (2)   Today (  )  
(3)   now(  )          
(4)   time(  )  
(5)   None of these 
287. How do you display current date 
only in MS Excel? 
(1)   date (  )        (2)   Today (  ) 
(3)   now(  )          
(4)   time() 
(5)    None of these  
288. How do you wrap the text in a  cell? 
(1)   Format, cells, font 
(2)    Format, cells, protection 
(3)    format, cells, number 
(4)    Format cells, alignment 
(5)    None of these 
289. What does COUNTA (  ) function do? 
(1)    counts    cells     having alphabets 
(2)   counts empty eel Is 
(3)    counts    cells     having number 
(4)    counts non-empty cells 
(5)    None of these 
290. What Is the short cut key to highlight the entire column? 
(1)    Ctrl+C 
(2)    Ctrl+Enter 
(3)    Ctrl+PageUp 
(4)    Ctrl+SpaceBar 
(5)    None of: ese 
291. In the formula, which symbol specifies the fixed 
columns or rows? 
(1)    A.S     (2)   *  
(3)    %         
(4)   &  
(5)    None of these 

292. Excel displays the current cell address In the.......... 
(1)    Formula bar 
(2)    Status Bar 
(3)    Name Box 
(4)    Title Bar 
(5)    None of these 
293. What Is the correct way to refer the cell AID on sheets 
from sheetl? 
(1)    sheet3IA10 
(2)    sheetllAlO 
(3)   Sheets-A10 
(4)    A10 
(5)   None of these 
294.Which language is used to create macros in Excel? 
(1)   Visual Basic 4 
(2)    C 
(3)   Visual C++   
(4)   Java  
(5)    None of these  
295. Which of the following is not a term of MS-Excel? 
(1)    Cells         (2)   Rows 
(3)   Columns 
(4)    Document 
(5)    None of these 
296. How many worksheets can a workbook have?  
(1)    3   (2)   8 
(3)    255 
(4)   All of above 
(5)    None of these 
297. Which would you choose to create a bar diagram? 
(1)    Edit, Chart 
(2)    Insert, Chart 
(3)   Tools, Chart 
(4)    Format, Chart 
(5)    None of these 
298. Which setting you must modify to print a worksheet 
using letterhead?  
(1)   Paper         (2)   Margin 
(3)    Layout 
(4)    Orientation 
(5)    None of these 
299. What do you call the chart that shows the proportions of 
how one or more data elements relate to another data 
element? 
(1)    XY Chart 
(2)    Line Chart 
(3)    Pie Chart 
(4)    Column Chart 
(5)    None of these 
300. The spelling dialog box can be involved by choosing 
spelling from ___ menu.  
(1)   insert  
(2)   file  
(3)   tools            
(4)   view  
(5)   None of these 
301. Which key do you press to check spelling?  
(1)    F3   (2)   F5 
(3)    F7  (4)   F9 
(5)    None of these 
302.To   record   a   sequence   of keystrokes and mouse 
actions to play back later we use:  
(1)    Media player 
(2)    Sound Recorder     
(3)    Calculator 
(4)    Macro Recorder 
(5)    None of these 
303. We can save and protect 1he workbook by 
(1)   Write Reservation Password 
(2)    Protection Password 
(3)    Read-only Recommended 
(4)   Any of the above 
(5)    None of these 
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304. The first cell in EXCEL worksheet is labeled as 
(1) A  (2) A1 
(3) Aa  (4) AO 
(5) None of these 
305.What happens when dollar signs (S) are entered In a 
cell address? 
(1) An absolute eel I address is created. 
(2) Cell address will change when it is copied to another cell. 
(3) The sheet tab is changed. 
(4) The status bar does not display the eel I address. 
(5)  None of these 
306. What are the tabs that appear at the bottom of each 
workbook called? 
(1)    Reference tabs 
(2)    Position tabs 
(3)   Location tabs 
(4)   Sheet tabs 
(5)   None of these 
307.What is represented by the small, black square in the 
lower-right corner of an active cell or range? 
(1)   Copy handle 
(2)    Fill handle 
(3)   Insert handle  
(4)   Border 
(5)   None of these 308. In Excel, a Data Series is defined as 
what? 
(1)    A type of chart. 
(2)    A eel I reference. 
(3)   A collection of related data 
(4)    Adivision of results 
(5)    None of these 
309. In Excel, the Fill Color button on the Formatting toolbar 
is used for what? 
(1)    To insert a background. 
(2)   To add borders. 
(3)    To select a distribution of figures. 
(4)    To add shading or color to a cell range. 
(5)    None of these 
310. In help menu of Excel, which of the following tabs are 
found? 
(1)    Contents tab 
(2)    Answer Wizard tab           
(3)    Index tab 
(4)   all of the above 
(5)    None of these 
311. A ______is a grid with labeled 
columns and rows. 
(1)    Dialog box  (2)    Worksheet 
(3)    Clipboard      
(4)   Toolbar  
(5)    None of these 
312. The active cell: 
(1)    is defined by a bold border around the ceil. 
(2)    Receives the data the user enters. 
(3)    It is the formula bar. 
(4)    Only A and B 
(5)    None of these 
313.Which function Is used to calculate depreciation, rates of 
return, future values and loan payment amounts? 
(1)    Logical (2)    Math & Trigonometry 
(3)    Statistical 
(4)    Financial 
(5)   None of these 
314.  B7:B9 indicates: 
(1)    Cells B7 and cell B9 only. 
(2)    Cells B7 through B9. 
(3)    Cell BSonly. 
(4)    None of the a bove. 
(5)    None of these 
315. The Cancel and Enter buttons appear In the: 
(1)    Title bar  (2)    Formula bar 
(3)    Menu bar 
(4)    Sheet tabs 
(5)    None of these 

316. MS-EXCEL can be used to automate 
(1)    Financial    statements. Business forecasting 
(2)    Transaction   registers, inventory control 
(3)    Accounts     receivable, accounts payable 
(4)    Any of the above 
(5)    None of these 
317. NOT, AND, OR and XOR are 
(1)    Logical Operators 
(2)    Arithmetic operators 
(3)    Relational operators 
(4)    None of the above 
(5)    None of these 
318. In a report, you need to show the monthly rainfall in 
Nepal. The best way to do this is to insert a 
(1)    calendar 
(2)    photograph of rainfall 
(3)    chart  showing   rainfall amounts 
(4)    data base of rainfall 
(5)    None of these 
319. You want to record experiment information and create a 
chart that shows the rate of crystal growth over a period of 
time. The best application to use would be: 
(1)    word processing 
(2)    spreadsheet 
(3)   database 
(4)    graphics 
(5)    None of these 
320. You are editing an worksheet that you had previously 
saved. If you want to save the edited sheet without losing the 
original one,   which Command should you  use? 
(1)    New  (2)   Save As 
(3)   Edit  (4)   Save    
(5)   None of these 
321. If you want to have a blank line  after the title in a 
worksheet, what  is the best thing for you to do? 
(1)   Re-format the spreadsheet 
(2)   Insert a row 
(3)   Increase the column width      
(4)   Use the spacebar  
(5)   None of these 
322. In order to arrange the countries from those with the 
highest population to those with the lowest, you need to sort 
on the population field in............... 
(1)   ascending order 
(2)   descending order 
(3)   alphabetical order 
(4)   random order 
(5)   None of these 
323. In order to perform a calculation in a spreadsheet, you 
need to use a: 
(1)   table  
(2)   formula  
(3)   field             
(4)   variable  
(5)   None of these 
324.The box on the chart that contains the name of each 
Individual record Is called the__. 
(1)   cell   (2)   title  
(3)   axis  (4)   legend  
(5)   None of these , 
325. If you want all of the white cats grouped together In the 
database, you need to sort by__. 
(1)   Color, then Gender 
(2)   Pet Type, then Col or 
(3)   Pet Type, then Gender 
(4)   Color, then Pet Name 
(5)   None of these 
326. You accidentally erased a record In the sheet, What 
command 
can be used to  restore  It 
Immediately? 
(1)    Insert  (2)   Copy 
(3)    Undo  (4)   Replace 
(5)    None of these 
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327.Where a row and a column meet, what do you call that? 
(1)   A eel I (2)   A block 
(3)    A box 
(4)   None of the above 
(5)   None of these 
328. How do you tell one cell from another? 
(1)   By numbers 
(2)   By letters 
(3)   By its address 
(4)   by color 
(5)   None of these 
329. Give me an example of a cell address. 
(1)    1125  (2)   911  
(3)   41A  (4)   A21    
(5)   None of these 
330.Which Is an example of a formula? 
(1)   =A1+A2 
(2)   =add(AI:A2) 
(3)   A1+A2 
(4)   SUM{A1:A2) 
(5)   None of these 
331.Which is an example of a function? 
(1)   =add(AI:A2) 
(2)   =A1+A2 
(3)   »SUM(A1:A2) 
(4)   A1+A2 
(5)   None of these 
332.What   la   the   symbol   for multiplying? 
(1) >  (2) /  
(3) !  (4) *  
(5) None of these 
333. What Is the symbol for dividing?  
(1)   /  (2)=% 
(3)   & (4)   fl  
(5)   None of these  
334. All formula In Excel start with  
(1) .> (2)   + 
(3)   = (4)  - 
(5)    None of these 
335.You can use a function to combine text from two cells 
into one cell. But you can use an opera-tor to do the same 
thing. Which operator is that? 
(1)   & (ampersand) 
(2)   = (equal sign) 
(3)   (space) 
(4)   All of the above 
(5)   None of these 
336. Two common wildcard characters that Excel recognizes 
are 
(1) * and?         (2) < and >  
(3) * and /         (4) + and – 
(5) None of these 
337. The divide symbol is  
(1)   /                (2)   D 
(3)   \                (4)   ) 
(5)   None of these 
338. The multiplication arithmetic operator Is represented by 
which of the following symbols?  
(1)  a                (2)   *  
(3)   /                (4)   X  
(5)   None of these 
339. To add two cells (Al and A(2) together you use the 
following formula 
(1)   =A1 + A2 
(2)    =Add(AI+A(2) 
(3)   together (A 1:A(2) 
(4)   AlplusA2 
(5)   None of these 
340. To make a number In cell Cl 10% smaller than the 
number In C3 you enter 
(1)   -03*1.10        (2)   +C3*110 
(3)   -C3%10       
(4)   -C3*.90  
(5)   None of these 

341. On an excel sheet the active cell In Indicated by... 
(1)   A dark wide boarder 
(2)   A dotted border 
(3)   A blinking border 
(4)   None of above   
(5)   None of these 
342. On an Excel sheet the active cell in indicated by 
(1)   A dark wide border 
(2)   A dotted border 
(3)   A blinking border  
(4)   None of above 
(5)   None of these 
343. Using the Fl 1 shortcut key to create a chart on chart 
sheet creates 
(1)   A default chart 
(2)   A 2-dimensional column chart 
(3)   A 2-dimensional bar chart 
(4)   A 3-dimensional line chart 
(5)    None of these 
344. You can print 
(1)   A range of cells by range name 
(2)   An entire worksheet 
(3)   A single worksheet 
(4)   All of the above 
(5)   None of these 
345. You can create only a horizontal page break by first 
selecting 
(1)   A row below the row where you want the page break to  
       occure 
(2)   A cell in row 1 
(3)   A cell in column A 
(4)   a and c 
(5)    None of these 
346. You can create hyperlinks from the Excel workbook to 
(1)   A webpage on company internet 
(2)   A web page on the internet 
(3)   Other Office 97 application documents 
(4)   All 
(5)   None of these 
347. The cell reference fro a range of cells that starts in cell 
Bl and goes over to column G and down to row lOis...... 
(1)    DB1-G10     (2)   B1.G10 
(3)    B1;G10        (4)   B1:G10  
(5)    None of these 
348.The advantage of using a spreadsheet is : 
(1)   calculations can be done automatically 
(2)   changing    data    automatically updates calculations  
(3)    more flexibility 
(4)    all of the above 
(5)    None of these 
349. The intersection of a row and column is called :  
(1)    data  (2)   afield 
(3)   a cell (4)    an equation 
(5)    None of these 
350. There are three types of data found in a spreadsheet. 
(1)    data, words, numbers 
(2)    equations, data, numbers 
(3)   words, numbers, labels 
(4)    numbers formulas, labels 
(5)    None of these 
351. To select a column the easiest method is to........ 
(1)    Double click any cell in the column 
(2)    Drag from the top cell in the column to the last cell in    
         the column 
(3)    click the column heading 
(4)    click the column label 
(5)    None of these 
352. If you press...... the cell accepts your typing as its 
contents. 
(1)    Enter 
(2)    Ctrl+Enter 
(3)    Tab  
(4)   Insert  
(5)    None of these
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353. which of the following special function keys allow the 
content in cell 
(1) esc   
(2) shift  
(3) return  
(4) Tab  
(5) None of these 
354. Which is not an advantage of using computerized 
spread sheets? 
(1)   flexibility of moving entries 
(2)   speed of calculation 
(3)   ability of generate tables 
(4)   cost of initial setup 
(5)    None of these 
355. To select several cells or ranges that are not touching 
each other, you would ... while selecting 
(1)    hold down the Ctrl key 
(2)    hold down the Shift key 
(3)    hold down the Alt key 
(4)    hold down Ctrl + Shin key 
(5)    None of these 
356. What is the AutoSummarize feature used for in Word 
2000 
(1) It creates a 250 word, 500 word or 1000 word summary 
of the document 
(2)    It adds Automatic headwers, bold and italic characters 
as well as' automatic formatting of the document to give the 
look of a well summarized document 
(3)    it summarizes the statistics of the document into a 
report such as total words, total characters, total pages, total 
paragraphs, file size ecs 
(4)    It identifies the key points in a document for your to 
share with others or quickly scan 
(5)    None of these 
357. A certain spreadsheet shows in Page Break Preview 
that cells in Rows     1-25    have    white background. The 
cells in row 26 that contain data have a dark grey 
background, when you click the Print button...... 
(1)   nothing will print because some cells with data have  
       been omitted 
(2)   only the cells with gray back-ground will print 
(3)   the whole sheet will print 
(4)   only the cells with white background will print 
(5)    None of these '-'v 
358. A constant is another name for this type of data: 
(1)    number (2)   equation 
(3)   formula         
(4)   description  
(5)   None of these 
359. The view that puts a blue a blue line around each page 
that would be printed is the...... 
(1)    Print Preview 
(2)    Normal View 
(3)   Page Break Preview 
(4)    Split View 
(5)   None of these 
360. Auto Calculate will quickly add selected cells if you....... 
(1)   right click on the status bar and select Sum 
(2)   click the AutoCalculate but-ton on the toolbar 
(3)   use the key combination Ctrl+$ 
(4)    Double click the selection 
(5)    None of these 
361. The cell labeled 23. 54 the cell labeled F5 refers to 
(1)    row F column 5 
(2)   column F row 5 
(3)   function available in cells 
(4)   function key F4 
(5)   None of these 362. When you are typing an equation 
into a cell the first thing that must be entered is 
(1)   the first cell referenced 
(2)    parenthesis 
(3)   quotation marks 
(4)   an equal sign 
(5)   None of these 

363. Using the AutoSum button will replace in the selected 
cell...... 
(1)    the sum of values jn the cell's column. 
(2).   nothing until'ybu select a range of cells 
(3)   the sum of the cell's row unless you change the range 
(5)   None of these 
364.Bookl is an example of how …... are numbered and 
named during each work session 
(1)   Active cell  
(2)    Formula bar 
(3)    Menu bar 
(4)    Name box 
(5)    None of these 
365. Which of the following displays the contents of the 
active cell? 
(1)   Active cell 
(2)    Formula bar         
(3)    Menu bar 
(4)    Name box 
(5)   None of these 
366. Graphics objects on a chart are used to 
(1)   Add emphasis to chart data 
(2)    Add interest to a chart 
(3)    Help explain the chart data 
(4)   a, b, and c 
(5)    None of these  
367. What does SUMIF function do? 
(1)   Adds up cell values based on a condition 
(2)   Adds all the numbers in a range of cells 
(3)    Returns a subtotal in a list or database 
(4)   All of above  
(5)    None of these  
368. You can insert labels for 
(1)   All the data markers on a chart 
(2)   A data series 
(3)   A selected data marker 
(4)   All 
(5)    None of these 
369. Tab scrolling buttons 
(1)    Allow you.to view a different worksheet 
(2)    Allow you to view additional worksheet row down 
(3)    Allow you to view additional worksheet columns to the  
        right 
(4)   Allow you to view additional sheet tabs 
(5)    None of these 
370. All macro keyboard shortcuts include the...... key 
(1)    Alt   (2)   Ctrl  
(3)    F11              (4)   Shift  
(5)    None of these 
371. To open the Format Cells dialog box, press  
(1)    Alt* 1  
(2)   Ctrl + 1 
(3)    Ctrl + Shift + 1 
(4)    Fl 
(5)    None of these 
372. You can add a hyperlink to your worksheet by pressing 
(1)    Alt + K  
(2)   Ctrl + H 
(3)    Ctrl + K 
(4)    Ctrl + Shift + K 
(5)    None of these 
373. To"  move to the  previous worksheet, press 
(1)    Alt + PgUp 
(2)    Ctrl + PgUp 
(3)    Ctrl + PgDn 
(4)    Shift + Tab 
(5)    None of these 
374. Hyperlinks can be 
(1)    Text 
(2)    Drawing objects 
(3)    Pictures   
(4)   All of above 
(5)    None of these 
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375. To activate the previous cell in a pre selected range, 
press 
(1)    The Alt key (2)    The Tab key 
(3)   The Enter key 
(4)    None of the above 
(5)    None of these 
376. Which button do you click to add up a series of 
numbers?  
(1)   The autosum button 
(2)   The Formula button 
(3)   The quicktotal button 
(4)   The total button 
(5)    None of these 
377. When the formula bar is active, you can see 
(1)   The edit formula button 
(2)   The cancel button 
(3)   The enter button 
(4)   All of the above 
(5)   None of these 
378. To copy formatting from one area in a worksheet and 
apply it to another area you would use : 
(1)    The Edit > Copy Format and Edit>Paste Format 
commands form the menu. 
(2)   The Copy and Apply Formatting dialog box, located 
under the Formats Copy and Apply menu. 
(3)   There is no way to copy and apply formatting in Excel 
You have to do it manually 
(4)   The Format Painter button on the standard toolbar 
(5)   None of these 
379. In a worksheet you can select 
(1)   The entire worksheet 
(2)   Rows 
(3)   Columns (4)   All of the above 
(5)   None of these 
380. When you link data maintained in an excel workbook to 
a word document 
(1)   The word document can not be edit 
(2)   The word document contains a reference to the original 
source application 
(3)   The word document must contain a hyperlink 
(4)   The word document contains a copy of the actual data 
(5)    None of these 
381. Which area in an excel window allows entering values 
and formulas 
(1)    Title bar (2)    Menu bar 
(3)    Formula bar 
(4)    Standard toolbar 
(5)    None of these 
382. To hold row and column titles in place so that they do 
not scroll when you scroll a worksheet click the 
(1) Unfreeze panes command on the window menu 
(2)    Freeze panes command on the window menu 
(3)   Hold titles command on the edit menu 
(4)    Split command on the window menu  
(5)    None of these 
383. To edit in an embedded excel worksheet object in a 
word document 
(1)Use the excel menu bar and toolbars inside the word 
application 
(2)    Edit the hyperlink 
(3)    Edit the data in a excel source application 
(4)    Use the word menu bar and toolbars 
(5)    None of these 
384. To create a formula, you can use: 
(1)    Values but not cell references 
(2)    Cell references but not values 
(3)  Values or cell references although not both at the same time 
(4)    Value and cell references 
(5)    None of these 
385. Status indicators are located on the 
(1)    Vertical scroll bar  (2)    Horizontal scroll bar 
(3)    Formula bar 
(4)    Standard toolbar 
(5)    None of these 

386.  Which of the following is the oldest spreadsheet package? 
(1)    VisiCalc 
(2)    Lotus 1-2-3 
(3)    Excel 
(4)    StarCalc 
(5)    None of these 
387. Rounding errors can occur 
(1)    When you use multiplication, division, or exponentiation 
in a formula 
(2)    When you use addition and subtraction in a formula 
(3)    Because excel uses hidden decimal places in 
computation 
(4)    When you show the results of formulas with different 
decimal places that the calculated results 
(5)    None of these 
388. You can copy data or formulas 
(1) With the copy, paste and cut commands on the edit menu 
(2)  With commands on ta shortcut menu 
(3)  With buttgns on the standard toolbars 
(4)  All of the above 
(5)  None of these 
389. You can not link excel worksheet data to a word 
document 
(1)  With the right drag method 
(2)  With a hyperlink 
(3)  With the copy and paste special commands 
(4)  With the copy and paste buttons on the standard toolbar. 
(5)    None of these 
390.Which of the following is a popular DOS based 
spreadsheet package?  
(1)    Word 
(2)   Smart cell 
(3)   Excel 
(4)    Lotus 1-2-3 
(5)   None of these 
391. An excel workbook is a collection of 
(1)   Workbooks 
(2)   Worksheets 
(3)   Charts 
(4)   Worksheets and charts 
(5)   None of these 
392. Excel files have a default extension of 
(1) Xls  (2) Xlw  
(3) Wkl  (4) 123  
(5) None of these 
393. You can use the format painter multiple times before 
you turn it off by 
(1)     You can use the format painter button only one time 
when you click it 
(2)    Double clicking the format painter button 
(3)    Pressing the Ctrl key and clicking the format painter 
button 
(4)    Pressing the Alt key and clicking the format painter 
button 
(5)    None of these 
394. What function displays row data in a column or column 
data in a row? 
(1) Hyperlink  (2) Index  
(3) Transpose  (4) Rows  
(5) None of these 
395. When you insert an Excel file into a Word document, 
the data are 
(1)    Hyperlinked 
(2)    Placed in a word table 
(3)    Linked 
(4)   Embedded 
(5)    None of these 
396. Except for the .......function, a formula with a logical 
function shows the word "TRUE" or "FALSE" as a result 
(1) IF   
(2) AND  
(3) OR  
(4) NOT  
(5) None of these 
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397. Macros are "run" or executed from the...... menu. 
(1)   Insert  
(2)   Format  
(3)   Tools            
(4)   Data  
(5)   None of these 
398. You can open the consolidate dialog   box   byt   
choosing' Consolidate from the...... menu. 
(1)    Insert   
(2)   Format  
(3)    Tools      
(4)   Data  
(5)    None of these 
399. Each excel file is called a work-book because 
(1)    It can contain text and data 
(2)    It can be modified 
(3)    It can contain many sheets including worksheets and  
        chart sheets 
(4)    You have to work hard to create it 
(5)    None of these 
400. Which types of charts can excel produce? 
(1) Line graphs and pie charts only 
(2)    Only line graphs 
(3)    Bar charts, line graphs and pie charts 
(4)    Bar charts and line graphs only 
(5)    None of these 
401. How are data organized in a spreadsheet? 
(1)    Lines and spaces 
(2)    Layers and planes 
(3)    Rows and columns 
(4)    Height and width 
(5)    None of these 
402.  What  does the  VLOOKUP function do? 
(1)  Looks up text that contain V 
(2) Checks whether text is the same in one cell as in the next 
(3)  Finds related records 
(4) All of above 
(5)  None of these 
403. Gridlines 
(1)   May be turned off for display but turned on for printing 
(2)    May be turned on or off for printing 
(3)   The be turned off for display and printing 
(4)   a, b and c 
(5)    None of these 
404. You can print only an embedded chart by 
(1)    Moving the chart to a chart sheet before you print. 
(2)    Formatting the chart before you print 
(3)    Selecting the chart before you print 
(4)    a and c 
(5)    None of these 
405.Which of the following is a cor-rect order of precedence 
in a formula calculation? 
(1)    Multiplication and division, exponential positive and  
         negative value 
(2)    Multiplication and division, positive and negative values,         
         addition and subtraction 
(3)   Addition and subtraction, positive and negative values,  
        exponentiation 
(4)    None of above 
(5)    None of these 
406. A function incite another function is called a .....function. 
(1)    Nested         (2)   Round  
(3)    Sum  (4)   Text  
(5)    None of these 
407. How should you print a selected area of a worksheet, if 
you'll want to print a different area next time?  
(1)  On the file menu, point to print area, and then click set  
      print are 
(2)  On the file menu, click print, j and then click selection |  
       under print what 
(3)  On the view menu, click custom views, then click add 
(4)  All of above 
(5)  None of these 

408. Youar German supplier still in-voices for parts in 
deutsche marks. How can you .have Excel convert those 
sums to Euros? 
(1)    On the Insert menu, click Symbol and from the currency 
symbols subset, select the Euro sign. 
(2)   On the tools menu, click Add-lns, and select the Euro 
Currency Tools check box 
(3)   Apply a selected background color 
(4)   All of above 
(5)   None of these 
409. Which function calculates your monthly mortage 
payment? 
(1)   PMT (payments) 
(2)   NPER (number of periods) 
(3)   PV (present value) 
(4)   All of above 
(5)    None of these 
410. If you are working in English (US), Chinese or 
Japanese, Excel 2002 can speak data as you enter it, to help 
you verify ac: curacy. How do you activate this feature? 
(1) Point to speech on the tools menu, and then click show 
text to speech toolbar. 
(2)   Click validation on the data menu 
(3)    Point to speech on the tools menu, and then click 
speech recognition 
(4)   All of above 
(5)    None of these 
411. You can open the Sort dialog box by choosing Sort from 
the .... menu 
(1)    View  (2)   Format 
(3)    Tools    (4)   Data       
(5)    None of these 
412. when working in the page break preview, you can 
(1)    view exactly where each page break occurs 
(2)    add or remove page breaks 
(3)    change the print area 
(4)   all of above 
(5)    None of these 
413. A data map is helpful 
(1)    When you have too much data to chart 
(2)   To show a geographic distri-bution of data 
(3)   To compare data points 
(4)    To show changes in data over-time 
(5)    None of these  
414. In MS Access-,-a table can have__ primary key /keys. 
(1)     One  (2)   Two  
(3)    Three  (4)   Four  
(5)    None of these  
415. __ cells involves creating a single cell by combining two 
or more selected cells.  
(1)    Formatting    (2)   Merging  
(3)    Embedding  
(4)   Splitting  
(5)    None of these  
416. The horizontal and vertical lines on a worksheet are 
called  
(1)    cells  (2)   sheets  
(3)    blocklines     
(4)   gridlines  
(5)    None of these  
417. To delete an incorrect character in a document, __ to 
erase to the right of the insertion point. 
(1)    press the left mouse key 
(2)    double  click  the  right mouse key 
(3)    press the BACKSPACE key 
(4)    press DELETE key 
(5)    None of these  
418. The most common subtotal used Subtotals command is 
the __ function, which causes Excel to display a sum each 
time the corurol field change.  
(1)     ADD  (2)   SUM  
(3)    TOTAL          
(4)   LIST  
(5)    None of these  
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419. Be default, Excel positions text in a cell ___. 
(1)    left-aligned 
(2)    right-aligned 
(3)    centered       
(4)   justified  
(5)    None of these  
420. To centre a paragraph using shortcut keys, press __. 
(1)    CTRL + C 
(2)    CTRL + E 
(3)    CTRL + L 
(4)    CTRL + R 
(5)    None of these  
421. Which of the following is the latest version of Excel? 
(1)    Excel 2000 
(2)    Excel 20.02 
(3)    Excel ME 
(4)    Excel XP 
(5)    None of these  
422. Which area in an Excel window allows entering values 
and formulas 
(1)    Title Bar 
(2)    Menu Bar 
(3)    Formula Bar 
(4)    Standard Tool Bar  
(5)    None of these 
423.How are data organised in a spreadsheet?  
(1)   Lines and spaces  
(2)    Layers and planes  
(3)  . Height and width  
(4)    Rows and columns  
(5)    None of these  
424. Which of the following types of tables constraints will 
prevent the entry of duplicate rows?  
(1)    Primary key  
(2)   Unique  
(3)    Null  
(4)    Foreign key  
(5)   None of these 
425. Each cell in a Microsoft Office Excel document is 
referred to by its cell address, which is the  
(1)   cell's column label  
(2)    cell's column label and worksheet tab name  
(3)   cell's row label  
(4)   cell's row and column la-bels  
(5)    None of these  
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Microsoft powerpoint 
1.    To prepare a presentation/slide show which application 
is commonly used ? 
(1)   Photoshop 
(2)   Powerpoint 
(3)   Outlook Express 
(4)    Internet Explorer 
(5)   All correct 
2.    Use the __ to choose a slide layout. 
(1)   Quick Styles gallery 
(2)   Format gallery 
(3)   Layout gallery 
(4)   Layout collection 
(5)    None of these 
3.    Ellipse Motion is a predefined 
(1)   Design template 
(2)   Color scheme 
(3)   Animation scheme 
(4)   All of the above 
(5)   None of these 
4.    Block arrows, stars and ban-ners, and callouts are all 
examples of 
(1)   Different types of children's building blocks 
(2)   Auto Shape categories 
(3)   Clip art categories located in the Microsoft Clip Gallery 
(4)   More technical terms that I don't understand 
(5)   None of these 
5.    We can replace a font on all slides with another font 
using the .......option 
(1)    Edit, Fonts 
(2)    Tools, Fonts 
(3)    Tools, Replace Fonts 
(4)    Format, Replace Fonts 
(5)    None of these     
6.    Special effects used to introduce slides in a presentation 
are called 
(1)    Effects 
(2)    Custom animations 
(3)    Transitions 
(4)    Preset animations 
(5)    None of these 
7.    PowerPoint can display data from which of the following 
add in software of MS-Offlce 
(1)    Equation editor 
(2)    Organization chart 
(3)    Photo album 
(4)    All of these 
(5)    None of these 
8.    Which key on the keyboard can be used to view slide 
show  
(1)    F1 (2)   F2  
(3)    F5  (4)   F10  
(5)    None of these 
9.    Which of the following fill effects can you  use for the 
slide background?  
(1)   Gradient     (2)   Texture 
(3)   Picture 
(4)   All of the above 
(5)    None of these 
10. Which of the following statements is not true? 
(1) Holding down the Shift key while you draw an object 
creates perfect squares, circles and straight lines 
(2)    The text in a text box can't be formatted 
(3)    The drawing toolbar contains tools for drawing shapes, 
lines, arrows, and more 
(4)    Ctrl+ S save the document 
(5)    None of these 
11.  A chart can be put as a part of the presentation using 
(1)    Insert-> Chart 
(2)    Insert -> Pictures -> Chart 
(3)    Edit -> Chart 
(4)   View -> Chart 
(5)    None of these 

12.  The arrangement of elements such as Title and Subtitle 
text, pictures, tables et (3) is called 
(1)    Layout 
(2)    Presentation 
(3)    Design        (4)   Scheme  
(5)    None of these 
13. Which of the following are types of sound files? 
(1)    LOG files      
(2)   DAT flies  
(3)   WAV files 
 (4)   DRV files 
(5)    None of these 
14. Which of the following can you use to add times to the 
slides in a presentation? 
(1)    Microsoft graph 
(2)    Microsoft Table 
(3)    Microsoft Excel 
(4)    Microsoft Word 
(5)    None of these 
15. Which view in PowerPoint can be used to enter speaker 
comments? 
(1)    Normal 
(2)    Slide show 
(3)    Slide sorter 
(4)    Notes page view 
(5)    None of these 
16. The best way to insert a new slide in a presentation is to 
use the 
(1)    Normal view 
(2)    Special view 
(3)    Slide show view 
(4)    Slide sorter view 
(5)   None of these 
17. Which is the best view for getting your thoughts for a 
presentation out on the computer? 
(1)    Outline view 
(2)    Notes page view 
(3)   Slide sorter view 
(4)    Slide view 
(5)    None of these 
18. The boxes that are displayed to indicate that the text, 
pictures or objects are placed in it is called........ 
(1) Placeholder  
(2) Auto text  
(3) Text box  
(4) Word art  
(5) None of these 
19. Which Of the following is not a feature of PowerPoint? 
(1)    Printing transparencies 
(2)    Printing the speakers notes along with slide images 
(3)   Linking a slide transition with a laser pointer 
(4)    Drawing with a pen 
(5)    None of these 
20. Which option can be used to create a new slide show 
with the current slides but presented in a different order 
(1)    Rehearsal 
(2)    Custom slider show 
(3)    Slide show setup 
(4)    Slide show view 
(5)    None of these 
21.-Which of the following are actions you can assign to an 
action button or slide object? 
(1)    Run a macro 
(2)    Play a sound 
(3)    Hyper link 
(4)    All of above 
(5)    None of these 
22. Which option in PowerPoint allows to cany slides from 
one computer to another? 
(1)    Save As 
(2)    Save and Go 
(3)    Pack and Go 
(4)   Web and Go 
(5)    None of these 
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23. Which file format can be added to a PowerPoint show? 
(1)   jPg  
(2)   .giv 
(3)    .wav 
(4)   All of the above 
(5)    None of these 
24.  In Microsoft PowerPoint two kind of sound effects files 
that can be added to the presentation are 
(1)    .wav files and .mid files 
(2)    .wav files and .gif files 
(3)    .wav files and jpg files 
(4)   jpg files and .gif files 
(5)    None of these 
25. Material consisting -of text and numbers is best 
presented as 
(1)    A table slide 
(2)    A bullet slide 
(3)    A title slide 
(4)    All of the above 
(5)    None of these 
26.  What is a motion path? 
(1)    A type of animation entrance effect 
(2)    A method of advancing slides 
(3)    A method of moving items on a slide 
(4)    All of the above 
(5)    None of these 
27. What is a slide-title master pair? 
(1)   The title area and text area of a specific slide 
(2)  A slide master and title master merged into a single slide 
(3)  A slide master and title master for a specific design  
       template 
(4)  All of above 
(5)  None of these 
28.  Which of the following should you use if you want all the 
slide in the presentation to have the same "look"? 
(1)   the slide layout option 
(2)    add a slide option 
(3)    outline view 
(4)    a presentation design template 
(5)    None of these 
29.   in the context of animations, what is a trigger? 
(1)    An action button that advances to the next slide 
(2)    An item on the slide that performs an action when  
        clicked 
(3)   The name of a motion path 
(4)    All of above 
(5)    None of these 
30.  If you have a PowerPoint show you created and want to 
send using email to another teacher you can add the show to 
your email message as a (an) 
(1)    Inclusion 
(2)    Attachment 
(3)    Reply 
(4)    Forward 
(5)    None of these 
31.  In order to edit a chart, you can 
(1)   Triple click the chart object 
(2)   Click and drag the chart object 
(3)    Double click the chart object 
(4)    Click the chart object 
(5)    None of these 
32. to exit the PowerPoint 
(1)   click the application minimize button 
(2)   click the document close button 
(3)   double click the applications control menu icon 
(4)   double click the document control menu icon  
(5)   None of these 
33. to preview a motion path effect using the custom 
animation task pane, you should 
(1)   click the play button 
(2)   click the show effect button 
(3)   double click the motion path 
(4)   all of above 
(5)    None of these 

34. You can create a new presentation by completing all of 
the following except 
(1)   Clicking the new button on the standard toolbar 
(2)   Clicking file, new 
(3)    Clicking file open 
(4)    Pressing Ctrl + N 
(5)   None of these 
35.  You can embed a MS-Organization Chart in a slide by 
(1)   Clicking the object command on the edit menu 
(2)   Clicking the object command on the edit menu 
(3)   Clicking the insert new slide button the standard toolbar, 
        then double click the organization chart button on the   
        formatting toolbar  
(4)   Clicking the MS Organization Chart button on the  
        standard toolbar 
36. To select one hyperlink after another during a slide 
presentation, what do you press?  
(1)   Tab  (2)   Ctrl + K 
(3)   Ctrl + h 
(4)   All of above 
(5)    None of these 
37. Special effects used to introduce slides in a presentation 
are called 
(1)   effects (2)    custom animations 
(3)   transitions 
(4)    present animations 
(5)    None of these 
38. You can edit an embedded organization chart object by 
(1)   Clicking edit object 
(2)    Double clicking the organization chart object 
(3)    Right clicking the chart object, then clicking edit MS- 
        Organizaiton Chart object 
(4)    b and c both 
(5)    None of these 
39. What is the term used when you press and hold the left 
mouse key and more the mouse around the slide? 
(1)    Highlighting 
(2)    Dragging 
(3)    Selecting 
(4)    Moving 
(5)    None of these 
40. Which of the following toolbars provide different options 
in various master views? 
(1)    Common tasks toolbar 
(2)    Drawing toolbar 
(3)    Formatting toolbar 
(4)    Standard toolbar 
(5)    None of these 
41.  How can you create a uniform appearance by adding a 
background image to all slides? 
(1)    Create a template 
(2)    Edit the slide master 
(3)    Use the autocorrect wizard 
(4)    All of the above 
(5)    None of these 
42.  How do you create speaker note pages that show the 
slides, related notes, and your company logo on each page? 
(1)    Edit the notes master and add your company logy 
(2)    Edit the slide master and insert your company logo and 
notes pane 
(3)    Edit the handout master to include your company logo 
and one slide per page with additional note space 
(4)    All of the above 
(5)    None of these 
43.  One way to make a PowerPoint slide display animations 
is to: 
(1)    Select the slide in normal view; and click Format 
Animation 
(2)    Click the PowerPoint window and move it around 
vigorously with the mouse for a manual animation effect 
(3)    Select the slide in slide sorter view, right click and 
choose preset animations from the shortcut menu 
(4)    PowerPoint does not have an animation feature 
(5)    None of these 
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44. Which of the following is not a way to cut ext? 
(1)    Select the text and press the delete button 
(2)    Select the text and select Edit, Cut from the menu 
(3)    Select the text and click the Cut button on the toolbar 
(4)    Select the text and press Ctrl + X 
(5)    None of these 
45. Which types of fonts are best suitable for titles and 
headlines 
(1)    serif fonts (2)    sans serif fonts 
(3)   text fonts 
(4)    picture fonts 
(5)    None of these 
46. Which type of font is best suitable for large amount of 
text? 
(1)    serif fonts (2)    sans serif fonts 
(3)   text fonts 
(4)   picture fonts 
(5)    None of these 
47. To give a PowerPoint presentation to a large audience, 
you: 
(1) Set up your computer in a large auditorium, and click 
large, auditorium, OK 
(2)   Click the slide you wish the audience to see in normal 
view, then click the next slide, and so on. 
(3)    Choose either view, slide show or slide show, view 
show 
(4)    Slick slide show, OK 
(5)    None of these 
48. Which of the following can you use to add times to the 
slides in a presentation 
(1)   Slice Show menu 
(2)    Rehearse timing button 
(3)    Slide transition button 
(4)   All of the above 
(5)   None of these 
49. Which of the following is not one of PowerPoint's views? 
(1)    Slide show view (2)    Slide view 
(3)    Presentation view 
(4)    Outline view 
(5)    None of these 
50. Which PowerPoint view works best for adding slide 
transitions? 
(1)    Slide show view (2)    Slide sorter view 
(3)    Slide view 
(4)    Notesview 
(5)    None of these 
51. Which of the following views is the best view to use when 
setting transition effects for all slides in a presentation 
(1)    Slide sorter view 
(2)    Notes page view 
(3)    Slide view 
(4)    Outline view 
(5)    None of these 
52. Which option can be used to set custom timings for 
slides in a presentation? 
(1)    Slider Timings 
(2)    Slider Timer 
(3)    Rehearsal 
(4)    Slide Show Setup 
(5)    None of these 
53. Which of the following will not advance the slides in a 
slide show view? 
(1)   The esc key 
(2)   The space bar 
(3)    The enter key 
(4)   The mouse button 
(5)    None of these 
54. To import text from a word document that uses headings 
into a PowerPoint presentation: 
(1)    This can not be done in PowerPoint 
(2)    Click Insert, Slides from Outline 
(3)    Click     Import,     Word Document Headings 
(4)   .Click File, New, Presentation from Word Headings 
(5)    None of these  

55.  Format painter 
(1)    To paint pretty picutures on your slides 
(2)    To copy formatting from one object or piece of tex 
and then apply it elsewhere 
(3)   To change the background color of your slides 
(4)   To paint pretty pictures on background of slides 
(5)    None of these 
56.   Slide show options available to the presenter include all 
of the following except 
(1)    Transitions command 
(2)    Speaker notes command 
(3)    Meeting minder command 
(4)    Navigation commands 
(5)    None of these 
57. Which of the following is an example for automatic text 
formatting 
(1)    Underlining hyperlink 
(2)    Adjusting extra space 
(3)    Replacing two -'s with an em hyphens.   
(4)    All of above 
(5)   None of these 
58. Which of the following is not a way to create a new 
presentation? 
(1)    Using the Scan-In Slides feature 
(2)    From scratch (create a blank presentation 
(3)    Using a template 
(4)    Using the auto content wizard 
(5)    None of these 
59. The quickest way to create a PowerPoint presentation is 
to use the 
(1)    Word for windows templates 
(2)    Auto creation wizard 
(3)    Auto content wizard 
(4)r   Presentation wizard 
(5)     None of these 
60. Which option the following can you format using buttons 
on the formatting toolbar? 
(1)    Your hard drive 
(2)    Format painting 
(3)    Font color 
(4)    Underlining 
(5)    None of these 
61. Which tab is not available on left panel   when   you   
open   a presentation?  
(1)   Outline   (2)   Slides 
(3)   Notes (4)   All of above 
(5)   None of these 
62. Which of the following statements is not true? 
(1)   You can type text directly into a PowerPoint slide but 
typing in text box is more convenient. 
(2)   From Insert menu choose Picture and then From File to 
insert your images into slides. 
(3)   You can display a PowerPoint presentation in Normal, 
Slide Sorter or Slide Show view. 
(4)   You can show or hide task pane from View » Toolbars 
(5)    None of these 
63. To start Microsoft PowerPoint application 
(1)   Click on Start » Programs » All Programs » Microsoft 
PowerPoint 
(2)    Hit Ctrl + R then type ppointexe and Enter 
(3)   Click Start > > Run then type powerpnt then press Enter 
(4)   All of above 
(5)    None of these 
64. Which of the following section does not exist in a slide 
layout?  
(1)   Titles  (2)   Lists  
(3)   Charts (4)   Animations 
(5)   None of these 
65.  PowerPoint presentations are widely used as  
(1)   Note outlines for teachers 
(2)    Project presentations by students 
(3)    Communication of planning 
(4)   All of above 
(5)    None of these 
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66. __ controls all the main slide control     tasks     for     
your presentation.  
(1)   Task Pane     (2)   Task Bar 
(3)    Control Panel 
(4)    All of above 
(5)    None of these 
67. Which of the following cannot be toggled from View » 
Toolbars? 
(1)    Control Toolbox (2)   Slides 
(3)    Revisions 
(4)    Reviewing 
(5)   None of these 
68. Which of the following pane is not available in Task 
Pane? 
(1)    Getting Started (2)    Clip Art 
(3)    Word Art 
(4)    Search Results 
(5)    None of these 
69. Which of the following pane is NOT available in Task 
Pane? 
(1)    Slide Design  (2)    Master Slide 
(3)    Slide Layout 
(4)   Slide Transition 
(5)    None of these 
70. A new presentation can be created from 
(1)    Blank Presentation 
(2)    From Existing Presentation 
(3)    From Design Template 
(4)    All of above 
(5)    None of these 
71.  In slide layout panel how many layouts are available for 
text layout by default?  
(1)    4   (2)   7  
(3)    12                  
(4)    18  
(5)    None of these 
72. Which of the following statement is false? 
(1) If you choose to select from one of the pre made slide 
layouts, you can change the positioning 
(2)    If you choose to select from the pre-made slide layouts, 
you cannot delete the objects in the layout. 
(3)    Blank Slide is at the top of the 'Content Layouts' area in 
the Slide Layout panel. 
(4)    All of above are false statements 
(5)    None of these 
73. What lets you to create new presentation by selecting 
ready-made font color and graphics effects? 
(1)    Presentation Template 
(2)    Master Slide 
(3)    Design Template 
(4)    Animation Scheme 
(5)    None of these 
74.  Which command will you use in PowerPoint if you need 
to change the color of different objects without changing 
content? 
(1)    Design Template 
(2)    Color Scheme 
(3)    Font Color 
(4)    Object Color  
(5)    None of these 
75.  What PowerPoint feature will you use to apply motion 
effects to different objects of a slide? 
(1)    Slide Transition 
(2)    Slide Design 
(3)    Animation Objects 
(4)    Animation Scheme 
(5)    None of these 
76.  What feature will you use to apply motion effects in 
between a slide exits and another enters?  
(1)    Slide Transition 
(2)    Slide Design 
(3)    Animation Objects 
(4)    Animation Scheme 
(5)    None of these  

77. The selected design template can be applied 
(1)   To current slide only 
(2)   To all the slides 
(3)   To all the new presentation you create 
(4)   All of above 
(5)    None of these 
78. The difference between Slide Design and Auto Content 
Wizard is 
(1)    Both are same 
(2)   AutoContent Wizard is just the wizard version of Slide  
        Design 
(3)    Slide Design does not provide sample content but Auto  
        Content Wizard provides sample content too! 
(4)   Slide Design asks your choice in steps but Auto Content  
       Wizard does not let you make choices 
(5)    None of these 
79.  In which menu can you find features like Slide Design, 
Slide Layout etc.? 
(1)    Insert Menu 
(2)    Format Menu 
(3)   Tools Menu 
(4)    Slide Show Menu 
(5)    None of these 
80. Which menu provides you options like Animation 
Scheme, custom Animation, Slide Transition? 
(1)    Insert Menu 
(2)    Format Menu 
(3)   Tools Menu 
(4)   Slide Show Menu 
(5)    None of these 
81.  How many steps are there between Start and Finish in 
AutoContent Wizard?  
(1) 3  (2) *  
(3) S  (4) 6 
(5)    None of these  
82. Which short cut key inserts a new slide in current presen-
tation?    
(1)    Ctrl+N  
(2)   Ctrl+M 
(3)    Ctrl+S 
(4)   All of above 
(5)    None of these  
83. What happens if you select first and second slide and 
then click on New Slide button on toolbar? 
(1)    A new slide is inserted as first slide in presentation 
(2)    A new slide is inserted as second slide in presentation 
(3)    A new slide is inserted as third slide in presentation 
(4)    None of above 
(5)    None of these 
84. Which of the following method can insert a new slide in 
current presentation? 
(1)    Right click on the Slide panel and choose New Slide 
(2)    From Insert menu choose New Slide 
(3)    Click on New Slide button on toolbar 
(4)    All of above 
(5)    None of these 
85. Which of the following is not a part of Slide Design? 
(1)    Design Template 
(2)    Color Scheme 
(3)   Animation Scheme 
(4)    Slide Layout 
(5)    None of these 
86. What is the best way to create another copy of a slide? 
(1)   Click the slide then press Ctrl+A and paste in new slide 
(2)    From Insert Menu choose Duplicate Slide 
(3)    Redo everything on a new slide that you had done on 
previous slide 
(4)    None of above 
(5) None of these 87. From which menu you can access 
Picture, Test Box, Chart etc? 
(1)    File  (2)   Edit 
(3)    Insert  
(4)   View 
(5) None of these  
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88: If you want to insert some slides from other presentation 
into current one choose 
(1)    From Insert menu choose Slides from Files 
(2)    From Insert menu choose Slides from Presentation 
(3)    From Insert menu choose Slides 
(4)    None of above 
(5)    None of these 
89. What are the three options available in Insert » Picture 
menu? 
(1)   Clipart, Pictures, Shapes 
(2)    Clipart, From File, Shapes 
(3)    Clipart, From Files, Auto Shapes 
(4)    Clipart, Pictures. Auto Shapes 
(5)    None of these 
90.  To insert slide numbers 
(1)    Insert a text box and select Insert » Page Number 
(2)    Insert a textbox and select Insert » Number »  
        PageNumber 
(3)   Choose Insert > > Slide Number 
(4)    Insert n new text box and select Insert > > slide Number 
(5)    None of these 
91.  In a PowerPoint presentation 
(1)    Sound clips can be inserted but not movie clips 
(2)    Movie clips can be inserted but not sound clips 
(3)    Both cannot be inserted 
(4)    Both can be inserted 
(5)   Tally can be inserted 
92. To insert a hyperiink in a slide 
(1)   Choose Insert » Hyperiink 
(2)    Press Ctrl + K 
(3)    Hyperlinks can't be inserted in slides 
(4)   Both a and b 
(5)   None of these 
93.  List Box and Text box 
(1) Are some other than that in a list box the bullets are 
enabled 
(2)   Are different. List boxes are used to present lists and 
can't be created with text boxes. 
(3)   Both of above 
(4)   None of above 
(5)   are not used at all 
94. Which of the following statement is true? 
(1)   You can insert text boxes from drawing toolbar in 
PowerPoint 
(2)   You cannot insert text boxes from drawing toolbar in 
PowerPoint 
(3)   Text boxes are provides when you choose a layout and 
can't be inserted afterwards 
(4)   Text box is not available 
(5)   None of these 
95. When you delete a text box object from a slide in 
PowerPoint Presentation 
(1)   The object is deleted but text box and the text inside is 
left on the slide 
(2)   The text box is deleted and the text is pasted on the 
slide 
(3)   The text box and text both are deleted 
(4)   All of above 
(5)   None of these 
96. Which of the following font effect is not available in 
PowerPoint Font dialog box? 
(1)    Underline 
(2)   Shadow 
(3)    Emboss 
(4)    Strikethrough 
(5)    None of these 
97. What happens if you edited an image inserted in 
PowerPoint? 
(1)   The original file that was inserted is not changed 
(2)    The original file that was inserted is changed 
(3)   The original file is changed when you save presentation 
(4)    None of above 
 
 

98.  If you select Insert » Picture » From File 
(1)   You can insert pictures and clipArts 
(2)    You can insert clipArts only 
(3)   You can insert pictures only 
(4)    All of above 
(5)    None of these 
99. The effect applied to display when slides changes in slide 
show view is 
(1)    Slide Animation 
(2)    Custom Animation 
(3)   Custom Transition 
(4)    Slide Transition 
(5)    None of these  
100. To   start   slide   show  of  a presentation 
(1)    Hit F5 key 
(2)    From Slide Show menu choose View Show option 
(3)    From Slide Show menu choose Rehearse timing 
(4)    Both a & b 
(5)    None of these  
101. Which option on the custom animation task pane allows 
you to apply a preset or custom motion path? 
(1)   Add effect 
(2)    Emphasis 
(3)   Animate now 
(4)   All of the above 
(5)    None of these 
102. What is the term used when a clip art image changes 
the direction of faces?  
(1)    Group  (2)   Flip       
(3)    Rotate 
(4)    All of the above 
(5)    None of these 
103. the slide that is used to introduce a topic and set the 
tone for the presentation is called the 
(1)   table slide (2)   graph slide 
(3)   bullet slide    
(4)   title slide  
(5)    None of these 
104. Which of the following features should you use when 
typing in the notes text box?  
(1)    Slide show   (2)   Insert  
(3)    Slide maser  
(4)   Zoom  
(5)    None of these 
105.Which option allows you to select line, curve, freeform or 
scribble tools? 
(1)    Create effect 
(2)    Insert motion path 
(3)    Draw custom path 
(4)   All of the above 
(5)   None of these 
106. Which of the following should be used when you want to 
add a slide to an existing presentation? 
(1)    File, add a new slide 
(2)    Insert, New slide 
(3)    File Open 
(4)    File, New 
(5)   None of these 
107. The size of the organization chart object 
(1)    Is determined by the presentation design and can not 
be changed 
(2)    Is determined by the presentation design but can be 
changed in PowerPoint 
(3)    Is dependent on the amount of text within the 
organization chart 
(4)   b and c 
(5)    None of these 
108. Want a PowerPoint photo album slide show to play 
continuously? 
(1)   Use random slide transitions 
(2)   Launch an online broadcast 
(3)    Loop continuously 
(4)   All of the above 
(5)   None of these 
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109. what is defined by the handout master? 
(1)   Slide formatting 
(2)   Layout of audience handout notes 
(3)   Handout content formatting for Microsoft word export 
(4)   All of above 
(5)   None of these 
110. Which of the following tool enables you to add text to a 
slide without using the standard placeholders? 
(1)   Text tool box  (2)   Line tool 
(3)    Drawing tool 
(4)   Auto shapes tool 
(5)   None of these 
111. In notes master view, how do you modify the font size of 
text for all hte4 notes of a presentation? 
(1)   rModify the slide design 
(2)    Modify the notes master layout 
(3)   Modify the text within the body placeholder 
(4)   All of the above 
(5)   None of these 
112. Want your logo in the same position on every slide, 
automatically? Insert it on the 
(1)   Handout master (2)   Notes master 
(3)   Slide master 
(4)   All of the above 
(5)   None of these 
113. Which of the following views is the best view to use 
when setting 
transition effects for all slides in a presentation? 
(1)    Slide sorter view (2)    Notes pages view 
(3)    Slide view 
(4)    Outline view 
(5)    None of these 
114. Objects on the slide that hold text are called 
(1)    Placeholders 
(2)    Object holders 
(3)    Auto layouts 
(4)   Text holders 
(5)    None of these 
115. Which of the following provides a means of printing out 
feature notes with a miniature slide on a printed page? 
(1)    Slide with animation 
(2)    Outline view 
(3)    Notes page 
(4)    Audience handout 
(5)    None of these 
116. Which command brings you to the first slide in your 
presentation? 
(1)    Next slide button 
(2)    Page up 
(3)    Ctrl +'Home ! 
(4)    Ctrl + End 
(5)    None of these 
117. In normal view, how can you quickly change to handout 
master view? 
(1)   Click the outline tab and select handout master view 
(2)   Press the shift key and click the handout master view  
        button 
(3)    On the view menu, click slide sorter, and dick handouts. 
(4)    All of above 
(5)    None of these 
118. how can you quickly reinstate a deleted footer 
placeholder in master view? 
(1)   Create a new slide master 
(2)    Re-apply    the    footer Placeholder 
(3)    Re-apply the slide layout 
(4)    All of the above 
(5)    None of these 
119. Which of the following can you use to add times to the 
slides in a presentation? 
(1)    Slide show menu 
(2)    Rehearse timings button 
(3)   Slide transition button 
(4)   All of the above 
(5)    None of these 

120. To select all of the boxes of an organization chart 
(1)   Clicking and edit and select all 
(2)   Right click the chart background and then click select all 
(3)    Press and hold the SHIFT key and click each box 
(4)    All of above 
(5)    None of these 
121. You can show the shortcut menu during the slide show by 
(1)    Clicking the shortcut button on the formatting toolbar 
(2)    Right clicking the current 1 slide 
(3)    Clicking an icon on the current slide 
(4)    a and b 
(5)    None of these 
122. Auto clipart is a feature that 
(1)  Automatically places clipart in your presentation 
(2)   Scans your presentation for incorrect spelling in your 
words on each slide 
(3)   Scans your presentation for incorrect spelling in Word 
Arts objects 
(4)   All of above 
(5)    None of these 
123. to edit the text within the boxes of an organization chart, 
you 
(1)   Select the box and text, then make changes 
(2)   Select the box, then make the changes 
(3)   Highlight the text, them make the changes 
(4)   A and b both 
(5)    None of these 
124. Which of the following allow you to select more than 
one slide in a presentation? 
(1)   Alt + Click each slide 
(2)   Shift + drag each slide 
(3)   Shift + Click each slide 
(4)   Ctrl + Click each slide 
(5)   None of these 
12.5. The view that displays the slides on a presentation as 
miniature representations of the slides is called 
(1)   Slide show (2)   Slide sorter view 
(3)   Notes page view 
(4)   Outline view 
(5)   None of these 
126. The PowerPoint view that displays only text (title and 
bullets) is 
(1)   Slide show (2)   Slide sorter view 
(3)   Notes page view 
(4)   Outline view 
(5)   None of these 
127. In Microsoft PowerPoint the entry effect as one slide 
replaces another in a show is called a (an) 
(1)   Animation 
(2)   Slide transition 
(3)   Custom animation 
(4)   Preset animation 
(5)   None of these 
128. Which of the following presentation elements can you 
modify using the slide master? 
(1)   Slide comments 
(2)   Slide transitions 
(3)   Speaker note font and color 
(4)   All of above 
(5)    None of these 
129. Which of the following provides a printed copy of your 
presentation? 
(1)   Outline 
(2)    Speaker notes 
(3)    Audience handouts 
(4)   All of the above 
(5)   None of these 
130. Slide show options available to the presenter include all 
of the following except 
(1)   Transitions command 
(2)   Speaker notes command 
(3)    Meeting reminder command 
(4)    Navigation commands 
(5)    None of these 
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131. Presentation designs regulate the formatting and layout 
for the slide and are commonly called 
(1)    Design plates 
(2)    Templates  (3)    Placeholders 
(4)    Blueprints 
(5)    None of these 
132. Which of the following bypasses the print dialog box 
when printing individual slides or an entire presentation? 
(1)    File, print, preview (2)    The print button 
(3)    File, print 
(4)    Ctrl + p 
(5)    None of these 
133. To add a header or footer to your handout, you can use 
(1)   The title master 
(2)   The slide master 
(3)   The handout master 
(4)   All of above 
(5)   None of these 
134. Which of the following will not advance the slides in a 
slide show view? 
(1)    Esc key  (2)   The spacebar 
(3)   The Enter key 
(4)   The mouse button 
(5)    None of these 
135. What are lines, curve, freeform and scribble? 
(1)    Emphasis effects that can be applied to animations 
(2)    Types of custom motion paths 
(3)    Predefined entrance and exit effects 
(4)    All of the above 
(5)    None of these 
136. Comments on a presentation can record who wrote 
them and when they were added. What's the automatic way 
in PowerPoint 2002? 
(1)    Use online collaboration 
(2)    Use comments 
(3)    Use the notes page 
(4)    All of the above 
(5)    None of these 
137. When using PowerPoint to play a PowerPoint show for 
previewing the show, select 
(1)    View, slide sorter 
(2)    View, slide 
(3)    View, slide show 
(4)    View outline 
(5)    None of these 
138. In Microsoft PowerPoint in order to see all the slides on 
one screen use 
(1)   View, slide sorter 
(2)    View, slide 
(3)   View, master 
(4)    view, slide show 
(5)    None of these 
139. What's the best place to find animated images for you-
PowerPoint 2002 presentation? 
(1)   Microsoft online (2)   Word clipart 
(3)    PowerPoint tools and ins 
(4)   All of the above 
(5)    None of these 
140.  what's the easy way to apply varied animations to test 
on slides 
(1) apply effects in the custom animation text pane . 
(2)   apply an animation scheme 
(3)   customize bullets with animated clipart 
(4)   all of above 
(5)   None of these 
141. Using a custom animation effect, how do you make text 
appear on a slide by letter 
(1)   Apply the animation scheme fade in one by one. 
(2)   Apply an entrance effect, and then set it to by letter in 
the effect option dialog box 
(3)   Apply the fly in entrance to the text, and then set its 
speed to very slow. 
(4)   All of above 
(5)   None of these 

142. To exit the PowerPoint application, you should 
(1)   Click the application minimize button 
(2)   Click the document close button 
(3)   Double click the application control menu icon 
(4)   Double click the document control menu icon 
(5)   None of these 
143. You can create a new presentation by completing all of 
the following except: 
(1) Clicking the new button on the standard toolbar 
(2)   Clicking file, new 
(3)   Clicking file open 
(4)    Pressing Ctrl + N 
(5)   None of these 
144. You have customized a design template in one 
presentation and you want to use it in another presentation. 
What the best way to do this?  
(1) Use the browse feature in the slide design task pane to 
find the file that has your design template and apply it to the 
current file. 
(2)   Copy and paste the slide with the design template you 
want to include the new presentation; inserted slide will 
inherit the design 
(3)    Save the presentation that has the design template with 
a new name, and then use a new file to your presentation 
(4)   All of the above. 
(5)    None of these 
145. Which of the following options in the printer dialog box 
would you select to print slides 5 and 12 in a presentation? 
(1)    Slides 
(2)   Custom shows 
(3)    Current slide 
(4)   All of the above 
(5)    None of these 
146. Which of the following toolbars provides different 
options in various master views? 
(1)   Common tasks toolbar 
(2)    Drawing toolbar 
(3)    Formatting toolbar 
(4)   Standard toolbar 
(5)    None of these 
147. You can tell when an object is active because 
(1)   The object is highlighted 
(2)    Eight small sizing handles appear surrounding the text 
(3)   A  box frame  appears surrounding the text 
(4)    b and c 
(5)    None of these 
148. Which of the following is not an option when printing-
handouts? 
(1)   Six slides per page 
(2)    Five slides per page 
(3).   Three slides per page 
(4)   Two slides per page 
(5)   None of these 
149. What's the best way to design the layout for your 
slides? 
(1)    Create layouts for slides, handouts and notes using the 
Master Layout dialog box in slide master view 
(2)    For each new slide, select a layout from the Slide 
Layout task pane 
(3)   Apply templates from the Slide Design task pane 
(4)   None of above 
(5)    None of these 
150. Any and every command can be found on the 
(1)    Drawing toolbar 
(2)   Formatting toolbar 
(3)    Standard toolbar 
(4)    Menu bar 
(5)   None of these 
151.The slide that is used to introduce a topic and set the 
tone for the presentation is called the 
(1)   Table slide (2)   Graph slide 
(3)    Bullet slide 
(4)   Title slide 
(5)    None of these 
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152. How do you print your slides in a handout that includes 
lines for notes? 
(1)   In the print dialog box, select handout and set the 
number of slides per page to 3 
(2) In the print dialog box, select handout and set the number 
of slides per page, then select the include comment page 
option 
(3)   In the print dialog box select note page instead of 
handout 
(4)   All of above  
(5)   None of these 
153. Which of the following features should you use when 
typing in him notes text box? 
(1)   Slide shows (2)   Insert 
(3)   Slide master 
(4)   Zoom 
(5)   None of these 
154. Which of the following should e used when you want to 
add a slide to an existing presentation? 
(1)   File, add a new slide 
(2)    Insert, new slide 
(3)   File, open 
(4)   File, new 
(5)   None of these 
155. Which of the following is the default page setup 
orientation for notes pages, outlines and handouts? 
(1)   Vertical (2)   Landscape 
(3)   Portrait 
(4)   None of above 
(5)   None of these 
156. Which of the following is the default page setup 
orientation for slides in PowerPoint? 
(1)   Vertical (2)   Landscape 
(3)    Portrait 
(4)   All of above 
(5)   None of these 
157. How can you get your photo album slide show to play 
continuously? 
(1)   Use random slide transition 
(2)   Launch      an      online broadcast 
(3)    Loop continuously 
(4)   All of above 
(5)    None of these 
158.What are symbols used to identify items in a list?  
(1)   Icons  (2)   Markers  
(3)   Bullets          
(4)   Graphics  
(5)   None of these 
159. You have got a bunch of digital holiday photo you want 
to put into a slide show. What the quickest method? 
(1)    Apply a multiple-picture layout to several slides, and 
use the clipart icon on the slides to import your picture 
(2)    On the insert menu, point to the picture, click from, file, 
and select your picture in a group for each slide 
(3)    On the insert menu, point the picture and click new 
photo album 
(4)    All of the above 
(5)    None of these 
160.How would you create the following diagram in PowerPoint? 
(1)    Use auto shapes and the drawing toolbar to create the 
diagram and design it 
(2)    Open the diagram gallery from the drawing toolbar and 
choose this diagram type 
(3)    Use the chart command on the insert menu to import 
the diagram 
(4)    All of above 
(5)    None of these 
161. Which of he following provides a means of printing out 
features notes with a miniature slide on a printed page? 
(1)   Slides with animation 
(2)    Outline view 
(3)    Notes page 
(4)   Audience handout 
(5)    None of these 

162. Which command brings you to the first slide in your 
presentation? 
(1)    Next slide button 
(2)    Page up 
(3)    Ctrl + home 
(4)    Ctrl + end 
(5)    None of these 
163. You were giving your presentation, and you need to 
click a slide that's few slides back. How do you get there? 
(1)   Press ESC to get back into a normal view; click the slide 
thumbnail in normal view; then click the resume slide show 
button 
(2)    Press backspace until your desired slide 
(3)    Right click, point to go on the shortcut menu, point to by 
title, and click the slide you want to go to 
(4)    All of above 
(5)    None of these 
164. Which of the following should you do to bring a bullet 
back to a previous level? 
(1)    Press the shift + tab keys 
(2)    Press the shift key 
(3)    Press the enter key 
(4)    Press the tab key 
(5)    None of these 
165. Good design determines 
(1)    Credibility 
(2)    Readability 
(3)    First impression 
(4)   All of above 
(5)    None of these 
166. To make a selection of slides on our presentation, use a 
different design template from the other slides, what do you 
do? 
(1)   Select the slides thumbnails in that section, and apply a 
different color scheme 
(2)    Select the slide thumbnails in that section and apply a 
different design template 
(3)    Select one of the slides in the section you want to 
change, customize the fonts and colors, and use the format 
painter tool to apply those styles to the other slides in the 
section 
(4)    All of above 
(5)    None of these 
167. Your presentation is ready to go, but you don't know if 
PowerPoint is installed on the computer, you will use to 
present with what's the safe way 
(1)    Save your presentation as a web page 
(2)    Set up your presentation to be "browse as a kiosk" 
(3)   Use the Pack and Go wizard 
(4)    All of the above 
(5)   None of these 
168. The view that displays the slides of a presentation as 
miniature representations of the slides is called 
(1)   Slide show 
(2)   Slide sorter view 
(3)    Notes page view 
(4)   Outline view 
(5)    None of these 
169. The power point view that displays only text (title and 
bullets) is: 
(1)   Slide show 
(2)    Slide sorter view 
(3)    Notes page view 
(4)    Outline view 
(5)    None of these 
170. Which of the following provides a printed copy of your 
presentation? 
(1)    Outlines 
(2)    Speaker notes 
(3)   Audience handouts 
(4)   All of above 
(5)   None of these 
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171. Presentation designs regulate the formatting and layout 
for the slide and are commonly called 
(1)   Design templates 
(2)   Templates 
(3)    Placeholders 
(4)    Blueprints Correct 
(5)    None of these 
172. Which of the following should you use if you want all the 
slides in the presentation to have the same look? 
(1)   The slid layout option 
(2)   The add a slide option 
(3)    Outline view 
(4)    A presentation design template 
(5)    None of these 
173. Line spacing refers to 
(1)   The space between the lines of text 
(2)    The height of the line 
(3)   The length of the line 
(4)    A and c 
(5)    None of these 
174. Which of the following uses the spelling and grammar 
feature to indicate an incorrect spelling? 
(1)   The incorrect word appears in all capital letters 
(2)    The incorrect word has a wavy red line under it 
(3)    The incorrect word appears italicized 
(4)    The incorrect word appears bold 
(5)    None of these 
175. Which of the following bypasses the print dialog box 
when printing individual slides or an entire presentation? 
(1)    File, Print Preview 
(2)    The print button 
(3)    File, print 
(4)    Ctrl + P 
(5)    None of these 176; the handout master contains 
placeholders fro all of the following except 
(1)    Slide number 
(2)   Title (3)   Footer 
(4)    Header 
(5)    None of these 177. Material consisting of text and 
numbers is best presented as 
(1)   A table slide 
(2)    A bullet slide 
(3)    A title slide 
(4)    All of above 
(5)   None of these 
178. Which of the following displays when an image is 
selected? 
(1)    Add clip art only if it relates to your topic 
(2)    Be sure to place at least one clipart image per slide 
(3)   Resize the image so it takes up as much space as your text 

(4)    A and b 
(5)    None of these 
179. The Microsoft clip gallery allows you to 
(1)    Add word art images to a slide 
(2)    Spell check your presentation 
(3)    Add clip art images to a slide or slides 
(4)    Add slides to a presentation 
(5)    None of these 
180. Which command select all object at one time when 
selecting multiple objects to be deleted?  
(1)    Alt + a  
(2)   Ctrl + a 
(3)    Shift + Enter 
(4)    Edit, Select All 
(5)    None of these 
181. Auto clip art is a feature that 
(1)   Automatically places clip art in your presentation 
(2)   Scans your presentation for incorrect spelling of words 
on each slide 
(3)    Scans your presentation for incorrect spelling in word 
art objects 
(4)   All of the above 
(5)    None of these 
 

182. To select all the boxes of an organization chart 
(1)    Click edit, select all 
(2)    Right click the chart background click select all 
(3)    Press and hold the shift key and click each box 
(4)   All of the above 
(5)   None of these 
183. To adjust the width .of table columns, you 
(1)   Click table menu. Column width, then make adjustments 
(2)   Drag the vertical gridline between two columns 
(3)   Drag the column markers on the table ruler bar 
(4)   b and c 
(5)   None of these 
184. To add a new row to a table you would 
(1)   Click the insert rows command on the insert menu 
(2)   Press the enter key 
(3)   Click the insert rows button on the standard toolbar 
(4)   None of the above 
(5)   None of these 
185. After moving a clip art image to a particular location on 
the slide, you can immediately reverse the action using the 
(1)   Click the not do move object command on the edit menu 
(2)   Click on the undo button 
(3)   Click on redo button 
(4)   All of above 
(5)   None of these 
186. You can edit an embedded organization chart object by 
(1)   Clicking the edit object 
(2)    Double clicking the organization chart object 
(3)   Right clicking the chart object, then clicking edit MS-
Organization Chart object 
(4)   Band c 
(5)   None of these 
187. You edit an embedded table object by  
(1)   Clicking  the   edit  sub command of the document 
object command on the edit menu  
(2)    Double clicking the table object 
(3)    Right clicking the table object, then clicking edit 
document on the edit menu 
(4)   All of above 
(5)    None of these 
188. You can embed a Microsoft Word tale in a slide by 
(1)   Clicking the insert new slide button on the standard 
toolbar, then double clicking table 
(2)    Clicking the insert Microsoft word table button on the 
formatting toolbar 
(3)    Clicking the insert Microsoft word table button on the 
standard toolbar 
(4)    A and c 
(5)    None of these 
189. You can embed a organization chart in a slide by 
(1)   Clicking the object command on the edit menu 
(2)    Clicking the insert new slide button on the standard 
toolbar, then double clicking the organization chart auto 
layout 
(3)   Clicking the ms organization chart button on the 
formatting toolbar 
(4)   Clicking the ms organization chart button on the 
standard toolbar 
(5)    None of these 
190. You can add multiple subordinates to a position by 
(1)   Clicking the subordinate button as you press and hold 
shift 
(2)   Clicking the subordinate button each and every time 
You add a subordinate 
(3)    Clicking the subordinate button as many times as the 
desired boxes 
(4)    All of above 
(5)    None of these 
191. What is the name of the form used to input chart 
values? 
(1)    Datasheet (2)    Microsoft Excel 
(3)    Microsoft graph 
(4)    Auto form 
(5)    None of these 
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192. Which of the following you must first complete in order 
to delete an object? 
(1)    Double click the image 
(2)   Select the image 
(3)    Resize the image 
(4)    Move the image to a new location 
(5)    None of these 
193. What is the term used to described the separation of a 
clip art object into different parts so that it becomes a 
PowerPoint object? 
(1)    Embedding 
(2)    Regrouping 
(3)    Ungrouping 
(4)    Grouping Correct 
(5)    None of these 
194. The auto shapes tool provides you with 
(1)    Fancy text to place on your slide 
(2)    Commonly found shapes 
(3)   Any shape you want to add on a slide 
(4)    Clip art that is related to your presentation 
(5)    None of these 
195. Which of the following should e used when you want to 
add a slide to an existing presentation? 
(1)    File, add a new slide 
(2)    Insert, new slide 
(3)    File, open 
(4)    File, new 
(5)   None of these 
196. An organization has a president vice president, 
managers and supervisors. On what level of an organization 
chart are the vice presidents? 
(1)   Fourth level 
(2)   Third level 
(3)   Second level 
(4)    First level 
(5)    None of these 
197. Which of the following includes special effects that can 
be applied to drawing objects? 
(1)   Gradient fills 
(2)   Line color and style 
(3)   Rotating 
(4)   All of above 
(5)    None of these 
198. What is the term used when a clip art image changes 
the direction it faces?  
(1)    Group  
(2)   Flip  
(3)   Rotate         (4)   a and b  
(5)    None of these 
199. What is the term used when you press and hold the left 
mouse key and move the mouse around the slide? 
(1)    Highlighting 
(2)    Dragging 
(3)   Selecting      
(4)   b and c  
(5)   None of these 
200. The size of a table object 
(1)    is dependent on the amount of text within the table 
(2)    Is determined by the presentation design but can be 
changed 
(3)   Is determined by the presentation design and can not be 
changed 
(4)   A and c 
(5)    None of these 
201. The size of an organization chart object 
(1)    Is determined by the presentation design and cannot be 
changed 
(2)    Is determined by the presentation design but can be 
changed in PowerPoint 
(3)    Is dependent on the amount of text within the 
organization chart 
(4)    B and c 
(5)    None of these 

202. Which of the following format options should be used to 
display dollars on an axis? 
(1)    Normal 
(2)    Percentage 
(3)    Currency      
(4)   Comma  
(5)    None of these 
203. To maintain the perspective (height and width ratio) of 
an object when resizing, you need to 
(1)    Press and hold the shift key while dragging a corner 
sizing handle 
(2)    Press and hold the alt + Ctrl keys while dragging a 
middle handle 
(3)    Drag a corner sizing handle 
(4)    A and c 
(5)    None of these 
204. Which of the following is/are true about rulers and 
guides? 
(1)    Rulers and guides can be turned on or off 
(2)    Rulers and guides print on the slide 
(3)    Rulers and guides help place objects on the slide 
(4)    A and c 
(5)    None of these 
205. To edit the text within the boxes of an organization 
chart, you 
(1)   Select the box and text, then make the changes 
(2)   Select the box, and then make the changes 
(3)    Highlight the text then make the changes 
(4)    Highlight the text then make the change 
(5)    None of these 
206. Which of the following best describes serifs? 
(1)   Serifs on characters help to differentiate between similar 
looking letters 
(2)    Serifs fonts are best for viewing test at a distance 
(3)    Serifs are fine cross strokes that appear at the bottom 
and top of a letter 
(4)    Serif font is very simple in appearance 
(5)    None of these 
207. Which of the following options changes the fill color of 
an object back to the default color? 
(1)   Template 
(2)    Automatic 
(3)    Patterns 
(4)    Fill colors 
(5)    None of these 
208. Which of the following should you use to add shading to 
a drawing object on or an auto shape object? 
(1)    Text box tool 
(2)    Line tool 
(3)    Fill color        
(4)   B and c   
(5)    None of these 
209. Which of the following tools enable you to add text to a 
slide without using the standard placeholder?? 
(1)   Text box tool 
(2)   Line tool; 
(3)   Fill color 
(4)   Auto shapes tool  
(5)   None of these 
210. A cell is defined as 
(1)   The intersection of a column and a row 
(2)    An input box 
(3)    A rectangular marker 
(4)    All of the above 
(5)   None of these 
211. Which of the following must be used with the mouse 
when you want to resize an image from the center and keep 
it proportioned? 
(1)   The space bar 
(2)   The alt key 
(3)    The Ctrl key 
(4)    The shift key 
(5)    None of these 
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212. Which of the following should be used with the mouse 
when you want to draw a perfect shape? 
(1)   The spacebar 
(2)   The alt key 
(3)   The Ctrl key 
(4)   The shift key 
(5)    None of these 
213. What will happen if you release the mouse button 
before releasing the shift key when you draw a square? 
(1)   The square will not be a perfect square 
(2)   The square will not be at the center of the slide 
(3)   The square will be smaller 
(4)   The square will be larger 
(5)    None of these 
214. On which part of the chart are the values entered in a 
data sheet displayed? 
(1)   The title area 
(2)   The legend 
(3)   The y-axis 
(4)   The x-axis 
(5)    None of these 
215. In order to edit a chart, you can 
(1)   Triple click the chart object 
(2)   Click and drag the chart object 
(3)   Double click the chart object 
(4)   Click the chart objects 
(5)   None of these 
216. When an image is selected, it displays which of the 
following? 
(1)    Two corner handles 
(2)    Six middle. handles 
(3)    Eight sizing handles 
(4)    Six boxes 
(5)    None of these 
217. The maximum zoom percentage in Microsoft 
PowerPoint is 
(1)    100%  
(2)   200%  
(3)    400%             
(4)    500%  
(5)    None of these 
218.PowerPoint 2000 has ....... Number of views  
(1)    3  (2)   4  
(3)    fei                 
(4)   6  
(5)    None of these 
219. Press animation effects allows you to 
(1)   Add clip art images to your slides 
(2)    Create a custom transition to the nect slide 
(3)    Show bullet items as they are discussed 
(4)    None of above 
(5)    None of these 
220. Which of the following features allows you to view slides 
in a slide show without manually advancing each slide? 
(1)    Adding build effects 
(2)    Setting slide times 
(3)    Adding transitions 
(4)    All of these 
(5)    None of these 
221. Animation schemes can be applied to..... in the 
presentation 
(1)   All slides 
(2)   Select slides 
(3)    Current slide 
(4)    All of the above 
(5)    None of these 
222. Which of the following feature allows ypu to select more 
than one slide in slide sorter view? 
(1)    Alt + Click each slide 
(2)    Shift + drag each slide 
(3)   Shift + Click each slide 
(4)   Ctrl + Click each slide 
(5)    None of these 
 

223. One thing the common tasks button allows you to do is 
(1) Apply a design template to a slide 
(2)    Insert a new slide 
(3)    Choose a new layout for a slide 
(4)    All of above 
(5)    None of these 
224. A file which contains readymade styles that can be used 
for presentations is called 
(1)    Auto style (2)    Template      
(3)   Wizard (4)    Pre-formatting 
(5)    None of these 
225. Which key deletes text before, or the left of, the 
insertion point?  
(1)    Backspace   (2)   Page up 
(3)    Delete (4)    Page down 
(5)    None of these 
226. Which of the following is not a transition effect? 
(1)    Blinks diagonal 
(2)    Dissolve 
(3)    Fade through black 
(4)    Blinds vertical 
(5)    None of these 
227. To create a PowerPoint presentation from a template 
(1)    Click File, New, select the presentations tab and 
choose a template 
(2)   Click File, New Template and choose a template 
(3)    Import a presentation template from Power Point's 
template wizard 
(4)   Click Create Template from scratch, 
228. To save a presentation you 
(1)   Click saves on the windows start button 
(2)    press Ctrl + F5 
(3)   Select File, Save from the menu 
(4)   Click the saver button on the formatting toolbar 
(5)   None of these 
229. To change font size of a selected slide title, you? 
(1)    Click the toolbars font dropdown arrow and choose the 
font you prefer 
(2)   Click format, title and choose a font from the font tab 
(3)   Click the toolbar's increase font size button 
(4)   Click title, new font, 
(5)    None of these 
230. To change font size of a selected slide title, you: 
(1)   Click the toolbars Font dropdown arrow and choose the 
font you prefer 
(2)    Click Format, Title and choose a font from the font tab 
(3)   Click the toolbar's Increase Font Size button 
(4)    Click Title, New Font 
(5)    None of these 
231. You can show the shortcut menu during the slide show by 
(1)   Clicking the shortcut button in the formatting toolbar 
(2)   Right clicking the current slide 
(3)   Clicking an icon on the current slide 
(4)    A and b 
(5)    None of these 
232. To insert a new slide in the current presentation, we can 
choose 
(1) Ctrl + M  
(2) Ctrl + N  
(3) Ctrl + 0  
(4) Ctrl + F  
(5) None of these 
233..Microsoft PowerPoint is a  
(1)   Database program 
(2)   Spreadsheet program 
(3)   Presentation program 
(4)   Word processing program 
(5)    None of these 
234. What is the name of the form used to input chart 
values? 
(1)    Datasheet (2)    Microsoft Excel 
(3)    Microsoft graph 
(4)    Auto form 
(5)    None of these 
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235. Right clicking something in PowerPoint 
(1)    Deletes the object 
(2)    Selects the object 
(3)    Opens a shortcut menu listing for the object 
(4)    Nothing he right mouse button for operation 
(5)    None of these 
236. After choosing a predefine template...... option has to be 
Chosen to change a background color 
(1)    Design template 
(2)    Color scheme 
(3)    Animation scheme 
(4)    Color effects 
(5)    None of these 
237. Ellipse Motion is a predefined.... 
(1)    Design template 
(2)    Color scheme 
(3)   Animation scheme 
(4)    None of these 
(5)    None of these 
238. Block arrows, stars and banners, and callouts are all 
examples of 
(1)    Different types of children's building blocks 
(2)   Auto Shape categories 
(3)    Clip art categories located in the Microsoft Clip Gallery 
(4)    More technical terms that I don't understand 
(5)    None of these 
239. We can replace a font on all slides with another font 
using the ....option 
(1)   Tools, Replace Fonts 
(2)   Tools, Fonts 
(3)   Format, Replace Fonts 
(4)    Edit, Fonts 
(5)    None of these 
240. Special effects used to introduce slides in a 
presentation are called 
(1)    Effects 
(2)   Custom animations 
(3)   Transitions 
(4)    Preset animations 
(5)    None of these 
241. PowerPoint can display data from which of the following 
add-in software of MS-Office 
(1)    Equation editor 
(2)    Organization chart 
(3)    Photo album 
(4)    All of these 
(5)    None of these 
242. Which key on the keyboard can be used to view slide 
show  
(1)    Fl   (2)     F2  
(3)    F5           (4)    F10  
(5)    None of these 
243. Which of the following fill effects can you  use for the 
slide background?  
(1)    Gradient      (2)   Texture 
(3)    Picture 
(4)    All of the above 
(5)    None of these 
244. Which of the following statements is not true? 
(1)    Holding down the Shift key while you draw an object 
creates perfect squares, circles and straight lines 
(2)    The text in a text box can't be formatted 
(3)   The drawing toolbar contains tools for drawing shapes, 
lines, arrows, and more 
(4)   Ctrl+ S saves the document 
(5)    None of these 
245. A chart can be put as a part of the presentation using 
(1)    Insert -> Pictures -> Chart 
(2)   Insert -> Chart 
(3)   Edit-> Chart 
(4)    View -> Chart 
(5)   None of these 
 
 

246. The arrangement of elements such as Title and Subtitle 
text, pictures, tables etc. is called 
(1)    Layout 
(2)    Presentation 
(3)    Design          
(4)   Scheme  
(5)    None of these 
247. Which of the following are types of sound files?  
(1)    LOG files     (2)   DAT files 
(3)    WAV files 
(4)    DRV files 
(5)    None of these 
248. Which of the following can you use to add times to the 
slides in a presentation? 
(1)   Microsoft graph 
(2)    Microsoft Table 
(3)    Microsoft Excel 
(4)    Microsoft Word 
(5)   None of these 
249. Which view in PowerPoint can be used to enter speaker 
comments? 
(1)    Normal 
(2)   Slide show 
(3)   Slide sorter 
(4)   Notes page view 
(5)   None of these 
250. The best way to insert a new slide in a presentation is to 
use the 
(1)    Normal view 
(2)    Special view 
(3)   Slide show view 
(4)   Slide sorter view 
(5)    None of these 
251. Which is the best view for getting your thoughts for a 
presentation out on the computer? 
(1)    Outline view 
(2)    Notes page view 
(3)    Slide sorter view 
(4)    Slide view 
(5)    None of these 
252. The boxes that are displayed to indicate that the text, 
pictures or objects are placed in it is called.... 
(1) Placeholder  
(2) Auto text  
(3) Text box  
(4) Word art  
(5) None of these 
253. Which of the following is not a feature of PowerPoint? 
(1)    Printing transparencies 
(2)    Printing the speaker's notes along with slide images 
(3)    Linking a slide transition with a laser pointer 
(4)    Drawing with a pen 
(5)    None of these 
254. Which option can be used to create a new slide show 
with the current slides but presented in a different order 
(1)    Rehearsal 
(2)    Custom slider show 
(3)    Slide show setup 
(4)    Slide show view 
(5)    None of these 
255. Which of the following are actions you can assign to an 
action button or slide object? 
(1)    Run a macro 
(2)    Play a sound 
(3)    Hyper link 
(4)    All of above 
(5)    None of these 
256. Which option in PowerPoint allows to carry slides from 
one computer to another?  
(1)   Save As 
(2)    Save and Go 
(3)    Pack and Go 
(4)    Web and Go 
(5)    None of these 
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257. Power Point presentation is a collection of 
(1)    Slides and Handouts 
(2)    Speaker's notes 
(3)    Outlines 
(4)    All of the above 
(5)    None of these 
258. How can the slide show be repeated continuously? 
(1)    loop continuously until 'Esc' 
(2)    repeat continuously 
(3)    loop more 
(4)    All of the above 
(5)    None of these 
259. From where can we set the timing for each object? 
(1)    slide     show,     custom transition 
(2)    Slide show, Slide transition 
(3)    slide     show,     custom animation 
(4)    view, slide sorter 
(5)    None of these 
260. The arrangement of elements such as Title and subtitle 
text, pictures, tables etc. is called : 
(1)    Layout 
(2)    Presentation 
(3)    Design          
(4)   Scheme  
(5)    None of these 
261. A rile which contains ready-made styles that can be 
used for a presentation is called: 
(1)    AutoStyle 
(2)   Template 
(3)    Wizard 
(4)    Preformatting 
(5)    None of these 
262. After choosing a predefined template, which option has 
to be chosen to change the background color? 
(1)    Design Template 
(2)    Color Scheme 
(3)    Animation Scheme 
(4)    Color Effects 
(5)    None of these 
263. Ellipse Motion is a predefined___  
(1)    Design Template 
(2)   Col or Scheme 
(3)   Animation Scheme 
(4)   All of these 
(5)    None of these 
264. Animation Schemes can be applied to ___ in the 
presentation. 
(1)   All slides 
(2)   Select slides 
(3)   Current Slide 
(4)   All of the above 
(5)   None of these 
265. To insert new slide in the current Presentation, we can 
choose:  
(1)   Ctrl+ M      (2)   Ctrl+ N  
(3)    Ctrl-HD   
(4)   Ctrl+ F  
(5)   None of these 
266. To open the existing presentation, press 
(1) Ctrl + L  (2) Ctrl + N  
(3) Ctrl+ A  (4) Ctrl + 0  
(5) None of these 
267. Slides can have 
(1)   Title, text graphs 
(2)   Drawn objects, shapes 
(3)   Clipart, drawn art, visual 
(4)   any of the above 
268. A Chart can be put as a part of the presentation using 
(1)   lnsert -> Pictures ->Chart 
(2)    lnser t->Chart 
(3)   E.dit->Chart 
(4)   View->Chart 
(5)    None of these 

269. We can replace a font on all slides with another font 
using the option 
(1)    Edit-> Fonts 
(2)    Tools -> Fonts 
(3)    Tools -> Replace Fonts 
(4)    Format -> Replace Fonts 
(5)    None of these 
270. Which key on the keyboard can be used to view Slide 
show?  
(1)    F1  
(2)   F2  
(3)    F5                 
(4)    F10  
(5)    None of these 
271. Which option in PowerPoint allows you to create a 
package of your presentation for showing to another 
computer? 
(1)    Save As 
(2)    Save and Go 
(3)    Pack and Go 
(4)    Web and Go 
(5)    None of these 
272. Which view in Power Point can be used to enter 
Speaker Comments? 
(1)    Normal 
(2)   Slide Show 
(3)    Slide Sorter 
(4)    Notes Page view 
(5)    None of these 
273. Which option can be used to set custom timings for 
slides In a presentation? 
(1)   Slider Timings 
(2)    Slider Timer 
(3)    Rehearsal 
(4)    Slide Show Setup 
(5)    None of these 
274. Which option can be used to create a new slide show 
with the current slides but presented in a different order? 
(1)    Rehearsal 
(2)   Custom Slide show 
(3)    Slide Show Setup 
(4)    Slide Show View 
(5)    None of these 
275. Which of the following is an example for Automatic Text 
formatting? 
(1)    Underlining Hyperlink 
(2)    Adjusting extra space 
(3)    Replacing two-s with a hyphen 
(4)    All of the above 
(5)    None of these 
276. Power Point can display data from which of the 
following add-In software of MS Office? 
(1)    Equation Editor 
(2)    Organization Chart 
(3)    Photo Album 
(4)   All of these 
(5)    None of these 
277. The spelling dialog box can be  involved by choosing 
spelling from ___ menu.  
(1)    Insert  (2)   File  
(3)    Tools          (4)   view  
(5)    None of these 
278.Which key do you press to check spelling?  
(1)    F3   (2)   F5  
(3)    F7                (4)   F9  
(5)    None of these 
279.Which   PowerPoint feature allows the user to create a 
simple presentation without having to spend too much time 
on It? 
(1)   AutoContent Wizard 
(2)   Animation 
(3)   Col or Schemes 
(4)    Chart Wizard 
(5)   None of these 
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280. Which PowerPoint feature adds special effects to 
modify the appearance of the slides and the timing between 
each slide? •< 
(1)   Color Schemes 
(2)   Animation 
(3)   Transition Settings 
(4)    Handouts 
(5)    None of these 
281. Slide sorter of PowerPoint is available on menu.  
(1)    Insert  
(2)   File  
(3)   View             
(4)   Edit  
(5)   None of these 
282. To print the PowerPoint presentation, press 
(1) Ctrl+ T  (2) Ctrl + E  
(3) Ctrl + S  (4) Ctrl + P  
(5) None of these 
283. What Is a slide transition?  
(1)   Overheads   
(2)   Letters 
(3)   A special effect used to introduce a slide in a slide show 
(4)   The way one slide looks 
(5)    None of these 
284. What   does   "apply   design template" do? 
(1) Changes the content of the slide 
(2)   Adds functionality to the slide 
(3)   Changes the look of the slide without changing the 
content 
(4)   None of the above 
285. How can you stop a slide show? 
(1)    Press the right arrow 
(2)   Press Escape 
(3)    Press the left arrow 
(4)    Press the down arrow 
(5)   None of these 
286. What do you do to start the slide show? 
(1)   Click on Go 
(2)   Turn on transition 
(3)   Click on the Slide Show icon 
(4)   All of the above 
(5)   None of these 
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INTERNET 
 
1. All of the following are examples of real security and 
privacy risks EXCEPT: 
(1)   hackers. 
(2)   identity theft. 
(3)   viruses.         
(4)   spam.  
(5)    None of these  
2. The ability to recover and read deleted or damaged files 
from a criminal's  computer   is  an ex-ample of a law 
enforcement spe-cialty called: 
(1)    computer forensics. 
(2)    robotics. 
(3)   simulation. 
(4)    animation. 
(5)    None of these  
3. The difference between people with access to computers 
and the Internet and those without this access is known as 
the: 
(1)    Internet divide. 
(2)    digital divide. 
(3)   Web divide. 
(4)    broadband divide. 
(5)    None of these 
4. Which of the following is a Web browser ? 
(1)    Paint 
(2)    Power Point 
(3)   Word  
(4)   Fire fox  
(5)    All are Web browsers  
5. The Internet allows you to —  
(1)    send electronic mail  
(2)   view Web pages 
(3)   connect to servers 'all around the world 
(4)    None of these 
(5)    All of the above  
6.    Tunk e-mail is also called—  
(1)    spoof  (2)   spam 
(3)    sniffer script 
(4)    spool 
(5)    None of these 
7.    What is the most common way to get a virus in your 
computer's hard disk ? 
(1)    By installing games from their CDROMS 
(2)    By uploading pictures from mobile phones to the 
computer 
(3)    By sending e-mails 
(4)    By opening e-mails 
(5)    None of these 
8.    What is an E-mail attachment? 
(1)    A separate document from another program sent along 
with an E-mail message 
(2)    A receipt sent by the recipient 
(3)    A malicious parasite that feeds off of your messages 
and destroys the contents 
(4)    A list of CC: or BCC: recipients 
(5)    None of these 
9.      Which of the following are all considered advantages of 
e-mail ? 
(1)    Printable, global and expensive 
(2)    Global, convenience and Microsoft owned 
(3)   Convenience, speed of delivery, generality and reliability 
(4)    Slow delivery, reliable, global and inexpensive 
(5)    None of these 
10. What is an E-mail attachment? 
(1)    A separate document from another program sent along 
with an E-mail message 
(2)    A receipt sent by the recipient 
(3)    A malicious parasite that feeds off of your messages 
and destroys the contents 
(4)    A list of CC : or BCC : recipients 
(5)    None of these 

11.   Sending an E-mail is similar to 
(1)    drawing a picture 
(2)    writing a letter 
(3)    talking on the phone 
(4)    sending a package 
(5)    None of these 
12.  The __ also called the Web, contains billions of 
documents. 
(1)   Web Portal 
(2)    HTFP 
(3)   World Wide Web 
(4)    Domain 
(5)   None of these  
13. Choose the web-browser among the following: 
(1)   MSN messenger 
(2)   Yahoo messenger 
(3)   Rediffbal. net 
(4)   None of these 
(5)   Netscape Navigator  
14. The __ shows all the Web sites and pages that you have 
visited over a period of time.  
(1)   status bar    (2)   task bar 
(3)   tool bar 
(4)    history list 
(5)   None of these 
15.  In the URL http:/www.prenhall.com, the portion labelled 
http is the___ 
(1)   domain name 
(2)   host  
(3)   protocol 
(4)   top-level domain 
(5)    None of these 
16. A repair for a known software bug, usually available at no 
charge on the internet, is called a(n)_ 
(1)   version        (2)   tutorial  
(3)    patch   
(4)   FAQ (5)   None of these  
17. A Web site address is a unique name that identifies a 
specific _ on the Web. 
(1)   Web browser 
(2)   PDA 
(3)    Link 
(4)   Web site 
(5)   None of these 
18. A word in a web page that, when clicked,      opens     
another document is called —  
(1)    hyperlink       
(2)   anchor  
(3)    reference      
(4)   URL  
(5)    None of these  
19. When sending an e-mail, the _ line describes the 
contents of the message. 
(1)   to 
(2)    None of these 
(3)   contents      (4)   CC 
(5)    subject 
20. Which of the following is an example of connectivity ?  
(1)   floppy disk    
(2)   Internet  
(3)    power cord  
(4)   data  
(5)    None of these  
21. The process of connecting to the Internet account is 
(1)    SIGN IN 
(2)    LOG OUT 
(3)    LOG IN 
(4)    SIGN OUT 
(5)    None of these 
22. A commonly used graphic format for the web is 
(1)    Imp  (2)   bmp  
(3)    text              (4)   GIF  
(5)    TIP  
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23. The HTML code written in a text editor to make web-
pages, 
(1)    HTML coding tags 
(2)   source element 
(3)   Source code 
(4)   Tags 
(5)   None of these 
24. If you receive an e-mail from someone you don't know, 
what should you do? 
(1)    Delete it without opening it 
(2)    Forward it to the police immediately 
(3)  Open it and respond to them saying you don't know them 
(4)    Reply and ask them for their personal information 
(5)    Reply and tell them you want to keep in touch with them 
25. __ is collection of web-pages and __ is the very first page 
that we see on opening of a website. 
(1)    Home-page, Webpage 
(2)   Webpage-, Home-page 
(3)   Web-site, Home-page 
(4)   Webpage, Web-site 
(5)    None of these 
26.  When we run a program in HTML coding, _ is used as 
backend and __works as frontend. 
(1)    Notepad - Msn-messenger 
(2)    Notepad-1 nternet Ex-plorer 
(3)    MS-word - Internet -Explorer 
(4)    Both (1) and (2) 
(5)    None of these 
27.  One advantage of dial-up Internet access is 
(1)    it   utilizes   broadband technology 
(2)    None of these 
(3)    it uses a router for security 
(4)    modem speeds are very fast 
(5)    it utilizes existing telephone service 
28. What is the term for unsolicited e-mail ? 
(1)    newsgroup   (2)   Usenet  
(3)    backbone     (4)   spam  
(5)   flaming 
29. The code for a Web page is written using —— 
(1)    a fifth generation language 
(2)    Hypertext Markup Language 
(3)    Win Zip         
(4)   Perl  (5)    URL  
30.  Small application programs that run on a Web page and 
may ensure a form is completed properly or provide ani-
mation are known as ——  
(1)    spiders         (2)   flash  
(3)    cookies         
(4)   applets  
(5)    sparks  
31. When the pointer is positioned on a ——, it is shaped like 
a hand. 
(1)    hyperlink 
(2)   grammar error 
(3)    screen tip 
(4)    spelling error 
(5)   formatting error  
32.  Internet is 
(1)    a local computer network 
(2)    a world wide network of computers 
(3)    a world wide interconnected network of computers 
which use a common protocol to communicate with one 
another 
(4)    an interconnected network of computers 
(5)    None of these 
33. Which facilities is available in the internet are  
(i)   electronic mail  
(ii)  remote login  
(iii) file transfer (iv)Word processing 
(1)   i,ii 
(2)   ii, iii and iv 
(3)   i.ii.iv  
(4)   i, ii.iii  
(5)   None of these 

34.  Internet requires 
(1) an international agreement to connect computers 
(2) a commonly agreed'set of rules to communicate between 
computers 
(3)    a local area network 
(4)    a World Wide Web 
(5)    None of these 
35.  Each computer connected to the internet must 
(1)    be an IBM PC 
(2)    be internet compatible 
(3)    have a unique IP address 
(4)    have a modem connection 
(5)    None of these 
36.  IP address is currently 
(1)    None of these 
(2)    available in plenty 
(3)    6 bytes long 
(4)    not assigned as it is all used up 
(5)    4 bytes long 
37.  IP addresses are converted to 
(1)    a binary string 
(2)    a hierarchy of domain names 
(3)    alphanumeric string 
(4)    a hexadecimal string 
(5)    None of these 
38.  Internet addresses must always  
(i)     a    country    name    or organization type  
(ii)    internet service provider's name 
(iii)    name of organization  
(iv)   name of individual  
(v)    type of organization  
(1)    i,iii  
(2)   ii, iii, iv 
(3)    i, ii.iii 
(4)    ii, iii, iv, v 
(5)    None of these 
39.  Internet uses 
(1)   Telex switching 
(2)    Circuit switching 
(3)   Telephone switching 
(4)    Packet switching   
(5)    None of these 
40.  Internet data is broken up as 
(1)    fixed length packets 
(2)    None of these 
(3)    not packetized 
(4)    64 bytes packets 
(5)    variable length packets 
41.  Internet packet data structure consists of  
(i)     source address  
(ii)    destination address  
(iii)    serial number of packets  
(iv)   message bytes  
(v)    Control   bits   for   error checking  
(vi)    Path identification bits 
(1)    i, ii.iii 
(2)    i, Ii, iii, iv 
(3)    i, ii, iii, iv, v, vi 
(4)    i, ii, iii, iv, v 
(5)    None of these 
42.  The packets of an internet message 
(1)   take a predetermined path 
(2)    go along different paths based on path availability 
(3)    take a path based on packet priority 
(4)    take the shortest path from source to destination 
(5)    None of these 
43.  By an intranet we mean 
(1)    a network connecting al! computers of an organi-ation 
and using the internet protocol 
(2)    a Wide Area Network connecting all branches of an 
organization 
(3)    a corporate computer net work 
(4)    a LAN of an organization 
(5)    None of these 
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44.  By an extranet we mean 
(1)   an extra fast computer network 
(2)    an extra network used by an organization for higher 
reliability 
(3)   the intranels of two co operating organizations 
interconnected via a secure leased line 
(4)   an extra conventation to crating organization 
(5)    None of these 
45. World Wide Web 
(1)    is another name for internet 
(2)    world wide qonnection for computers 
(3)   a collection of world wide information 
(4)   a collection of linked information residing on computers 
connected by the internet 
(5)   None of these 
46. Among services available on the World Wide Web are  
(i)     Encryption    
(ii)    HTTP  
(iii)   HTML  
(iv)   Firewalls 
(1)   ii and iii          (2)   I and ii  
(3)    iii and iv       (4)   I and iv  
(5)   None of these 
47. A world wide web contains web pages 
(1)   presiding in many computers 
(2)    created using HTML 
(3)    residing in many computers linked together using HTML 
(4)   with links to other web pages 
(5)   None of these 
48. A web page is located using a 
(1)   Uniform Resource Locator 
(2)   Universal Record Linking 
(3)   Universal Record Locator 
(4)    Uniformly Reachable Links 
(5)   None of these 
49. A URL specifies the following :  
(i)     protocol used  
(ii)    domain name of server hosting web page  
(iii)   name   of   folder   with required information  
(iv)   name     of     document formatted using HTML  
(v)    the name of 1SP  
(1)    i, ii, iii, v         
(2)   ii, iii, iv, v  
(3)    i, iii, iv  
(4)   i, ii, iii, iv  
(5)    None of these 
50. A search engine is a program to search 
(1)   for information 
(2)   web pages 
(3)   web pages for Information using specified search terms 
(4)   web pages for specified in-dex terms 
(5)    None of these 
51.  HTML stands for 
(1)   Hyper Text Markup Lan - guage 
(2)    Hyper Text Making Links 
(3)    Higher Textual Marking of Links 
(4)    Hyper Text Mixer of Links 
(5)    None of these 
52.  HTML is similar to a 
(1)   screen editor  (2)   scripting language 
(3)    search engine 
(4)    None pf these 
(5)    word processing language 
53.  Desirable properties of a website are 
(i)     a meaningful address  
(ii)    Help and search facilities  
(iii)   Links to related sites  
(iv)   Features to allow users to give feedback  
(v)    Hosting on a mainframe 
(1)    i, ii, iii 
(2)   i, ii, iii, iv, v 
(3)    i, ii, iii, iv       
(4)   i, ii, iii, v  
(5)   None of these 

54.  HTML uses 
(1)   Fixed tags defined by the language 
(2)    User defined tags 
(3)    Tags only for linking 
(4)    Pre-specified tags 
(5)    None of these 
55.  HTML tags define 
(1)    The data types of elements of document 
(2)    The   contents   of   the document 
(3)    Presentation of specified elements of a document 
(4)    The   structure   of   the document 
(5)    None of these 
56.  SGML stands for 
(1)    Standard General Markup Unit 
(2)    Structured General Markup Language 
(3)    Standard Graphics Mapping Language 
(4)    Standard   Generalized Markup Language 
(5)    None of these 
57.  HTML and XML are markup languages 
(1)    Specially development for the web 
(2)   Are versions of SGML 
(3)    Are based on SGML 
(4)    Independent of SGML 
(5)    None of these 
58.  XML stands for 
(1)    Extended Markup Language 
(2)    Excellent Markup Links 
(3)    Extra Markup Language 
(4)    Extended Marking Links 
(5)    None of these 
59.  XML uses 
(1)    Both predefined and user defined tags 
(2)    pre-defined tags 
(3)    user define tags 
(4)    Extended tags used in HTML and makes them powerful 
(5)    None of these 
60.   In   order  to   interpret  XML documents one should  
(1)    Use standardized tags 
(2)   Specify tag filename 
(3)   Define the tags separately 
(4)   Have a document type definition which defines the tags 
(5)    None of these 
61. The advantages of XML over HTML are 
(i).    It allows processing of data slored in web pages 
(ii)    It uses meaningful tags which aids in understanding the 
nature of a document 
(iii)   Is simpler than HTML 
(iv)   It separates presentation and structure of document 
(1)   (i),(ii)and(iy) 
(3)    (ii).(iii) and (iv) 
(4)   (i).(iii) and (iv) 
(5)    None of these 
62. XSL definition is used along with XML definition to 
specify 
(1)   The data types of the contents of XML document 
(2)   The   links   with   other 
documents 
(3)    The presentation of XML document 
(4)    The  juncture   of   XML document 
(5)    None of these 
63. XLL definition is used along with XML to specify 
(1)   The data types of the contents of XML document. 
(2)   The   links   with   other documents 
(3)   The presentation of XML document 
(4)    The  structure  of  XML document 
(5)    None of these 
64.  DTD definition is used along with XML to specify 
(1 )   The presentation of XML document 
(2)   The   links   with   other documents 
(3)    The structure of XML document 
(4)   The data types of the con- 
(5)  tents of XML document None of these 
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PRACTICE QUESTIONS SET 1 
1. One megabyte equals approximately 
1) 1,000 bits 
2) 1,000 bytes 
3) 1 million bytes 
4) 1 million bits 
5) 2,000 bytes 
2. Data going into the computer is called? 
1) Output 2) Algorithm 
3) Input 
4) Calculations 
5) Flowchart 
3. Which of the following refers to the memory in your 
computer? 
1) RAM  2) DSL 
3) USB 
4) LAN 
5) CPU 
4. When you are working on a document on PC, where is the 
Document temporarily stored? 
1) RAM  2) ROM 
3) The CPU 
4) Flash memory 
5) The CD-Rom 
5. Information travels between components on the mother 
board through- 
1) Flash memory 
2) CMOS 3) Bays 
4) Buses 
5) Peripherals 
6. How are data organized in a spreadsheet? 
1) Lines and spaces 
2) Layers and planes 
3) Height and width 
4) Rows and columns 
5) None of these 
7. Which of the following is true? 
1) Byte is a single digit in a binary number 
2) Bit represents a grouping of digital numbers 
3) Eight-digit binary number is called a byte 
4) Eight-digit binary number is called a bit 
5) None of these 
8. Transformation of input into output is performed by? 
1) Peripherals 
2) Memory 
3) Storage 
4) The Input-Output unit 
5) The CPU 
9. How many options does a binary choice offer? 
1) None 
2) One 
3) Two 
4) It depends on the amount of memory in the computer 
5) It depends on the speed of the computer's processor 
10. .....is collection of web pages and ......is the very first 
page that we see on opening of a web-site 
1) Home-page, Web-page 
2) Web-site, Home-page 
3) Web-page, Home-page 
4) Web-page, Web-site 
5) None of these 
11. When the pointer is positioned on a _____ it is shaped 
like a hand. 
1) Grammar error 
2) Hyperlink 
3) Screen tip 
4) Spelling error 
5) Formatting error 
12. The _____ of a system includes the programs or 
instructions. 
1) Hardware 2) Icon 
3) Information 
4) Software 
5) None of these 

13. 'www' stands for _____ 
1) World Word Web 
2) World Wide Web 
3) World White Web 
4) World Work Web 
5) None of these 
14. What menu is selected to cut, copy, and paste? 
1) File 
2) Tools 
3) Special 
4) Edit 
5) None 
15. You can use the tab key to 
1) Move a cursor across the screen 
2) Indent a paragraph 
3) Move the cursor down the screen 
4) Only (1) and (2) 
5) None of these 
16. The most important or powerful computer in a typical 
network is _____ 
1) Desktop 
2) Network client 
3) Network server 
4) Network station 
5) None of these 
17. Which of the following is an example of connectivity? 
1) Internet 
2) Floppy disk 
3) Power cord 
4) Data 
5) None of these 
18. The ability to find an individual item in a file immediately 
_____ is used. 
1) File allocation table 
2) Directory 
3) Sequential access 
4) Direct access 
5) None of these 
19. The primary purpose of software is to turn data into____ 
1) Web sites 
2) Information 
3) Programs 
4) Objects 
5) None of these 
20. To what temporary area can you store text and other 
data, and later paste them to another location? 
1) The clipboard 
2) ROM 
3) CD-ROM 
4) The hard disk 
5) None of these 
21. Storage that retains its data after the power is tuned off is 
referred to as 
1) volatile storage 
2) non-volatile storage 
3) sequential storage 
4) direct storage 
5) None of these 
22. _____is the science that attempts to produce machines 
that display the same type of intelligence that humans do. 
1) Nano science 
2) Nanotechnology 
3) Simulation 
4) Artificial intelligence (AI) 
5) None of these 
23. Changing an existing document is called _____ the 
document. 
1) Creating 
2) Editing 
3) Modifying 
4) Adjusting 
5) None of these 
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24. Computers use the _____ number system to store data 
and perform calculations. 
1) Decimal 
2) Hexadecimal 
3) Octal 
4) Binary 
5) None of these 
25. Which of the following is the largest unit of storage? 
1) GB 
2) KB 
3) MB 
4) TB 
5) None of these 
26. The _____ key will launch the start buttons. 
1) Esc 
2) Shift 
3) Windows 
4) Shortcut 
5) None of these 
27. _____is the process of finding errors in software code. 
1) Compiling 
2) Testing 
3) Running 
4) Debugging 
5) None of these 
28. To move to the beginning of a line of text, press the 
_____ key. 
1) Home 
2) A 
3) Page-up 
4) Enter 
5) None of these 
29. Virtual memory is 
1) Memory on the hard disk that the CPU uses as an 
extended RAM 
2) RAM 
3) Only necessary if you do not have any RAM in your 
computer 
4) A back up device for floppy disks 
5) None of these 
30. A _____ contains specific rules and words that express 
the logical steps of an algorithm. 
1) Syntax 
2) Programming structure 
3) Programming language 
4) Logic chart 
5) None of these 
31. When sending an e-mail, the _____ line describes the 
contents of the message. 
1) to 
2) subject 
3) contents 
4) CC 
5) None of these 
32. The _____ tells the computer how to use its components. 
1) Utility 
2) Network 
3) Operating system 
4) Application program 
5) None of these 
33. Which grouping do you work with when formatting text in 
word? 
1) Tables, paragraphs and indexes 
2) Paragraphs, indexes and sections 
3) Characters, sections and paragraphs 
4) Indexes, characters and tables 
5) None of these 
34. What is backup? 
1) Adding more components to your network 
2) Protecting data by copying it from the original source to a 
different destination 
3) Filtering old data from the new data 
4) Accessing data on tape 
5) None of these 

35. Network components are connected to the same cable in 
the_____ topology. 
1) Star 
2) Ring 
3) Bus 
4) Mesh 
5) Mixed 
36. This component is required to process data into 
information and consists of integrated circuits. 
1) Hard disk 
2) RAM 
3) CPU 
4) ROM 
5) None of these 
37. One advantage of dial-up-internet access is ___ 
1) It utilises broadband technology 
2) It utilizes existing telephone service 
3) It uses a router for security 
4) Modem speeds are very fast 
5) None of these 
38. What is the term for unsolicited e-mail? 
1) News group 
2) Use net 
3) Backbone 
4) Flaming 
5) Spam 
39. Two or more computers connected to each other of 
sharing information form a _____ 
1) Network 
2) Router 
3) Server 
4) Tunnel 
5) Pipeline 
40. Computers that are portable and convenient for users 
who travel are known as _____ 
1) Super computers 
2) Lap tops 
3) Mini computers 
4) File servers 
5) None of these 
41. A computer checks the _____ of user names and 
passwords for a match before granting access. 
1) Website 
2) Network 
3) Backup file 
4) Data base 
5) None of these 
42. Office LANs that are spread geographically apart on a 
large scale can be connected using a corporate _____ 
1) CAN 2) LAN 
3) DAN 
4) WAN 
5) TAN 
43. The code for a Web page is written using _____ 
1) A fifth generation language 
2) Win Zip 
3) Peripherals 
4) Hypertext Markup Language 
5) URL 
44. What is the process of copying software programs from 
secondary storage media to the hard disk called? 
1) Configuration 
2) Download 
3) Storage 
4) Upload 
5) Installation 
45. Small application programs that run on a web page and 
may ensure a form is completed properly or provide 
animation are known as _____ 
1) Flash 
2) Spiders 
3) Cookies 
4) Applets 
5) Sparks 
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46. The first computers were programmed using _____ 
1) Assembly language 
2) Machine language 
3) Source code 
4) Object code 
5) Spaghetti code 
47. Which process checks to ensure the components of the 
computer and operating are connected properly? 
1) Booting 
2) Processing 
3) Saving 
4) Editing 
5) None of these 
48. In a relational database, this is a data structure that 
organizes the information about a single topic into rows and 
columns. 
1) Block 
2) Record 
3) Tuple 
4) Table 
5) Command line interface 
49. How can the user determine what programs are available 
on a computer? 
1) Checking the hard disk properties 
2) Viewing the installed programs during the booting process 
3) Checking the operating system for a list of installed 
programs. 
4) Checking the existing files saved on the disk 
5) None of these 
50. When we run a program in HTML coding _____ is used 
as backend and ____ works as front-end. 
1) Notepad - Internet-Explorer 
2) Notepad - Msn-messenger 
3) MS-Word - Internet Explorer 
4) Both (1) and (2) 
5) None of these 
ANSWERS: 
1)3 2)3 3)1 4)1 5)4 6)3 7)3 8)5 9)3 10)2 11)2 12)4 13)2 14)4 
15)2 16)3 17)1 18)1 19)2 20)1 21)2 22)4 23)2 24)4 25)4 26)3 
27)4 28)1 29)2 30)3 31)2 32)3 33)1 34)2 35)2 36)3 37)2 38)5 
39)1 40)2 41)4 42)4 43)4 44)5 45)4 46)2 47)1 48)4 49)4 50)1 
 

PRACTICE QUESTIONS SET 2 
1. What type of network connection is NOT a way of 
connecting to the Internet? 
a. TCP/IP b. Dial-up 
c. ISDN 
d. T1 
e. T3 
2. Which of the following is the correct syntax for a URL? 
a. john@xyz.com 
b. c:\windows 
c. index.html 
d. aol.com 
e. All of the Above. 
3. A ―High Resolution‖ computer monitor will have: 
a. High dpi, e.g. .31 dpi 
b. Low dpi, e.g. .26 dpi 
c. 256 colors 
d. Resolution isn’t measured in dpi or colors 
e. The same resolution as your printer. 
4. Computer Memory is normally measured in: 
a. Kilobytes 
b. Megabytes 
c. Gigabytes 
d. Terabytes 
e. None of the Above 
5. In Microsoft Excel, which of the following formulas is 
incorrect? 
a. =SUM(A1,B1,B2,C2) 
b. =ROUND(SUM(A1:C2),2) 
c. =ROUND(A1:C2,2) 
d. =SUM(ROUND(A1:B1,B2:C2)) 
e. All of the Above 

6. A world wide web contains web pages 
a. residing in many computers 
b. created using HTML 
c. with links to other web pages 
d. residing in many computers linked together using HTML 
7. By an intranet we mean 
a. a LAN of an organization 
b. a Wide Area Network connecting all branches of an 
organization 
c. a corporate computer network 
d. a network connecting all computers of an organization and 
using the internet protocol 
8. Internet uses 
a. Packet switching 
b. Circuit switching 
c. Telephone switching 
d. Telex switching 
9. Internet is 
a. a local computer network 
b. a world wide network of computers 
c. an interconnected network of computers 
d. a world wide interconnected network of computers which 
use a common protocol to communicate with one another 
10. ____________ is a set of computer programs used on a 
computer to help perform tasks. 
A. An instruction 
B. Software 
C. Memory 
D. A processor 
11. System software is the set of programs that enables your 
computer’s hardware devices and ____________ software to 
work together. 
A. management 
B. processing 
C. utility 
D. application 
12. The PC (personal computer) and the Apple Macintosh 
are examples of two different: 
A. platforms. 
B. applications. 
C. programs. 
D. storage devices. 
13. Apple Macintoshes (Macs) and PCs use different______ 
to process data and different operating systems. 
A. languages 
B. methods 
C. CPUs 
D. storage devices 
14. Servers are computers that provide resources to other 
computers connected to a: 
A. network. 
B. mainframe. 
C. supercomputer. 
D. client. 
15. Smaller and less expensive PC-based servers are 
replacing ____________ in many businesses. 
A. supercomputers 
B. clients 
C. laptops 
D. mainframes 
16. DSL is an example of a(n) ____________ connection. 
A. network 
B. wireless 
C. slow 
D. broadband 
17. The difference between people with access to computers 
and the Internet and those without this access is known as 
the 
A. digital divide. 
B. Internet divide. 
C. Web divide. 
D. broadband divide. 
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18.____________ is the science revolving around the use of 
nanostructures to build devices on an extremely small scale. 
A. Nanotechnology 
B. Micro-technology 
C. Computer forensics 
D. Artificial intelligence 
19. Word processing, spreadsheet, and photo-editing are 
examples of: 
A. application software. 
B. system software. 
C. operating system software. 
D. platform software. 
20. Which of the following is NOT a necessary characteristic 
of computer fluency? 
A. Understanding the capabilities and limitations of 
computers 
B. Being able to write computer programs 
C. Becoming comfortable with the use of computers 
D. Understanding the legal, ethical, and societal implications 
of computing 
21. According to the U.S. Department of Labor, 
approximately ____________ % of American workers used 
computers on the job as of 2001. 
A. 20 
B. 40 
C. 50 
D. 70 
22. Retail employees typically use ____________ terminals 
to process sales transactions. 
A. sales processing 
B. transaction point 
C. automatic teller 
D. point of sale 
23. The process of ____________ involves automated study 
of consumer buying patterns in order to support marketing, 
inventory replenishment, and pricing decisions. 
A. transaction processing 
B. data mining 
C. simulation 
D. information processing 
24. The engineering discipline that involves construction of 
molecularly-sized computing devices is called: 
A. nanotechnology. 
B. molecular processing. 
C. silicon grafting. 
D. nanoscience. 
25. The prefix that stands for â•œbillionthâ•• is: 
A. giga.   B. tera.  
C. nano.  D. peta. 
26. A small biomedical device currently on the market that 
can be implanted underneath the skin for identification 
purposes is called the: 
A. Identitron. 
B. Verichip. 
C. Digicard. 
D. Nanoguard. 
27. The four main functions of a computer are: 
A. input, processing, output, and storage. 
B. learning, thinking, intelligence, and virtuosity. 
C. data, information, bits, and bytes. 
D. hardware, software, modeling, and operations. 
28. The primary purpose of a computer is to process 
_____________ and convert it into information. 
A. electricity 
B. data 
C. raw material 
D. a bit 
29. Bit refers to a: 
A. computer language. 
B. CPU instruction. 
C. 0 or 1 value. 
D. digital representation of an alphabetic character. 
 
 

30. There are ____________ bits in a byte. 
A. two  B. four 
C. six  D. eight 
31. In computer language, each letter, number, and an array 
of special characters consists of: 
A. 8 kilobytes. 
B. 8 bytes. 
C. a bit. 
D. 8 bits. 
32. Which of the following is the correct sequence of smallest 
to largest unit of storage size? 
A. megabyte ? terabyte ? gigabyte ? kilobyte ? petabyte 
B. kilobyte ? megabyte ? gigabyte ? terabyte ? petabyte 
C. kilobyte ? megabyte ? gigabyte ? petabyte ? terabyte 
D. kilobyte ? megabyte ? petabyte ? terabyte ? gigabyte 
33. The prefix kilo refers to approximately: 
A. one thousand. 
B. one million. 
C. one hundred. 
D. one billion. 
34. Computers work in: 
A. machine linguistics. 
B. binary language. 
C. HTML code. 
D. bit language. 
35. The metal or plastic case that houses the physical 
components of a computer together is called the: 
A. central processing unit . 
B. storage device. 
C. motherboard. 
D. system unit. 
36. The brains of the computer which executes the 
instructions, is called the: 
A. CPU. 
B. RAM. 
C. motherboard. 
D. system unit. 
37. Instructions and data that are about to be processed by 
the CPU are located in: 
A. a CD-ROM. 
B. RAM. 
C. the hard disk. 
D. the motherboard. 
38. The circuitry that includes the CPU and memory chips is 
located on the: 
A. system unit. 
B. operating system. 
C. motherboard. 
D. computer platform. 
39. All of the following are considered to be storage devices 
EXCEPTa:  
A. floppy disk. 
B. CPU. 
C. CD. 
D. hard disk drive. 
40. What is the correct association between a hardware 
component and a computer function? 
A. Monitor ? input 
B. Mouse ? input 
C. CPU ? storage 
D. Hard disk ? processing 
41. The main difference between application and system 
software is 
that: 
A. application software is composed of program instructions 
but 
system software is not. 
B. application software is stored in memory whereas system 
software is only in the CPU. 
C. system software is unnecessary whereas application 
software 
must be present on the computer. 
D. system software manages hardware whereas application 
software performs user tasks. 
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42. A document created in a word processing program or a 
budget created in a spreadsheet are both examples of 
documents created in: 
A. application software. 
B. system software. 
C. an operating system. 
D. a Windows platform. 
43. Which of the following is an example of system software? 
A. Word processor 
B. Operating system 
C. Management information system 
D. Spreadsheet 
44. The term that refers to computers that provide resources 
to other computers in a network is: 
A. server. 
B. mainframe. 
C. platform. 
D. resource provider. 
45. If a large business is going to use a single computer to 
execute many programs for hundreds of users at the same 
time, performing relatively simple operations and 
transactions, the type of computer will probably be a 
A. Supercomputer 
B. PC 
C. Mainframe 
D. ISP 
 
 
IBPS CWE COMPUTER KNOWLEDGE MODEL PAPER 
1. One megabyte equals approximately 
1) 1,000 bits 
2) 1,000 bytes 
3) 1 million bytes 
4) 1 million bits 
5) 2,000 bytes 
2. Data going into the computer is called? 
1) Output 
2) Algorithm 
3) Input 
4) Calculations 
5) Flowchart 
3. Which of the following refers to the memory in your 
computer? 
1) RAM 
2) DSL 
3) USB 
4) LAN 
5) CPU 
4. When you are working on a document on PC, where is the 
document temporarily stored? 
1) RAM 
2) ROM 
3) The CPU 
4) Flash memory 
5) The CD-Rom 
5. Information travels between components on the mother 
board through- 
1) Flash memory 
2) CMOS 
3)Bays 
4) Buses 
5) Peripherals 
6. How are data organised in a spreadsheet? 
1) Lines and spaces 
2) Layers and planes 
3) Height and width 
4) Rows and columns 
5) None of these 
7. Which of the following is true? 
1) Byte is a single digit in a binary number 
2) Bit represents a grouping of digital numbers 
3) Eight-digit binary number is called a byte 
4) Eight-digit binary number is called a bit 
5) None of these 

8. Transformation of input into output is performed by? 
1) Peripherals 
2) Memory 
3) Storage 
4) The Input-Output unit 
5) The CPU 
9. How many options does a binary choice offer? 
1) None 
2) One 
3) Two 
4) It depends on the amount of memory in the computer 
5) It depends on the speed of the computer's processor 
10. .....is collection of web pages and ......is the very first 
page that we see on opening of a web-site 
1) Home-page, Web-page 
2) Web-site, Home-page 
3) Web-page, Home-page 
4) Web-page, Web-site 
5) None of these 
11. When the pointer is positioned on a _____ it is shaped 
like a hand. 
1) Grammar error 
2) Hyperlink 
3) Screen tip 
4) Spelling error 
5) Formatting error 
12. The _____ of a system includes the programs or 
instructions. 
1) Hardware 
2) Icon 
3) Information 
4) Software 
5) None of these 
13. 'www' stands for _____ 
1) World Word Web 
2) World Wide Web 
3) World White Web 
4) World Work Web 
5) None of these 
14. What menu is selected to cut, copy, and paste? 
1) File 
2) Tools 
3) Special 
4) Edit 
5) None 
15. You can use the tab key to 
1) Move a cursor across the screen 
2) Indent a paragraph 
3) Move the cursor down the screen 
4) Only (1) and (2) 
5) None of these 
16. The most important or powerful computer in a typical 
network is 
_____ 
1) Desktop 
2) Network client 
3) Network server 
4) Network station 
5) None of these 
17. Which of the following is an example of connectivity? 
1) Internet 
2) Floppy disk 
3) Power cord 
4) Data 
5) None of these 
18. The ability to find an individual item in a file immediately 
_____ is used. 
1) File allocation table 
2) Directory 
3) Sequential access 
4) Direct access 
5) None of these 
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19. The primary purpose of software is to turn data into 
_____ 
1) Web sites 
2) Information 
3) Programs 
4) Objects 
5) None of these 
20. To what temporary area can you store text and other 
data, and later paste them to another location? 
1) The clipboard  2) ROM 
3) CD-ROM 
4) The hard disk 
5) None of these 
21. Storage that retains its data after the power is tuned off is 
referred to as 
1) volatile storage 
2) non-volatile storage 
3) sequential storage 
4) direct storage 
5) None of these 
22. _____is the science that attempts to produce machines 
that display the same type of intelligence that humans do. 
1) Nano science 
2) Nanotechnology 
3) Simulation 
4) Artificial intelligence (AI) 
5) None of these 
23. Changing an existing document is called _____ the 
document. 
1) Creating 
2) Editing 
3) Modifying 
4) Adjusting 
5) None of these 
24. Computers use the _____ number system to store data 
and perform calculations. 
1) Decimal 
2) Hexadecimal 
3) Octal 
4) Binary 
5) None of these 
25. Which of the following is the largest unit of storage? 
1) GB 
2) KB 
3) MB 
4) TB 
5) None of these 
26. The _____ key will launch the start buttons. 
1) Esc 
2) Shift 
3) Windows 
4) Shortcut 
5) None of these 
27. _____is the process of finding errors in software code. 
1) Compiling 
2) Testing 
3) Running 
4) Debugging 
5) None of these 
28. To move to the beginning of a line of text, press the 
_____ key. 
1) Home 
2) A 
3) Page-up 
4) Enter 
5) None of these 
29. Virtual memory is 
1) Memory on the hard disk that the CPU uses as an 
extended RAM 
2) RAM 
3) Only necessary if you do not have any RAM in your 
computer 
4) A back up device for floppy disks 
5) None of these 

30. A _____ contains specific rules and words that express 
the logical steps of an algorithm. 
1) Syntax 
2) Programming structure 
3) Programming language 
4) Logic chart 
5) None of these 
31. When sending an e-mail, the _____ line describes the 
contents of the message. 
1) to 
2) subject 
3) contents 
4) CC 
5) None of these 
32. The _____ tells the computer how to use its components. 
1) Utility 
2) Network 
3) Operating system 
4) Application program 
5) None of these 
33. Which grouping do you work with when formatting text in 
word? 
1) Tables, paragraphs and indexes 
2) Paragraphs, indexes and sections 
3) Characters, sections and paragraphs 
4) Indexes, characters and tables 
5) None of these 
34. What is backup? 
1) Adding more components to your network 
2) Protecting data by copying it from the original source to a 
different destination 
3) Filtering old data from the new data 
4) Accessing data on tape 
5) None of these 
35. Network components are connected to the same cable in 
the _____ topology. 
1) Star 
2) Ring 
3) Bus 
4) Mesh 
5) Mixed 
36. This component is required to process data into 
information and consists of integrated circuits. 
1) Hard disk 
2) RAM 
3) CPU 
4) ROM 
5) None of these 
37. One advantage of dial-up-internet access is ___ 
1) It utilises broadband technology 
2) It utilizes existing telephone service 
3) It uses a router for security 
4) Modem speeds are very fast 
5) None of these 
38. What is the term for unsolicited e-mail? 
1) News group 
2) Use net 
3) Backbone 
4) Flaming 
5) Spam 
39. Two or more computers connected to each other of 
sharing information form a _____ 
1) Network 
2) Router 
3) Server 
4) Tunnel 
5) Pipeline 
40. Computers that are portable and convenient for users 
who travel are known as _____ 
1) Super computers 
2) Lap tops 
3) Mini computers 
4) File servers 
5) None of these 
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41. A computer checks the _____ of user names and 
passwords for a match before granting access. 
1) Website 2) Network 
3) Backup file 
4) Data base 
5) None of these 
42. Office LANs that are spread geographically apart on a 
large scale can be connected using a corporate _____ 
1) CAN  2) LAN 
3) DAN 
4) WAN 
5) TAN 
43. The code for a Web page is written using _____ 
1) A fifth generation language 
2) Win Zip 
3) Peripherals 
4) Hypertext Markup Language 
5) URL 
44. What is the process of copying software programs from 
secondary storage media to the hard disk called? 
1) Configuration 
2) Download 
3) Storage 
4) Upload 
5) Installation 
45. Small application programs that run on a web page and 
may ensure a form is completed properly or provide 
animation are known as _____ 
1) Flash 
2) Spiders 
3) Cookies 
4) Applets 
5) Sparks 
46. The first computers were programmed using _____ 
1) Assembly language 
2) Machine language 
3) Source code 
4) Object code 
5) Spaghetti code 
47. Which process checks to ensure the components of the 
computer and operating are connected properly? 
1) Booting 
2) Processing 
3) Saving 
4) Editing 
5) None of these 
48. In a relational database, this is a data structure that 
organizes the information about a single topic into rows and 
columns. 
1) Block 
2) Record 
3) Tuple 
4) Table 
5) Command line interface 
49. How can the user determine what programs are available 
on a computer? 
1) Checking the hard disk properties 
2) Viewing the installed programs during the booting process 
3) Checking the operating system for a list of installed 
programs. 
4) Checking the existing files saved on the disk 
5) None of these 
50. When we run a program in HTML coding _____ is used 
as backend and ____ works as front-end. 
1) Notepad - Internet-Explorer 
2) Notepad - Msn-messenger 
3) MS-Word - Internet Explorer 
4) Both (1) and (2) 
5) None of these 
ANSWERS: 
1)3 2)3 3)1 4)1 5)4 6)3 7)3 8)5 9)3 10)2 11)2 12)4 13)2 14)4 
15)2 16)3 17)1 18)1 19)2 20)1 21)2 22)4 23)2 24)4 25)4 26)3 
27)4 28)1 29)2 30)3 31)2 32)3 33)1 34)2 35)2 36)3 37)2 38)5 
39)1 40)2 41)4 42)4 43)4 44)5 45)4 46)2 47)1 48)4 49)4 50)1 

PRACTICE QUESTIONS SET 3 
 
1.What is the ultimate purpose of Defragmentation ? 
1) Make the PC faster 
2) Create More Free Space 
3) Delete temporary files 
4) Reduce Power consumption 
5) All of the above 
2.Computers process data into information by working 
exclusively with : 
1) multimedia 
2) words 
3) characters 
4) numbers 
5) None of these 
3.You must install a (n) ......... on a network if you want to 
share a broadband Internet connection 
1) router 
2) modem 
3) node 
4) cable 
5) None of these 
4.The purpose of the primary key in a database is to : 
1) unlock the database 
2) provide a map of the data 
3) uniquely identify a record 
4) establish constraints on database operations 
5) None of these 
5.The design of the network is called the network 
1) architecture 
2) server 
3) transmission 
4) type 
5) None of these 
6.The most frequently used instructions of a computer 
program are 
likely to be fetched from: 
1) the hard disk 
2) cache memory 
3) RAM 
4) registers 
5) None of these 
7.Personal logs or journal entries posted on the Web are 
known as : 
1) listservs 
2) Webcasts 
3) blogs 
4) subject directories 
5) None of these 
8.Which of the following is NOT a type of broad band internet 
connection ? 
1) Cable  2) DSL 
3) Dial-up 
4) Satellite 
5) None of these 
9.Linux is a(n) ........ operating system 
1) open-source 
2) Microsoft 
3) Windows 
4) Mac 
5) None of these 
10.Which of the following places the common data elements 
in order from smallest to largest 
1) character, file, record, field, database 
2) character, record, field, database, file 
3) character, field, record, file, database 
4) Bit, byte, character, record, field, file, database 
5) None of these 
11.The internet is .......... 
1) a large network of networkds 
2) an internal communication system for a business 
3) a communications system for the Indian government 
4) All of these 
5) None of these 
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12.Which of the following statements is FALSE concenring 
file names ? 
1) Files may share the same name or the same extension 
but not both 
2) Every file in the same foldr must have a unique, name 
3) File extension is another name for file type 
4) The file extension comes before the dot (.) followed by the 
file name 
5) None of these 
13.Which of the following would most likely NOT be a 
symptom of a virus ? 
1) Existing program files and icons disappear 
2) The CD-ROM stops functioning 
3) THe Web browser opens to an unusual home page 
4) Odd messages or images are displayed on the screen 
5) None of these 
14.What is a back up ? 
1) Restoring the information backup 
2) An exact copy of a system's information 
3) The ability to get a system u and runnign in the event of a 
system crash or failure 
4) All of these 
5) None of these 
15. ............ are lists of commands that appear on the screen 
1) GUIs  2) Icons 
3) Menus 
4) Windows 
5) None of these 
16.What is the correct association between a hardware 
component and a computer function? 
1) Monitor > input 
2) Mouse > input 
3) CPU > storage 
4) Hard disk > processing 
5) None of these 
17.What is the function of Drop Cap ? 
1) It does not allow capital letters to be used in the 
documents 
2) It makes first letter of each word capital letter in the 
documents 
3) It lets you begin a paragraph witha large dropped initial 
capital letter 
4) In automatically starts all paragraphs and sentences with 
capital letters 
5) None of these 
18.The errors that can be pointed out by the compiler are : 
1) Syntax error 
2) Symantic error 
3) Logical error 
4) Internal error 
5) None of these 
19. The move to the bottom of a document, press ........ 
1) Auto summarize 2) Home key 
3) Ctrl + Home key 
4) End key 
5) Ctrl + End key 
20.By default, your documents print in ..... mode 
1) Landscape 
2) Portrait 
3) Page setup 
4) Print preview 
5) None of these 
21.Select the odd one out : 
1) Interpreter 
2) Operating system 
3) Compiler 
4) Assembler 
5) Programmer 
22.For viewing video CDs, you would use ...... 
1) CD Player 
2) Windows Media Player 
3) WIndows Video Player 
4) WIndows Movie Player 
5) None of these 

23. What's the name for the program or service that lets you 
view e-mail messages ? 
1) Web browser 
2) E-mail clients 
3) E-mail ID 
4) Internet 
5) None of these 
24. What does the SMTP in an SMTP server stand for ? 
1) Simple Mail Transfer Protocol 
2) Serve Message Text Process 
3) Short Messaging Text Process 
4) Short Messaging Transfer Protocol 
5) None of these 
25.What's considered the'backbone’of the World Wide Web? 
1) Uniform resource locator (URL) 
2) Hypertext mark-up language (HTML) 
3) Hypertext transfer protocol (HTTP) 
4) File transfer protocol (FTP) 
5) None of these 
26. We access the World Wide Web using : 
1) Browsers 
2) Instant messaging applications 
3) High bandwidth 
4) Search engine 
5) None of these 
27.The Internet began with the development of 
1) USENET 
2) ARPANET 
3) Ethernet 
4) Intranet 
5) None of these 
28.A wireless network uses .......... waves to transmit signals 
1) mechanical 
2) radio 
3) sound 
4) magnetic 
5) None of these 
29.What device includes an adapter that decodes data sent 
in radio 
signals ? 
1) modem 
2) digital translator 
3) router 
4) switch 
5) None of these 
30.Network components are connected to the same cable in 
the .......... topology 
1) star 
2) ring 
3) bus 
4) mesh 
5) None of these 
31.Small application programs that run on a Web page and 
may ensure a form is completed properly or provide 
animation are known as ...... 
1) flash 
2) spiders 
3) cookies 
4) applets 
5) None of these 
32.Which of the following is Not a characteristic of a 
compluter ? 
1) Intelligence 
2) Speed 
3) Versatility 
4) Automation 
5) None of these 
33.The WWW standard allows programs on many different 
computer platforms to show the information on a server. 
Such programs are called : 
1) ISP 2) Web Browsers 
3) Web Servers 
4) Web Modular 
5) None of these 
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34. Outlook Express is a 
1) E-mail client 
2) Scheduler 
3) Address book 
4) All of the above 
5) None of these 
35.Which of the following is not a network ? 
1) Local Area Network 
2) Wide Area Network 
3) Optical Fibre 
4) All are networks 
5) None of these 
36.Which of the following is Not a characteristic of E-mail ? 
1) Low cost 
2) Record maintenance in database 
3) High speed 
4) Waste reduction 
5) None of these 
37. ........... is the science that attempts to produce machines 
that display the same type of intelligence that humans do 
1) nanoscience 
2) Nanotechnology 
3) Simulation 
4) Artificial intelligence 
5) None of these 
38.Who designed the first electronic computer - ENIAC ? 
1) Van Neuman 
2) Joseph M Jacquard 
3) J presper Eckert and John W mauchly 
4) Both 1 and 2 
5) None of these 
39............. is a collection of web - pages and .......... is the 
very first page that we see on opening of a website 
1) Home page, Web page 
2) Website, Home page 
3) Web page, Home page 
4) Web page, Website 
5) None of these 
40.When we run progra in HTML coding, ......... is used as 
back-end and ........... works as front-end 
1) Notepad, Internet Explorer 
2) Notepad, MSN messenger 
3) MS Word, Internet Explorer 
4) Both 1 and 3 
5) None of these 
41.The server on the internet is also known as : 
1) Repeater 
2) Host 
3) Gateway 
4) AND Gate 
5) None of these 
42.Website is a collection of : 
1) HTML documents 
2) Graphic files 
3) Audio and Video files 
4) All of the above 
5) None of these 
43. ........... is a method in which multiple communicatioin 
devices 
are connected to one another efficiently 
1) Switching 
2) Redundancy 
3) Capacity 
4) Detecting 
5) None of these 
44. One computer that is nto considered a portable computer 
is ....... 
1) Mini computer 
2) A Laptop 
3) Micro computer 
4) All of the above 
5) None of these 
 

45.The sharing of a medium and its path by 2 or more 
devices is called .......... 
1) Modulation 
2) Encoding 
3) Line discipline 
4) Multiplexing 
5) None of these 
46.Device drivers are : 
1) time power cords for external storage devices 
2) experts who know to maximise the performance of device 
3) small, special purpose programs 
4) the innermost part of the operating system 
5) None of these 
47. Array is ............ 
1) linear data structure 
2) non-linear data structure 
3) complex data structure 
4) simple data structure 
5) None of these 
48.A stored link to a webpage, in order to have a quick and 
easy access to it later, it called : 
1) Bookmark 
2) WP-link 
3) Favourite 
4) Both 1 and 3 
5) None of these 
49.Which input device cannot be used to work in MS Office ? 
1) Sanner 
2) Mouse 
3) Keyboard 
4) Joy stick 
5) Lightpen 
50................ is an animated character that gives help in MS 
Office ? 
1) Office worker 
2) Comic assistant 
3) Office assistant 
4) All of the above 
5) None of these 
ANSWERS: 
1)2 2)4 3)1 4)2 5)1 6)2 7)3 8)3 9)1 10)3 11)1 12)4 13)2 14)4 
15)3 16)2 17)3 18)1 19)5 20)2 21)2 22)2 23)2 24)1 25)3 26)1 
27)2 28)2 29)3 30)1 31)1 32)1 33)2 34)4 35)3 36)2 37)4 38)1 
39)2 40)141)2 42)4 43)1 44)1 45)4 46)3 47)1 48)4 49)4 50)3 
 

PRACTICE QUESTIONS SET 4 
1. Programs from the same developer, sold bundled 
together, that provide better integration and share common 
features, toolbars and menus are known as? 
1) software suites 
2) integrated software 
3) software processing 
4) personal information 
5) none of these 
2. A data warehouse is which of the following? 
1) Can be updated by the users 
2) Contains numerous conventions and formats 
3) Organized around subject areas 
4) Contains only current data 
5) None of these 
3. _____ servers store and manages files for network users. 
1) Authentication 
2) Main 
3) Web 
4) File 
5) None of these 
4. All of the following are examples of real security and 
privacy risks except? 
1) hackers 
2) spam 
3) viruses 
4) identify theft 
5) None of these 
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5. Loading Operating System onto RAM is called? 
1) Printing 2) Saving 
3) Booting 
4) Staring 
5) None of these 
6. In MICR, C stands for? 
1) Code  2) Colour 
3) Computer 
4) Character 
5) None of these 
7. System software is the set of programs that enables your 
computer's hardware devices and ____ software to work 
together? 
1) management 
2) processing 
3) utility 
4) application 
5) None of these 
8. ___ are specially designed computer chips reside inside 
other devices, such as your car or your electronic thermostat? 
1) Servers 
2) Embedded computers 
3) Robotic computers 
4) Mainframes 
5) None of these 
9. The following are all computing devices, except? 
1) notebook computers 
2) cellular telephones 
3) digital scanners 
4) personal digital assistants 
5) None of these 
10. In a ring topology, the computer in possession of the 
_____ can transmit data? 
1) packet 
2) data 
3) access method 
4) token 
5) None of these 
11. This part of operating system manages the essential 
peripherals, such as the keyboard, screen, disk drives and 
parallel and serial ports ______ 
1) basic input/output 
2) secondary system 
3) peripheral system 
4) marginal system 
5) None of these 
12. The bar at the top of a window that bears the name of the 
window is known as? 
1) control panel 
2) task bar 
3) menu bar 
4) status bar 
5) title bar 
13. ______ controls the way in which the computer system 
functions and provides a means by which users can interact 
with the computer. 
1) The platform 
2) Application software 
3) Operating system 
4) The motherboard 
5) None of these 
14. Servers are computers that provide resources to other 
computers connected to a? 
1) mainframe 
2) network 
3) super computer 
4) client 
5) None of these 
15. A device that operates under the control of another 
device is called? 
1) Stem  2) Slave 
3) Simulator 
4) Emulator 
5) None of these 

16. URL stands for? 
1) Universal Research List 
2) Universal Resource List 
3) Uniform Resource Locator 
4) Uniform Research Locator 
5) None of these 
17. A database management system (DBMS) is a? 
1) hardware system used to create, maintain and provide 
controlled access to a data- base 
2) hardware system used to create, maintain, and provide 
uncontrolled access to a database. 
3) software system used to create, maintain, and provide 
uncontrolled access to a database. 
4)software system used to create, maintain and provide 
controlled access to a database. 
5)None of these 
18. The design of the network is called the network? 
1) architecture 
2) server 
3) transmission 
4) type 
5) None of these 
19.A Proxy server is used for which of the following? 
1)To provide security against unauthorized users 
2)To process client requests for web pages 
3)To provide TCP/IP 
4)To process client requests for database access 
5) None of these 
20.When data changes in multiple lists and all lists are not 
updated, this causes? 
1) data redundancy 
2) information overload 
3) duplicate data 
4) data inconsistency 
5) None of these 
21._____ are words that a programming language has set 
aside for its own use? 
1) Control words 
2) Reserved words 
3) Control structures 
4) Reserved keys 
5) None of these 
22.The most frequently used instru-ctions of a computer 
program are likely to be fetched from? 
1) the hard disk 
2) cache memory 
3) RAM 
4) registers 
5) None of these 
23.What is the shortcut key to "Undo" the last action in a 
document? 
1) Ctrl + X 
2) Ctrl + Y 
3) Ctrl + Z 
4) Ctrl + U 
5) None of these 
24.You must install a(n) ________ on a network if you want 
to share a broadband Internet connection. 
1) router  2) modem 
3) node 
4) cable 
5) None of these 
25.The errors that can be pointed out by the compiler are? 
1) Syntax errors 
2) Semantic errors 
3) Logic errors 
4) System errors 
5) None of these 
26.Granting an outside organization access to internet web 
pages is often implemented using a(n)? 
1) extranet 2) intranet 
3) internet 
4) hacker 
5) None of these 
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27.Which term identifies a specific computer on the web and 
the main page of the entire site? 
1) URL 
2) Web site address 
3) Hyperlink 
4) Domain name 
5) None of these 
28.The code that relational database management systems 
use to perform their database task is referred to as? 
1) QBE 
2) SQL 
3) OLAP 
4) Sequel Server 
5) None of these 
29.Chip is a common nickname for a(n)? 
1) transistor 
2) resistor 
3) integrated circuit 
4) semiconductor 
5) None of these 
30.Programs such as Internet Explorer that serve as 
navigable windows into the Web are called 
1) Hypertext 
2) Networks 
3) Internet 
4) Web browsers 
5) None of these 
31.What menu is selected to cut, copy and paste? 
1) File 
2) Tools 
3) Special 
4) Edit 
5) None of these 
32.The most important or powerful computer in a typical 
network is? 
1) desktop 
2) network client 
3) network server 
4) network station 
5) None of these 
33.The primary purpose of software is to turn data into? 
1) Web sites 
2) information 
3) programs 
4) objects 
5) None of these 
34.The ability to find an individual item in a file immediately 
_______ is used? 
1) file allocation table 
2) directory 
3) sequential access 
4) direct access 
5) None of these 
35.To make a notebook act as a desktop model, the 
notebook can be connected to a ______ which is connected 
to a monitor and other devices? 
1) bay 
2) docking station 
3) port 
4) network 
5) None of these 
36.You can use the tab key to? 
1) move cursor across the screen 
2) indent a paragraph 
3) move the cursor down the screen 
4) Only (1) and (2) 
5) None of these 
37.A collection of related files is called a? 
1) character 
2) field 
3) database 
4) adjusting 
5) None of these 
 

38.Storage that retains its data after the power is turned off is 
referred to as? 
1) volatile storage 
2) non-volatile storage 
3) sequential storage 
4) direct storage 
5) None of these 
39.Which of the following is an example of connectivity? 
1) Internet 
2) floppy disk 
3) power card 
4) data 
5) None of these 
40._______ is the process of finding errors in software code? 
1) Compiling 
2) Testing 
3) Running 
4) Debugging 
5) None of these 
41.A _______ contains specific rules and words that express 
the logical steps of an algorithm? 
1) syntax 
2) programming structure 
3) programming language 
4) logic chart 
5) None of these 
42.Changing an existing document is called ______ the 
document? 
1) creating 
2) editing 
3) modifying 
4) adjusting 
5) None of these 
43.Virtual memory is? 
1) memory on the hard disk that the CPU uses an extended 
RAM 
2) in RAM 
3) only necessary if you do not have any RAM in your 
computer 
4) a back up device for floppy disks 
5) None of these 
44.Computers use the ________ number system to store 
data and perform calculations? 
1) decimal 
2) hexadecimal 
3) octal 
4) binary 
5) None of these 
45.The ______ key will launch the start buttons? 
1) esc 
2) shift 
3) windows 
4) shortcut 
5) None of these 
46.To move to the beginning of a line of text, press the 
_____ key? 
1) home 
2) a 
3) page up 
4) enter 
5) None of these 
47.When sending an e-mail, the ______ line describes the 
contents of the message? 
1) to 2) subject 
3) contents 
4) CC 
5) None of these 
48.Which groupings do you work with when formatting text in 
Word? 
1) Tables, paragraphs and indexes 
2) Paragraphs, indexes and sections 
3) Characters, sections and paragraphs 
4) Indexes, characters and tables 
5) None of these 
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49.Which of the following is the largest unit of storage? 
1) GB 
2) KB 
3) MB 
4) TB 
5) None of these 
50.The ______ tells the computer how to use its 
components? 
1) utility 
2) network 
3) operating system 
4) application program 
5) None of these 
ANSWERS: 
1. (1) 2. (3) 3. (4) 4. (2) 5. (3) 6. (4) 7. (4) 8. (2) 9. (3) 10. (4) 
11. (1) 12. (5) 13. (3) 14. (2) 15. (2) 16. (3) 17. (4) 18. (1) 19. 
(2) 20. (4) 21. (2) 22. (2) 23. (3) 24. (1) 25. (1) 26. (1) 27. (1) 
28. (2) 29. (3) 30. (4) 31. (4) 32. (3) 33. (2) 34. (3) 35. (2) 36. 
(4) 37. (3) 38. (2) 39. (1) 40. (2) 41. (1) 42. (2) 43. (1) 44. (4) 
45. (3) 46. (1) 47. (2) 48. (1) 49. (1) 50. (3) 
 

PRACTICE QUESTIONS SET 5 
1.A normal CD-ROM usually can store up to .......... 
1) 680 KB 
2) 680 Bytes 
3) 680 MB 
4) 680 GB 
5) None of these 
2.Which programming languages are classified as low level 
languages ? 
1) Basic, COBOL, FORTRAN 
2) Prolog 2, Expert Systems 
3) Knowledge based Systerms 
4) Assembly Languages 
5) None of these 
3.Which of the following devices have a limitation that we 
can only store information to it but cannot erase or modify it ? 
1) Floppy Disk 
2) Hard Disk 
3) Tape Drive 
4) CDROM 
5) None of these 
4.Which of the following is the largst manufacturer of Hard 
Disk Drives ? 
1) IBM 
2) Seagate 
3) Microsoft 
4) 3M 
5) None of these 
5. The programs which are as permanent as hardware and 
stored in ROM is known as 
1) Hardware 
2) Software 
3) Firmware 
4) ROM ware 
5) None of these 
6.To save a document in different location use : 
1) Save 
2) Save as 
3) Save as web page 
4) All of above 
5) None of these 
7.Which of the following is not an manufacturer of Hard Disk 
drives ? 
1) Samsung 2) Interl 
3) Seagate 
4) Western Digital 
5) None of these 
8.The two basic types of record - access methods are 
1) Sequential and random 
2) Sequential and indexed 
3) Direct and immediate 
4) On-line and real time 
5) None of these 

9. A disadvantage of the laser printer is : 
1) It is quieter than an impact printer 
2) It is very slow 
3) The output is of a lower quality 
4) All of the above 
5) None of these 
10.Different components on the motherboard of a PC 
processor unit are linked together by sets or parallel 
electrical conducting lines. What are these lines called ? 
1) Conductors 
2) Buses 
3) Connectors 
4) Connectively 
5) None of these 
11.Which of the following professions has been affected by 
personal computers ? 
1) Medical 
2) Clerical and law 
3) Accounting 
4) All of the above 
5) None of these 
12. What is meant by a dedicated computer ? 
1) Which is used by one person only 
2) Which is assigned one and only one task 
3) Which uses one kind of software 
4) Which is meant for application software 
5) None of these 
13. A computer program that translates one program 
instructions at a time into machine language is called a / an 
1) Interpreter 
2) CPU 
3) Compiler 
4) Simulator 
5) None of these 
14.Instructions and memory address are represented by 
1) Character code 
2) Binary codes 
3) Binary word 
4) Partiy bit 
5) None of these 
15.As compared to diskettes, the hard disks are 
1) More expensive 
2) More portable 
3) Less rigid 
4) Slowly accessed 
5) None of these 
16.The secondary storage devices can only store data but 
they cannot perform 
1) Arithmetic Operation 
2) Logic operation 
3) Fetch operstions 
4) Either of the above 
5) None of these 
17.A physical connection between the microsprocessor 
memory and other parts of the microcomputer is known as 
1) Path 
2) Address bus 
3) Router 
4) All of the above 
5) None of these 
18. A group of magnetic tapes, videos or terminals usually 
under the control of one master is 
1) Cyinder 
2) Surface 
3) Track 
4) Cluster 
5) None of these 
19.Each model of a computer has a unique 
1) Assembly of a computer 
2) Machine language 
3) High level language 
4) All of the above 
5) None of these 
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20.Which company is the biggest player in the 
microprocessor industry ? 
1) Motorola 
2) IBM 
3) Intel 
4) AMD 
5) None of these 
21.Which computer memory is used for storing programs 
and data currently being processed by the CPU ? 
1) Mass memory 
2) Internal memory 
3) Non-volatile memory 
4) PROM 
5) None of these 
22.Microprocessors can be used t make 
1) Computer 
2) Digital systems 
3) Calculators 
4) All of the above 
5) None of these 
23.The subject of cybernetics deals with the science of 
1) Genetics 
2) Control and communications 
3) Molecular biology 
4) Biochemistry 
5) None of these 
24.A term associated with the comparison of processing 
speeds of different computer system is : 
1) EFTS  2) MPG 
3) MIPS 
4) CFPS 
5) None of these 
25.An integrated circuit is 
1) A complicated circuit 
2) An integrating device 
3) Much costlier than a single transistor 
4) Fabricated on a tiny silicon chip 
5) None of these 
26.Which command is used to set a name to a disk in DOS ? 
1) VOLUME 
2) VOL 
3) LABEL 
4) DISKLABEL 
5) None of these 
27.Which file starts MS Word ? 
1) Winword.exe 
2) Word.exe 
3) Msword.exe 
4) Word2003.exe 
5) None of these 
28.To get to the 'Symbol' dialog box, click on the ......... menu 
and choose 'Symbol'. 
1) Insert  2) Format 
3) Tools 
4) Table 
5) None of these 
29.Superscript, subscript, outline, emboss, engrave are 
known as 
1) font styles 2) font effects 
3) word art 
4) text effects 
5) None of these 
30.Shimmer, Sparkle text, Blinkng Background etc. are 
known as 
1) font styles 
2) font effects 
3) word art 
4) text effects 
5) None of these 
31.Which of the following is not availabel in Font Spacing ? 
1) Normal 2) Loosely 
3) Condensed 
4) Expanded 
5) None of these 

32.Bold, Itali, Regular are known as 
1) font styles 
2) font effects 
3) word art 
4) text effects 
5) None of these 
33.If you begin typing an entry into acell and then realize that 
you don't want your entry placed into a cell, you : 
1) Press the Erase key 
2) Press esc 
3) Press the Enter button 
4) Press the Edit Formula button 
5) None of these 
34.Which of the following will not cut information? 
1) Pressing Ctrl + C 
2) Selecting Edit > Cut. from the menu 
3) Clicking the cut button ont he standard 
4) Pressing Ctrl + X 
5) None of these 
35.Computer connected to a LAN (Local Area Network) can 
1) run faster 
2) go on line 
3) share information and / or share peripheral equipment 
4) E-mail 
5) None of these 
36.A self replicating program, similar to a virus which was 
taken from a 1970s science fiction novel by John Bruner 
entitled the Shockwave Rider is ........ 
1) Bug 
2) Vice 
3) Lice 
4) Worm 
5) None of these 
37.Unwanted repetitious messages, such as unsolicited bulk 
- e-mail is known as 
1) Spam 
2) Trash 
3) Calibri 
4) Courier 
5) None of these 
38.COBOL is widely used in ........... applications 
1) Commericial 
2) Scientific 
3) Space 
4) mathematical 
5) None of these 
39.VDU is also called 
1) Screen 
2) Monitor 
3) Both 1 & 2 
4) printer 
5) None of these 
40.What kind of software would you most likely use to keep 
track of billing account ? 
1) Word Processing 
2) Electronic Publishing 
3) Spreadsheet 
4) Web authoring 
5) None of these 
41.Test the validity of the statements ? 
1) 1 KB = 1024 BYTES 
2) 1 MB = 2048 BYTES 
3) 1MB = 100 KILOBYTES 
4) 1 KB = 1000 BYTES 
5) None of these 
42.Which of the following is not a computer language ? <br/> 
1) BASIC 
2) C++ 
3) C# 
4) Java 
5) Microsoft 
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43.Which among the following is a correct definition of 
"Digital Divide"? 
1) gap between people having access to mobile and internet 
access 
2) gap between people having access to internet / IT and no 
internet/ IT 
3) gap between people having access to broadband and 
narrowband internet 
4) gap between people having access to internet banking 
and normal banking 
5) gap between the people having an email account and no 
email account 
44.Now a days Vishing has become a criminal practice of 
using social engineering over which of the following ? 
1) Social networking sites 
2) Mobile Phones 
3) E-mail 
4) Cyber cafes 
5) All of the above 
45.What is the fullform of W3C? 
1) World Wide Web Consortium 
2) World Wide Web Company 
3) World Wide Web Center 
4) World Wide Web Command 
5) None of these 
46.Which among the following is used for removing a 
software bug / defect which is available for free of cost from 
the software provider ? 
1) Version 
2) Update 
3) Help 
4) Patch 
5) Syntax 
47.In the MICR Code Line Structure what do represent the 
first three digits of Sort field number consisting of nine digits? 
1) City 
2) Bank 
3) Branch 
4) Account Type 
5) None of the above 
48.Most of the internet banking sites provide which of the 
following feature to reduce the risk of keystroke logging for 
the password entry ? 
1) Virtual keyboard 
2) Finger Touching 
3) Touchscreen 
4) Shape Writer 
5) Dasher 
49.ADSL data communications technology uses which of the 
following for faster data transmission ? 
1) Voiceband modem 
2) Wireless Modem 
3) Copper telephone Lines 
4) Sockets 
5) None of the above 
50.What is the purpose of keeping electronic devices such 
as computers, televisions, and remote controlled devices on 
Sleep mode ? 
1) Reduce Power consumption 
2) Back UP 
3) To write contents of RAM to hard disc 
4) To improve download speed 
5) None of thea above 
 
ANSWERS: 
1) 3 2) 4 3) 4 4) 2 5) 3 6) 2 7) 2 8) 1 9) 5 10) 2 11) 4 12) 2 
13) 1 14) 2 15) 1 16) 4 17) 2 18) 4 19) 2 20) 3 21) 2 22) 4 23) 
2 24) 4 25) 4 26) 3 27) 1 28) 1 29) 2 30) 4 31) 2 32) 1 33) 2 
34) 1 35) 3 36) 4 37) 1 38) 1 39) 3 40) 3 41) 1 42) 5 43) 2 44) 
2 45) 1 46) 4 47) 1 48) 1 49) 3 50) 1 
 
 
 
 

PRACTICE QUESTIONS SET 6 
 
1.Which command devides the surface of the blank disk into 
sectors and assign a unique address to each one 
1) Ver 
2) Format 
3) Fat 
4) Chkdsk 
5) None of these 
2.If you need to duplicate the entire disk, which command 
will you use ? 
1) Copy 
2) Diskcopy 
3) Chkdsk 
4) Format 
5) None of these 
3.A .............. sometimes called a boot sector virus, executes 
when a computer boots up because it resides in the boot 
sector of a floppy disk or the master boot record of a hard 
disk 
1) system virus 
2) Trojan horse virus 
3) file virus 
4) macro virus 
5) None of these 
4.A result of a computer virus can not lead to ...... 
1) Disk Crash 
2) Mother Board Crash 
3) Corruption o f program 
4) Deletion of files 
5) None of these 
5.Every computer connected to an intranet or extranet must 
have a distinct ....... 
1) firewall 
2) proxy server 
3) IP address 
4) domain name 
5) None of these 
6.Programming language built into user programs such as 
Word and Excel are known as ...... 
1) 4GLs 
2) Macro languages 
3) object-oriented languages 
4) visual programming languages 
5) None of these 
7.Firewalls are used to protect against ....... 
1) unauthorized Attacks 
2) virus Attacks 
3) Data Driven Attacks 
4) Fire Attacks 
5) None of these 
8.Which of the following extensions suggest that the file is a 
backup copy 
1) Bak 
2) Bas 
3) Com 
4) Txt 
5) None of these 
9.Computer programs are written in a high - level 
programming language; however, the human readable 
version of a program is called ....... 
1) cache 
2) instruction set 
3) source code 
4) word size 
5) None of these 
10.The software tools that enable a user to interact with a 
computer 
for specific purposes are known as ....... 
1) Hardware 
2) Networked Software 
3) Shareware 
4) Applications 
5) None of these 
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11............... proessing is used when a large mail-order 
company accumulates orders and processes them together 
in one large set 
1) Batch  2) Online  
3) Real-time 
4) Group 
5) None of these 
12.When a file contains instructions that can be carried out 
by the computer, it is often called a(n) ...... file 
1) data  2) information 
3) executable 
4) application 
5) None of these 
13.A complier translates a program written in a high - level 
language into ........ 
1) Machine language 
2) An algorithm 
3) A debugged program 
4) Java 
5) None of these 
14.A set of step - by - step procedures for accomplishing a 
task is known as a(n) ..... 
1) algorithm 
2) hardware program 
3) software bug 
4) firmware program 
5) None of these 
15.A complete electronic circuit with transistors and other 
electronic components on a small silicon chip is called a(n).... 
1) Workstation 
2) CPU 
3) Magnetic disk 
4) Integrated circuit 
5) None of these 
16.A saved document is referred to as a ..... 
1) file  2) word 
3) folder 
4) project 
5) None of these 
17.What is output ? 
1) What the processor takes from the user 
2) What the user gives to the processor 
3) What the processor gets from the user 
4) What the processor gives to the user 
5) None of these 
18.When you turn on the computer, the boot routine will 
perform this test ........ 
1) RAM test 2) Disk drive test 
3) Memory test 
4) Power - on self-test 
5) None of these 
19.Which of the following storage media provides sequential 
access only ? 
1) Floppy disk 
2) Magnetic disk 
3) Magnetic tape 
4) Optical disk 
5) None of these 
20.In word processing, an efficient way to move the 3rd 
paragraph to place it after the 5th paragraph is ........ 
1) copy and paste 
2) copy, cut and paste 
3) cut, copy and paste 
4) cut and paste 
5) None of these 
21. Hardware includes .......... 
1) all devices used to input data into a computer 
2) sets of instructions that a computer runs or executes 
3) the computer and all the devices connected to it that are 
used to input and output data 
4) all devices involved in processing information including the 
central processing unit, memory and storage 
5) None of these 

22.The quickest and easiest way in Word, to locate a 
particular word or phrase in a document is to use the ....... 
command 
1) Replace 2) Find 
3) Lookup 
4) Search 
5) None of these 
23.The term 'user interface' refers to ............ 
1) What the user sees on the screen and how they can 
interact with it 
2) How the operating system responds to user commands 
3) the means by which the user interacts with the peripheral 
devices on the computer 
4) the monitor that is available for the computer 
5) None of these 
24.For creating a document, you use ........ command at File 
Menu. 
1) Open  2) Close 
3) New 
4) Save 
5) None of these 
25.The .............. becomes different shapes depending on the 
task you are performing 
1) Active tab 
2) Insertion point 
3) Mouse pointer 
4) Ribbon 
5) None of these 
26.Specilizd programs that asist users in locating information 
on the Web are called .... 
1) Information engines 
2) Search engines 
3) Web browsers 
4) Resource locators 
5) None of these 
27.The background of any Word document ...... 
1) Is always white colour 
2) Is the colour you presect under the Options menu 
3) Is always the same for the entire document 
4) Can have any colour you choose 
5) None of these 
28.Correcting errors in a program is referred to as ......... 
1) debugging 
2) bugging 
3) rectifying 
4) modifying 
5) None of these 
29.Any letter, number, or symbol found on the keyboard that 
you can type into the computer .......... 
1) output 
2) character 
3) type 
4) print 
5) font 
30.A symbol or question on the screen that prompts you to 
take action and tell the computer what to do next ........ 
1) scanner 
2) questionnaire 
3) prompt and dialog box 
4) information seeker 
5) None of these 
31.Commands at the top of a screen such as : 
FILE-EDIT-FONT-TOOLS to operate and change things 
within programs ..... 
1) menu bar 
2) tool bar 
3) user friendly 
4) word processor 
5) None of these 
32.The primary device that a computer uses to store 
information ...... 
1) monitor 2) memory 
3) disk  4) hard drive 
5) None of these 
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33.A file extension is separated from the main file name with 
a(n) ......, but no spaces 
1) questiion nark 
2) exclamation mark 
3) underscore 
4) period 
5) None of these 
34.Application software is designed to accomplish ....... 
1) real -w orld tasks 
2) computer-centric tasks 
3) gaming tasks 
4) operating system tasks 
5) None of these 
35.A ...... is a device that not only provdes surge protection, 
but also furnishes your computer with battery backup power 
during a power outage 
1) surge strip 
2) USB 
3) UPS 
4) battery strip 
5) None of these 
36.The term ............. designates equipment that might be 
added to a computer system to enhance, its functionality 
1) digitial device 
2) system add-on 
3) disk pack 
4) peripheral device 
5) None of these 
37........... this is the act of copying or downloading a program 
from a network and making multiple copies of it. 
1) Network piracy 
2) Plagiarism 
3) Software piracy 
4) Site-license piracy 
5) None of these 
38.When installing ............., the user must copy and usually 
decompress program files from a CDROM or other medium 
to the hard disk 
1) programming software 
2) system hardware 
3) applications hardware 
4) applications software 
5) None of these 
39.Which one of the following would be considered as a way 
that a computer virus can enter a computer system ? 
1) Opening an application previously installed on the 
computer 
2) Borrowed an illegal copy of software 
3) Viewing a website without causing any additional 
transctions 
4) Running antivirus programs 
5) None of these 
40.Programs such as Mozila Firefox that serve as navigable 
windows into the Web are called .......... 
1) Hypertext 
2) Networks 
3) Internet 
4) Web browsers 
5) None of these 
41.What is the main difference between a mainframe and a 
super computer ? 
1) Super computer is much larger than mainframe computers 
2) Super computers are much smaller than mainframe 
computers 
3) Supercomputers are focused to execute few programs as 
fast as possible while mainframe uses its power to execute 
as many programs concurrently 
4) Supercomputers are focused to execute as many 
programs as possible while mainframe uses its power to 
execute few programs as fast as possible 
5) None of these 
 
 

42.What is the function of Recycle Bin ? 
1) Store deleted file 
2) Store temporary file 
3) Store corrupted file 
4) Store Document file 
5) None of these 
43.Which is the latest version of MS Office ? 
1) Office XP 
2) Windows XP 
3) Office 2007 
4) Office 2010 
5) None of these 
44.Which device can not be shared in network ? 
1) Floppy 
2) Keyword 
3) Computer 
4) Printer 
5) None of these 
45.What is the purpose of query ? 
1) Input data 
2) Output data 
3) Sort & filter 
4) All of above 
5) None of these 
46.Which port doesn't exist in computer ? 
1) USB 
2) Parallel 
3) Com1 / Com2 
4) RAW 
5) None of these 
47.What is the name of exel files ? 
1) Workbook 
2) Worksheet 
3) Spreadsheet 
4) Spread book 
5) None of these 
48.Workgroup means 
1) Computers in network 
2) Individual user 
3) Individual computer 
4) All of he above 
5) None of these 
49.Synonym can be reviewed with 
1) Spelling and grammar 
2) Thesaurus 
3) Both 
4) Synonym viewer 
5) None of these 
50.Which command allows you to reduce fragments of file 
and optimize the performance of disk ? 
1) Scandisk 
2) Diskcomp 
3) Chkdsak 
4) Defrag 
5) None of these 
 
ANSWERS: 
1) 2 2) 2 3) 5 4) 2 5) 2 6) 4 7) 1 8) 1 9) 3 10) 4 11) 1 12) 3 
13) 1 14) 1 15) 4 16) 1 17) 4 18) 2 19) 2 20) 4 21) 4 22) 2  
23) 1 24) 3 25) 3 26) 2 27) 4 28) 1 29)2 30) 3 31) 1 32) 4  
33) 5 34) 4 35) 3 36) 4 37) 3 38) 1 39) 2 40) 4 41) 3 42) 1  
43) 4 44) 2 45) 4 46) 4 47) 1 48) 1 49) 2 50) 4 
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PRACTICE QUESTIONS SET 7 
 
1. A framwork in which circuit boards can be mounted is... 
(A) Switch circuit 
(B) Chip 
(C) Card cage 
(D) Bar code 
(E) None of these    Answer: (C) 
2. A convolutional code that is prone to catastrophic error 
propagation is... 
(A) Mnemonics 
(B) Gray code 
(C) machine code 
(D) Catastrophic code 
(E) None of these    Answer: (D) 
3. Which one of the following input device is user-
programmable? 
(A) Dumb terminal 
(B) Smart terminal 
(C) VDT 
(D) Intelligent terminal 
(E) None of these    Answer: (D) 
4. The barcode which is used on all types of items, is read by 
a scanning device directly into the computer. What is the 
name of this scanning device? 
(A) Laser scanner 
(B) Wand 
(C) OCR 
(D) MICR 
(E) None of these    Answer: (A) 
5. A Plastic card similar to a credit card but having some 
memory and a microprocessor embedded within it is (A) 
Punched paper tape 
(B) Chip card 
(C) Card punch 
(D) Magnetic tape 
(E) None of these    Answer: (B) 
6. The category of operating system that you most likely 
have running on your PDA computer is a ____________ 
operating system. 
(A) real-time 
(B) single-user, single-task 
(C) single-user, multi-task 
(D) multi-user, multi-task 
(E) None of these    Answer: (B) 
7. Which of the following is an example of a real-time 
operating system? 
(A) Lynx 
(B) MS DOS 
(C) Windows XP 
(D) Symbian 
(E) None of these    Answer: (A) 
8. A real-time operating system is most likely to be used for 
which of the following tasks? 
(A) Controlling access to a shared printer in a network 
(B) Ensuring that the system clock works correctly on a 
server 
(C) Managing the access to system files in a laptop computer 
(D) Controlling the fuel injection system of an automobile 
engine 
(E) None of these    Answer: (D) 
9. An essential difference between the operating system that 
runs a typical desktop computer and the operating system 
that runs a typical PDA is that 
(A) the desktop OS has a graphical user interface whereas 
the PDA OS does not 
(B) the desktop OS can run several programs simultaneously 
whereas the PDA OS cannot 
(C) the desktop OS manages hardware resources whereas 
the PDA OS does not 
(D) the desktop computer has an OS whereas a PDA does 
not 
(E) None of these    Answer: (B) 
 

10.To set a register or counter to the all-zero-state is... 
(A) Rerun 
(B) Reset 
(C) Remote 
(D) Release 
(E) None of these    Answer: (B) 
11.A set of information that defines the status of resources 
allocated 
to a process is... 
(A) Process control 
(B) ALU 
(C) Register Unit 
(D) Process description 
(E) None of these    Answer: (D) 
12. A family of polynomial block codes designed to correct 
burst errors is known as 
(A) Bar codes 
(A) Gray codes 
(C) Fire codes 
(D) mnemonics codes 
(E) None of these    Answer: (C) 
13. The MS-DOS operating system is a 
(A) graphical user interface, single-tasking operating system 
(B) graphical user interface, multi-tasking operating system 
(C) command-driven interface, single-tasking operating 
system 
(D) command-driven interface, multi-tasking operating 
system 
(E) None of these    Answer: (C) 
14. Which of the following was an early desktop operating 
system that included an integrated graphic user interface 
with point-and-click features? 
(A) MS-DOS 
(B) Mac OS 
(C) Unix 
(D) Gnome 
(E) None of these    Answer: (B) 
15.CD-ROM can store upto ____ MB of data 
(A) 600 MB 
(B) 400 Floppy disk 
(C) 320 MB 
(D) Both (A) and (B) 
(E) None of these    Answer: (D) 
16. The most recent version of the Mac OS is based on the 
____________ operating system 
(A) Windows 
(B) Linux 
(C) Unix 
(D) CMOS 
(E) None of these    Answer: (C) 
17. The ____________ operating system was initially 
created in the early 1970s at AT&T’s Bell Labs. 
(A) Linux 
(B) DOS 
(C) Unix 
(D) GNU 
(E) None of these    Answer: (C) 
18. The essential difference between an operating system 
like Linux and one like Windows is that 
(A) Windows can run with an Intel processor, whereas Linux 
cannot 
(B) Linux is proprietary, whereas Windows is not 
(C) any programmer can modify Linux code, which is not 
permitted with Windows 
(D) there are multiple versions of Linux, but only one version 
of Windows 
(E) None of these    Answer: (C) 
19. Which of the following is NOT an advantage of open-
source operating systems over proprietary versions? 
(A) Free use and distribution 
(B) Availability of technical support 
(C) Availability of source code 
(D) Ability to modify code 
(E) None of these    Answer: (B) 
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20. Use of icons and windows are characteristic of a 
________ interface 
(A) command-driven 
(B) windows-oriented 
(C) graphical-user 
(D) menu-driven 
(E) None of these    Answer: (C) 
22. The invention of the slide rule is attributed to ... 
(A) Babbage 
(B) Oughtred 
(C) Pascal 
(D) Napier 
(E) None of these    Answer: (B) 
23. The main purpose of the offline device is... 
(A) To reduce the no.of operator errors in recording data 
(B) To save computer time 
(C) To save floor space in the cimputer centre 
(D) All of the above 
(E) None of these    Answer: (B) 
24. The ability of an operating system to control the activities 
of multiple programs at the same time is called 
(A) multitasking 
(B) multi-processing 
(C) multi-operating 
(D) multi-paging 
(E) None of these    Answer: (A) 
25.A computer assisted method for the recording and 
analysing of existing hypothetical systems is known as 
(A) Distributed processing 
(B) Data transmission 
(C) Data link 
(D) Data flow 
(E) None of these    Answer: (D) 
 

IBPS COMPUTER KNOWLEDGE MCQs 
1. In a network, the computer that stores the files and 
process the data is named as 
a) Server 
b) Terminal 
c) Modem 
d) All of the above 
2. Viruses are called that because 
a) They are viruses 
b) They can copy themselves and spread 
c) Both (a) and (b) 
d) None of the above 
3. Which of the can't spread virus 
a) An e-mail with attachment 
b) A plain text mail 
c) Downloading files over the web 
d) None of the above 
4. There is a new anti-virus software update available, when 
it is downloaded to your computer 
a) Everyday 
b) Only in the night 
c) When you next switch on your computer 
d) All of the above 
5. Numbers are stored and transmitted inside a computer in 
a) Binary form 
b) ASCII code form 
c) Alphabets form 
d) Numerical form 
6. CPU capacity can be measured in 
a) BPS 
b) MIPS 
c) MHz 
d) MPI 
7. MPIS stands for 
a) Million Instructions Per Second 
b) Million Instructions Per Season 
c) Monthly Instructions Per Second 
d) Million Inputs Per Second 
 
 

8. LAN speeds are measured in 
a) BPS 
b) KBPS 
c) MBPS 
d) MIPS 
9. Modem speeds are measured in 
a) BPS 
b) KBPS 
c) MBPS 
d) MIPS 
10. BPS stands for 
a) Bits Per Second 
b) Bits Per Season 
c) Bytes Per Second 
d) Bits Per System 
11. In processing cheques which of the following I/O 
techniques have banks traditionally followed? 
a) OCR 
b) MICR 
c) Barcode 
d) VRT 
12. What is object of UPS? 
a) Using for storage 
b) To increase the speed of a computer 
c) Provides backup power 
d) All of the above 
13. QWERTY is used with reference to 
a) Monitor 
b) Printer 
c) Keyboard 
d) Mouse 
14. "Zipping" a file means 
a) Encrypting the message 
b) Compressing the message 
c) Transfer the message 
d) All of the above 
15. Integrated Circuits (IC) chips used in computers are 
made with 
a) Gold 
b) Silver 
c) Silicon 
d) Coper 
16. What is the Super Computer developed in India 
a) CRAY 
b) PARAM 
c) Both (a) and (b) 
d) None of the above 
17. Which of the following is different from other 
a) Internet 
b) Windows 
c) Unix 
d) Linux 
18. What is the full form of WWW? 
a) World Wide Web 
b) World With Web 
c) Work Wide Web 
d) World Wide Wet 
19. Which of the following Command is required to reboot 
the computer 
a) CTRL+ALT+DEL 
b) CTRL+ALT+TAB 
c) CTRL+ALT+SHIFT 
d) CTRL+SHIFT+DEL 
20. Select the ODD one 
a) Operating system 
b) Interpreter 
c) Compiler 
d) Assembler 
21. PC stands for 
a) Practical Computer 
b) Personal Computer 
c) Private Computer 
d) Personal Contact 
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22. The computer code for interchange of information 
between terminals is 
a) BCDIC 
b) BCD 
c) ASCII 
d) None of the above 
23. The retrieval of information from the computer is defined 
as 
a) Data processing 
b) Input 
c) Output 
d) All of the above 
24. Which one of the following is NOT a computer language? 
a) MS-Excel 
b) BASIC 
c) COBOL 
d) C++ 
25. "C" is 
a) A letter 
b) A word 
c) A language 
d) An alphabet 
26. Difference Engine invented by 
a) Charles Babbage 
b) John McCarthy 
c) Pascal 
d) Newton 
27. First generation computer systems used 
a) Transistors 
b) Vacuum Tubes 
c) Both (a) and (b) 
d) None of the above 
28. A byte is made up of 
a) Eight bytes 
b) Eight binary digits 
c) Two binary digits 
d) Two decimal points 
29. Doing research by using an on-line database instead of a 
printed set of similar information offers which of the following 
advantage 
a) More current information 
b) Easier to understand 
c) Better charts 
d) None of the above 
30. Software programs that allow you to legally copy files 
and give them away at no cost are called which of the 
following 
a) Time sharing 
b) Public domain 
c) Shareware 
d) None of the above 
31. The term that we use to describe physical components of 
the system 
a) Hardware b) Input 
c) Software 
d) None of the above 
32. Which of the following is used to indicate the location on 
the computer monitor 
a) Mouse 
b) Cursor 
c) Both (a) and (b) 
d) None of the above 
33. Mr. Saketh needs to design invitation card. What type of 
computer program is suitable? 
a) MS-Word 
b) Desktop Publishing 
c) Simulation 
d) None of the above 
34. Which combination of keys needs to be pressed to make 
a percent sign? 
a) Shift+2 
b) Shift+3 
c) Shift+4 
d) Shift+5 

35. What process should be used to recall a document saved 
previously? 
a) Copy 
b) Save 
c) Retrieve 
d) Enter 
36. What term applies to a collection of related records in a 
database? 
a) Field 
b) File 
c) Both (a) and (b) 
123 
d) None of the above 
37. How are data organized in a spreadsheet? 
a) Rows and Columns 
b) Boxes 
c) Tables 
d) None of the above 
38. Which of the following mode we use to deliver e-mail 
a) Postal 
b) Courier 
c) Computer 
d) Fax 
39. VIRUS stands for 
a) Vital Information Recourse Under Siege 
b) Vital Information Reason Under Siege 
c) Vital Information Recourse Under System 
d) Virus Information Recourse Under Siege 
40. ------ Is known as unauthorized access into others system 
a) Hacking 
b) Encryption 
c) Decryption 
d) None of the above 
 

ANSWERS: 

1. a 2. b 3. b 4. c 5. b 6. b 7. a 8. c 9. a 10. a 
11. b 12. c 13. c 14. b 15. c 16. b 17. a 18. a 19. a 
20. a 21. b 22. c 23. c 24. a 25. c 26. a 27. b 28. b 
29. a 30. b 31. a 32. b 33. b 34. d 35. c 36. b 37.a 
38. c 39. a 40. a 
 
 

U
p

al
 R

an
ga

For More Book Download Here - http://GKTrickHindi.com




